FCC Information

WARNING: Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

NOTICE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his or her own expense.

Shielded cables must be used with this unit to ensure compliance with the Class A FCC limits.

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Change Made</th>
</tr>
</thead>
<tbody>
<tr>
<td>23-11654-00 Rev. 01</td>
<td>7/2010</td>
<td>Initial release.</td>
</tr>
<tr>
<td>23-11654-01 Rev. 01</td>
<td>5/2012</td>
<td>Revised for BD FACSDiva software version 7.0.</td>
</tr>
</tbody>
</table>
# Contents

## About This Guide

- Conventions ......................................................... xiv
- Technical Assistance ........................................... xv
- Limitations .......................................................... xvi

## Chapter 1: Cytometer Components

- New Software Functions ........................................ 18
- BD FACSaria III Features ......................................... 18
  - New and Upgrade Features ................................. 19
- Fluidics Cart ....................................................... 21
  - Containers and Connectors .............................. 21
  - Connecting to an External Air Supply .............. 22
  - Power and Operation ........................................ 23
- Flow Cytometer .................................................... 24
  - Fluidics Components ...................................... 25
  - Optics System .................................................. 35
  - Cytometer Electronics .................................... 43
  - Emergency Stop Button .................................. 44
- Workstation ......................................................... 46

## Chapter 2: Theory of Operation

- Fluid Movement .................................................... 48
- Sheath Flow ......................................................... 49
- Sample Flow ......................................................... 50
Chapter 4: Running Samples

Cyometer Startup ................................................. 118
Performing Fluidics Startup ................................. 120
Starting the Stream ............................................. 122
Setting Up the Breakoff ...................................... 124
Setting Up the Fluidics Cart ................................. 127
Checking Cytometer Performance ......................... 135
Preparing the CS&T Workspace ......................... 136
Preparing the CS&T Beads ................................. 138
Running a Performance Check ......................... 139
Reviewing the Results ........................................ 139
Application Settings ........................................... 141
Creating Application Settings ............................... 142
Data Collection .................................................. 148
Setting Up the Workspace .................................... 149
Calculating Compensation ................................. 152
Data Recording and Analysis ............................... 155
Setting Up the Experiment ................................. 155
Setting Up the Global Worksheet ...................... 156
Recording Data .................................................. 158
Analyzing Data .................................................. 159
Performing a Batch Analysis .............................. 161
Manual Adjustment of Laser Delay ...................... 163

Chapter 5: Sorting

Setting Up for Sorting ........................................... 168
Setting Up for Bulk Sorting ................................. 169
Determining the Drop Delay – Manual Method .......... 172
Setting Up the Experiment .................................... 172
Using Manual Drop Delay ................................... 174
Determining the Drop Delay – Automatic Method ................................. 177
  Overview of Auto Drop Delay ......................................................... 177
  Using Auto Drop Delay ................................................................. 177
Sorting ................................................................................................. 179
  Setting Up the Experiment ............................................................... 180
  Starting and Monitoring the Sort ...................................................... 181
  Stopping and Resuming a Sort ......................................................... 183
  Pausing and Resuming a Sort .......................................................... 185
  Responding to a Nozzle Clog During a Sort ....................................... 186
Setting Up for Sorting Onto a Plate or Slide .......................................... 188
  Installing the Sorting Hardware ....................................................... 188
  Setting Up the Stream ...................................................................... 190
  Creating a Custom Device ................................................................. 192
Index Sorting ......................................................................................... 195
  Setting Up for Index Sorting ............................................................ 195
Terasaki Plate Adapter ........................................................................ 199
  Using the Adapter ............................................................................ 199
  Using the Correct Device in the Sort Layout ...................................... 200

Chapter 6: Shutdown and Maintenance .................................................. 201
Daily Shutdown .................................................................................... 202
  Cleaning the Flow Cell ..................................................................... 202
Fluidics Shutdown ................................................................................ 203
  External Cleaning ............................................................................ 206
Scheduled Maintenance ........................................................................ 207
  Internal Cleaning ............................................................................ 208
  Purging the Fluid Filters ................................................................. 213
  Purging the Sheath Filter ................................................................. 214
  Changing the Fluid Filters ............................................................... 215
  Changing the Sheath Filter .............................................................. 216
  Changing the Ethanol Shutdown Filter ............................................. 217
Changing the Sample Lines ........................................... 218
Changing the Air Filters ............................................. 225
Changing the Sheath Tank Air Filter ............................... 225
Checking the Fluidics Cart Drip Tray ............................... 226
Unscheduled Maintenance .......................................... 227
Changing the Integrated Nozzle .................................... 228
Cleaning the Integrated Nozzle ..................................... 229
Handling the Integrated Nozzle ...................................... 231
Temporary Replacement of a Seal ................................ 232
Closed-Loop Nozzle Maintenance .................................. 232
Installing or Removing a Sample Line Filter ..................... 235
Changing the Pinch Valve Tubing .................................. 237
Cleaning the Camera Windows ...................................... 239
Removing the Deflection Plates .................................... 242
Lubricating the Sample Injection Chamber O-Ring ............. 243
Using Custom Optical Filters ....................................... 244
Cleaning the Optical Filters ......................................... 245
Removing or Installing the FSC ND Filter ......................... 246

Chapter 7: Troubleshooting ............................................ 249
Troubleshooting the Stream ......................................... 250
Troubleshooting the Breakoff ....................................... 255
Sorting Troubleshooting ............................................. 256
Acquisition Troubleshooting ....................................... 261
Fluidics Troubleshooting ............................................ 268
Electronics Troubleshooting ........................................ 270

Chapter 8: Technical Specifications ................................. 271
Cytometer Specifications ............................................. 272
Environment ............................................................ 272
Performance .......................................................... 273
Sort Performance .................................................. 274
Optics Specifications ............................................ 275
Fluidics Cart Specifications ................................. 276

Appendix A: Supplies and Consumables 277
  Cytometer Supplies ........................................... 278
  Optical Components .......................................... 278
  Accessory Kit .................................................. 280
  Other Replacement Parts .................................... 282
  Consumables ..................................................... 284
  Cytometer Setup Particles .................................. 284
  Reagents ........................................................ 285
  Labware ......................................................... 286

Appendix B: Laser Options 287
  Planning Considerations ..................................... 288
  Optics Choices for the 375-nm Laser .................... 288
  Optics Changes When Using the 445-nm Laser .......... 288
  Using a Fluorochrome with Multiple Lasers .......... 288
  Detector Locations ............................................ 289
  Detector Configurations .................................... 290
  488/633 Two-Laser System .................................. 290
  488(445)/561/633 Four-Laser System .................... 292
  488(445)/633/405(375) Five-Laser System ............. 294
  488(445)/561/633/405(375) Six-Laser System ....... 296
  Special Cases .................................................. 299
  Third PMT in the 633 Trigon ............................... 299
  Fifth PMT in the 561-nm Octagon ......................... 300
Appendix C: BD Aerosol Management Option 301

Option Components .................................................. 302
Evacuator .......................................................... 302
ULPA Filter ......................................................... 303

Operating the BD Aerosol Management Option ............................ 304
Starting Up the Evacuator ........................................ 304
Setting Up for Sorting ............................................. 307
Responding to a Nozzle Clog During a Sort with the AMO .......... 308
Turning Off the Evacuator ......................................... 310

Maintenance ....................................................... 310
Replacing the ULPA Filter ........................................ 311
Replacing the Air Filter ........................................... 315

Troubleshooting .................................................... 317
Control Panel Troubleshooting ...................................... 317
Filter Flow Gauge Troubleshooting .................................. 319

Specifications ....................................................... 320

Appendix D: Temperature Control Option 321

Option Components .................................................. 322
Using the BD Temperature Control Option ............................. 323
Setting Up the Water Bath ........................................ 323
Setting Up the Tube Holder ........................................ 325
Setting Up the ACDU Stage ........................................ 327
Starting Up the Water Bath ........................................ 329

Maintenance ....................................................... 330
Tube Holders ....................................................... 330
Recirculating Water Tubing .......................................... 330

Specifications ....................................................... 331

Index 333
About This Guide

This user’s guide contains the instructions necessary to operate and maintain your BD FACS™ Aria™ III flow cytometer. Because many instrument functions are controlled by BD FACSDiva™ software, this guide also contains basic software information needed for instrument setup. For detailed information on software features, see the BD FACSDiva Software Reference Manual.

The BD FACS Aria III User’s Guide assumes you have a working knowledge of basic Microsoft® Windows® operation. If you are not familiar with the Windows operating system, see the documentation provided with your computer.

New users of the BD FACS Aria III flow cytometer should read:

- Cytometer Components on page 17 to become familiar with instrument components
- Theory of Operation on page 47 to understand how the instrument works and to learn about the software components used to control different subsystems
- Using BD FACSDiva Software on page 81 to see where software components are located

Instructions for routine acquisition, analysis, and sorting can be found in Chapters 4 and 5.
Conventions

The following tables list conventions used throughout this guide. Table 1 lists the symbols that are used in this guide or on safety labels to alert you to a potential hazard. Text and keyboard conventions are shown in Table 2.

Table 1 Hazard symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Caution symbol]</td>
<td>Caution: hazard or unsafe practice that could result in material damage, data loss, minor or severe injury, or death</td>
</tr>
<tr>
<td>![Electrical danger symbol]</td>
<td>Electrical danger</td>
</tr>
<tr>
<td>![Laser radiation symbol]</td>
<td>Laser radiation</td>
</tr>
<tr>
<td>![Biological risk symbol]</td>
<td>Biological risk</td>
</tr>
</tbody>
</table>

a. Although these symbols appear in color on the instrument, they are in black and white throughout this user’s guide; their meaning remains unchanged.

Table 2 Text and keyboard conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ Tip</td>
<td>Highlights features or hints that can save time and prevent difficulties</td>
</tr>
<tr>
<td>NOTE</td>
<td>Describes important features or instructions</td>
</tr>
<tr>
<td>Italics</td>
<td>Italics are used to highlight book titles.</td>
</tr>
<tr>
<td>Bold</td>
<td>Bold text indicates software elements such as windows, menus, buttons, and tabs that are used to complete tasks.</td>
</tr>
</tbody>
</table>
Technical Assistance

For technical questions or assistance in solving a problem:

- Read the section of the user’s guide specific to the operation you are performing.
- See Troubleshooting on page 249.

If additional assistance is required, contact your local BD Biosciences technical support representative or supplier.

When contacting BD Biosciences, have the following information available:

- Product name, part number, and serial number
- Any error messages
- Details of recent system performance

For instrument support from within the US, call (877) 232-8995.

For support from within Canada, call (888) 259-0187.

Customers outside the US and Canada, contact your local BD representative or distributor.
Limitations

This instrument is for Research Use Only. Not for use in diagnostic or therapeutic procedures.

BD Biosciences is providing software without warranty of any kind on an as-is basis. The software and workstations are intended for running the instruments supplied by BD Biosciences. It is the responsibility of the buyer/user to ensure that all added electronic files including software and transport media are virus-free. If the workstation is used for Internet access or purposes other than those specified by BD Biosciences, it is the buyer/user's responsibility to install and maintain up-to-date virus protection software. BD Biosciences does not make any warranty with respect to the workstation remaining virus-free after installation. BD Biosciences is not liable for any claims related to or resulting from the buyer/user's failure to install and maintain virus protection.
Cytometer Components

The BD FACS Aria III flow cytometer is a high-speed fixed-alignment benchtop cell sorter. With its fixed-optics design and digital electronics, the BD FACS Aria III flow cytometer enables multicolor analysis of up to 18 fluorescent and two scatter options at a time.

The BD FACS Aria III system consists of three major components: a fluidics cart, a benchtop flow cytometer, and a workstation. Nearly all cytometer functions are operated from within BD FACSDiva software.

The following topics are covered in this chapter:

- New Software Functions on page 18
- BD FACS Aria III Features on page 18
- Fluidics Cart on page 21
- Flow Cytometer on page 24
- Workstation on page 46

For technical information about how the cytometer works, see Theory of Operation.
New Software Functions

BD FACSDiva software version 7 includes new functions that improve the general usability of the software. See the *BD FACSDiva Software Reference Manual* for a description of these new functions.

BD FACSDiva software version 7 includes the BD™ Cytometer Setup and Tracking module (CS&T) version 2.0. You must use BD FACSDiva™ CS&T research beads (CS&T research beads) with version 2.0. See Preparing the CS&T Beads on page 138. The new CS&T research beads add support for the full range of lasers, filters, and mirrors available on the BD FACSaria III system.

BD FACSDiva software version 7 also includes the following new functions that are specific to the BD FACSaria III system:

- Support for index sorting. See Index Sorting on page 195.
- Support for Terasaki plates for sorting. See Terasaki Plate Adapter on page 199.

BD FACSaria III Features

The BD FACSaria III system includes features that are available with new purchases or as part of a field upgrade from a BD FACSaria II system. Users who want to upgrade from BD FACSaria systems must first upgrade to a BD FACSaria II system.
New and Upgrade Features

The BD FACSaria III system includes the following features:

- A 561-nm (yellow-green) laser option
- A 445-nm (blue-violet) laser option
- A second octagon detector array with a fourth beam spot and an optional 561-nm laser or 445-nm laser
- An fourth beam spot to accommodate the optional 561-nm laser or 445-nm laser
- The X-mount optical plate
- A new power switch to support additional lasers
- A next-generation flow cell

Optics System Features

For more information about the BD FACSaria III optics system, including the following new features, see Optics System on page 35. For detailed configuration specifications, see Laser Options on page 287.

561-nm Laser Option

The 561-nm laser can be installed on a system to enable improvements in multicolor experiments and to expand the range of applications for these platforms. Specifically, this option increases PE sensitivity and minimizes or eliminates FITC spectral overlap into the PE channel, giving the instrument the best chance at resolving a dim staining PE population. In addition, this laser improves resolution for mCherry fluorescent proteins.
445-nm Laser Option

The 445-nm laser can be installed on a system to enable enhanced sensitivity when working with cyan fluorescent proteins. This laser shares the detector collection optics with the 488-nm laser. If both lasers are installed on a system, you can use either the 445-nm laser or the 488-nm laser, but you cannot use both at the same time.

Optional Second Octagon Array

BD FACSaria III introduces an additional octagon that is coupled with the optional violet laser. The system can now support up to two trigons and two octagons, with the additional octagon mounted behind the front trigon and octagon arrays.

X-Mount Optical Plate

The fiber optic heads for the new lasers and all existing lasers (except the 375 nm) are mounted on an X-mount optical plate, which provides support for the fourth beam spot.

Fourth Beam Spot

A fourth spatially-separated beam spot is added with the 561-nm laser option. This additional beam spot enables the simultaneous use of four lasers.

New Power Switch

The power switch has been redesigned to support up to six lasers. For more information, see Power Panel on page 43.

Next-Generation Flow Cell

The BD FACSaria III system includes a new flow cell that has been optimized for four laser beam spots. This flow cell is also included with the 375-nm laser option for side population studies. For more information, see Cuvette Flow Cell on page 29.
Fluidics Cart

A separate fluidics cart supplies sheath and cleaning fluids and collects waste from the cytometer. The self-contained fluidics cart supplies the required air pressure and vacuum, which eliminates the need for an external source (although the cart can be hooked up to an in-house air source, if one is available). The air pumps provide pressure from 5 to 75 PSI to accommodate a variety of cell sorting applications. Air pressure is adjusted within BD FACSDiva software.

Containers and Connectors

The fluidics cart holds a 10-L stainless steel sheath tank, a 5-L stainless steel ethanol shutdown tank, a 10-L waste container, and three 5-L auxiliary cleaning fluid containers (Figure 1-1).

Figure 1-1  Fluidics cart containers

⚠️ To prevent foaming, do not fill the containers with solutions containing a high concentration of detergent.

The fluidics cart connects directly to the flow cytometer unit via a power cord, fluid hoses, serial communication cable, and air line (Figure 1-2 on page 22). Receptacles for the aerosol management and temperature control options are also located within the connection panel. The position of the fluidics cart is
constrained only by the length of the connecting cables and hoses, which extend up to 9 feet (2.7 m). Typically, the cart is placed to the left or underneath the cytometer.

Figure 1-2 Fluidics cart power and fluid line connectors on cytometer

Connecting to an External Air Supply

To connect the fluidics cart to an external air source, switch on the Auxiliary Air Supply and attach the external air line to the air input connector. The external air supply should provide 80–100 PSI. The external air must be dust and oil-free.

Figure 1-3 Connectors on fluidics cart
NOTE There is a pull-out drip tray under the connection area. Check the tray periodically for moisture. See Checking the Fluidics Cart Drip Tray on page 226 for details.

Power and Operation

Power to the fluidics cart is supplied by the cytometer. The cart is activated when the cytometer main power switch is turned on (see Power Panel on page 43).

⚠️ Power to the fluidics cart is supplied and controlled through the flow cytometer. The fluidics cart voltage settings have been configured to match the supply voltage by your service engineer. To properly operate the fluidics cart, plug the fluidics cart power cord only into the power receptacle on the cytometer (Figure 1-2 on page 22). Do not plug the power cord directly into a wall socket. Do not change the input voltage selection switch on the fluidics cart.

⚠️ When the stream is on, air pressure fluctuates between 80–100 PSI (Figure 1-4). A pressure reading of less than 80 PSI or greater than 100 PSI indicates that the fluidics cart is not functioning properly. If this occurs, contact your BD Biosciences service representative for assistance. Do not operate the cytometer outside the normal air pressure range.

Figure 1-4 Fluidics cart flow gauge

See the following sections for more information about the fluidics cart:

- Recommended fluids on page 127
Flow Cytometer

The benchtop flow cytometer contains the major components for all three subsystems (fluidics, optics, and electronics). The BD FACS Aria III cytometer is relatively compact, with a much smaller footprint than most sorters with the same capabilities. The cytometer can be set up on a typical laboratory benchtop or table, and it requires only a 20-amp electrical outlet. No special facilities are required.

Figure 1-5 BD FACS Aria III flow cytometer

To view the fluidics components, open the side door and lift the flow cell access door. To view the optics components, open the optics access door. The power
panel and connectors are found on the left side of the cytometer. Other electronic components are embedded within the cytometer and do not need adjustment.

⚠️ The flow cell access door is equipped with a shutter mechanism that shuts off the laser light when the door is opened. To ensure there is no interruption to data acquisition, do not open the door while sorting or recording.

See the following sections for more information about the flow cytometer:

- Fluidics Components on page 25
- Optics System on page 35
- Cytometer Electronics on page 43
- Emergency Stop Button on page 44

**Fluidics Components**

When the fluidics system is activated, the sheath fluid from the pressurized sheath tank is forced from the fluidics cart up into the cuvette flow cell where hydrodynamic focusing forces particles from the sample injection chamber through the cuvette in a single-file stream.

Within the cuvette flow cell, laser light is focused on the sample core stream. Fluorescent molecules excited by the different laser wavelengths are detected by the optics and analyzed by the electronics. Particles are then either transported to waste reservoirs via the waste aspirator, or sorted into a collection device within the sort collection chamber.

The following fluidics components are described in this section. For more information about fluidics, see Fluid Movement on page 48.

- Sample Injection Chamber on page 27
- Tube Holders on page 28
- Cuvette Flow Cell on page 29
- Integrated Nozzle on page 30
- Sort Block on page 30
- Sort Collection Chamber on page 34

**Figure 1-6** Main fluidics components
**Sample Injection Chamber**

The sample injection chamber is where sample is introduced into the flow cytometer. During acquisition, the chamber is pressurized to force sample toward the cuvette flow cell.

Samples can be agitated and temperature-controlled within the sample injection chamber using controls in the software (see Fluidics Controls on page 83). You can view the amount of fluid remaining in your sample tube by pressing the chamber light button shown in Figure 1-7.

⚠️ Do not use the chamber light for long periods with samples stained with light-sensitive reagents.

*Figure 1-7 Sample injection chamber*
Tube Holders

A variety of tube holders are provided with the cytometer to accommodate tubes from 15-mL centrifuge tubes to 1.0-mL microtubes (Figure 1-8).

To load a tube, install the appropriate-size tube holder onto the loading port, and place a tube in the holder. Make sure to press the tube holder down firmly onto the metal rod in the loading port, so the tube holder is seated correctly each time a tube is installed.

When the Load button is clicked in the software (see Acquisition Controls on page 101), the loading port rises to enclose the tube within the chamber.

Figure 1-8 Tube holders

After a tube is loaded, the Load button changes to Unload. Click the Unload button to lower the loading port after data has been recorded. After each tube is unloaded, sheath fluid flushes the sample tubing inside and out to reduce potential sample carryover.

⚠️ To prevent injury from moving parts, keep your hands and clothing away from the loading port when a tube is loading or unloading. Do not place objects under the loading port.
Cuvette Flow Cell

The BD FACSARia III system includes a new flow cell that has been optimized for four laser beam spots. This flow cell is also included with the 375-nm laser option for side population studies. The cuvette flow cell is the heart of the BD FACSARia III cytometer (Figure 1-9). Within the flow cell, hydrodynamic focusing forces particles through the cuvette in a single-file stream, where laser light intercepts the stream at the sample interrogation point.

The unique flow cell design permits particles to flow through the cuvette at a low velocity (approximately 6 m/sec for the 70 micron sort setup), allowing longer exposure to laser energy. The cuvette is gel-coupled to the fluorescence objective lens to transmit the greatest amount of emitted light from the interrogation point to the collection optics (see Optics System on page 35). After passing through the cuvette, the stream is accelerated (to approximately 30 m/sec with the 70 micron sort setup) as it enters the nozzle tip, where the drop drive breaks the stream into droplets for sorting.
Integrated Nozzle

The BD FACSARia III next-generation flow cell requires integrated nozzles that have been optimized for it.

The integrated nozzles are available in four sizes (70, 85, 100, and an optional 130 µm) to accommodate a variety of particle sizes, plus a closed-loop nozzle for use in cleaning and shutdown procedures. The nozzle is keyed to a fixed position at the lower end of the cuvette. Because the nozzle is below the interrogation point, optical alignment is not affected when the nozzle is changed.

See these sections for more information on the nozzle:

- Changing the Integrated Nozzle on page 228
- Cleaning the Integrated Nozzle on page 229
- Handling the Integrated Nozzle on page 231

If the seal in an integrated nozzle eventually comes out or gets damaged, you can replace the seal with a standard O-ring. See Temporary Replacement of a Seal on page 232.

Sort Block

After leaving the nozzle, particles pass through the sort block where they are either transported to waste via the waste aspirator, or sorted into a collection device in the sort collection chamber. The sort block houses the high-voltage deflection plates, along with the aspirator and aspirator drawer (Figure 1-11).
Note that the entire sort block assembly can be rotated on a fixed pivot point to adjust the position of the stream in the waste aspirator. If the keyed stream position differs between different nozzles, the stream might not hit the center of the aspirator after the nozzle is changed. In this case, you can change the angle of the sort block by loosening the adjustment screws on both sides of the deflection plates and rotating the sort block. An Allen wrench is provided in the accessory kit. Tighten the screws when the stream is re-centered in the aspirator.
Deflection Plates

The high-voltage deflection plates are used to deflect side streams during sorting. The plates are turned on and off using the Voltage control in the Side Stream window (see Side Stream Formation on page 69). A red warning light is illuminated whenever the plate voltage is on (Figure 1-13 on page 33).

⚠️ A 12,000-volt potential exists between the deflection plates when they are on. Contact with the charged plates results in serious electrical shock. Do not touch the deflection plates when the voltage warning light is illuminated, or when the software indicates that the plate voltage is on. The plates remain energized even when the sort block door is open.

Aspirator Drawer

The aspirator drawer keeps the sort collection tubes covered until sorting begins (Figure 1-12). You can open and close the drawer using a control in the Sort Layout or Side Stream window (see Using Sorting Controls on page 110). When the Sweet Spot is on and a clog is detected during sorting, the drawer automatically closes to protect the sort collection tubes. For information on how to handle a clog, see Responding to a Nozzle Clog During a Sort on page 186.

⚠️ To avoid pinching your hands or fingers in the drawer, keep your hands away from the sort block during sorting.

Figure 1-12 Aspirator drawer closed (left) vs open (right)
Aerosol Management

During sample acquisition and sorting, the sort block door and flow cell access door should be kept closed to help contain potential aerosols (Figure 1-13).

⚠️ Cell sorters that use droplet generation methods, like the BD FACSAria III, can produce aerosols around the sample stream. When acquiring biohazardous samples, follow universal precautions at all times. Keep the sort block door closed during sorting. If you need to access the sort block and you are working with highly infectious samples, consider turning off the stream before opening the sort block door. If the system encounters a clog during a sort, see Responding to a Nozzle Clog During a Sort with the AMO on page 308.

Figure 1-13  Sort block with door closed

Additional aerosol removal is provided by the BD™ Aerosol Management Option (AMO). The AMO is an optional device that evacuates the sort collection chamber during sorting. The AMO is equipped with an ultra-low penetrating air (ULPA) filter to trap aerosolized particles.

See Appendix C, BD Aerosol Management Option on page 301 for complete information on using this option.
Sort Collection Chamber

Collection devices are installed in the sort collection chamber to collect sorted samples. The collection devices are designed in two pieces with a universal top that can be used with different tube configurations. The universal top has three holes on the back side that help with aerosol evacuation when an AMO system is installed. Figure 1-14 shows the types of collection devices that are available.

**Figure 1-14** Sort collection devices

![Universal top (front view)](image)

![Universal top (back view)](image)

![Four-way 1-mL (optional)](image)

![Four-way 12 x 75-mm](image)

![Four-way 1.5-mL Eppendorf](image)

![Two-way 12 x 75-mm](image)

![Two-way 15-mL](image)

An automated cell deposition unit (ACDU) that sorts into multiwell plates and onto microscope slides is available as an option. See Figure 1-15 on page 35. BD Biosciences also offers a temperature control option to maintain the temperature of sorted samples during sorting. See Temperature Control Option on page 321.
The sort collection chamber door should be kept closed when sorting onto a plate. The door keeps the chamber free of dust and other airborne particles, and seals the chamber during aerosol evacuation for cytometers equipped with the AMO.

**Figure 1-15** Plate Loader on ACDU

---

**Optics System**

The BD FACS Aria III cytometer uses innovative designs for both the excitation and collection optics. The optics can be viewed by opening the optics access door and the flow cell access door.

⚠️ The flow cell access door is equipped with a shutter mechanism that shuts off the laser light when the door is opened. To ensure that there is no interruption to data acquisition, do not open the door while sorting or recording.

For detailed optics specifications, see Laser Options on page 287.
Excitation Optics

The excitation optics consist of lasers, fiber optic cables, beam-shaping prisms, and an achromatic focusing lens, as shown on the X-mount optical plate.

Figure 1-16 X-mount optical plate

For information about how signals are generated, see Signal Generation on page 52.

The BD FACSARia III cytometer uses air-cooled and solid state lasers that do not have special power or cooling requirements.

The system also supports up to six installed lasers, of which only four can be used at once.

See Table 1-1 for the laser choices. See Laser Options on page 287 for laser specifications.

Table 1-1 Laser configurations

<table>
<thead>
<tr>
<th>Laser</th>
<th>Wavelength (nm)</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>633</td>
<td>Standard</td>
</tr>
<tr>
<td>Yellow-Green</td>
<td>561</td>
<td>Optional</td>
</tr>
<tr>
<td>Blue</td>
<td>488</td>
<td>Standard</td>
</tr>
</tbody>
</table>
Fiber optics direct the laser light in a precise and constant manner onto beam-shaping prisms, which in turn transmit the laser light to a focusing lens. The lens focuses the laser light onto the sample core stream within the cuvette flow cell (Figure 1-9). The lasers are positioned on the sample stream for optimal generation of signals. Since the optical pathway and sample core stream are fixed, optimization is constant from day to day.

The X-Mount Optical Plate

The fiber optic heads for the new lasers and all existing lasers (except the 375-nm laser) are mounted on an X-mount optical plate. Figure 1-17 on page 38 shows the location for each fiber optic head.

The 488-nm and the 445-nm both share the same beam spot, so only one of them can be used at a time. Similarly, the 375-nm and 405-nm share a beam spot and only one of them can be used at a time.

Table 1-1 Laser configurations

<table>
<thead>
<tr>
<th>Laser</th>
<th>Wavelength (nm)</th>
<th>Comments</th>
</tr>
</thead>
</table>
| Blue-Violet| 445             | Optional
|            |                 | Uses the same optical path and PMTs as the blue laser. See Laser Options on page 287. |
| Violet     | 405             | Optional                                                                 |
| Near UV    | 375             | Optional
|            |                 | Uses the same optical path and PMTs as the violet laser. See Laser Options on page 287. |

⚠️ Lasers emit intense, coherent electromagnetic radiation that can cause irreparable damage to skin and eyes. To prevent retinal burns and possible blindness, do not remove laser shielding, adjust laser controls, or attempt to service the cytometer any place where laser warning labels are attached. See the *BD FACSAria III Safety and Limitations Guide* for the placement of laser warning labels.

Fiber optics direct the laser light in a precise and constant manner onto beam-shaping prisms, which in turn transmit the laser light to a focusing lens. The lens focuses the laser light onto the sample core stream within the cuvette flow cell (Figure 1-9). The lasers are positioned on the sample stream for optimal generation of signals. Since the optical pathway and sample core stream are fixed, optimization is constant from day to day.

---

Chapter 1: Cytometer Components 37
Depending on how your system is configured, you can choose different combinations of lasers by adjusting the rotary power switches on your power panel. For more information, see Power Panel on page 43.

**Figure 1-17** The X-mount optical plate laser configuration

The 375-nm laser option features a solid state laser that also excites fluorochromes and dyes. It is also useful for population studies. It uses the same emission pathways as the violet laser option. The laser alignment is fixed and requires no adjustments once it is installed.

The 375-nm laser is the only laser not mounted on the X-mount optical plate. It is mounted next to the flow cell as shown in the following figure.
Collection Optics

From the cuvette flow cell, laser light is collected by a fluorescence objective lens that is gel-coupled to the cuvette to transmit the maximum amount of light. The lens collects and focuses fluorescent light emitted at each of the laser focal points onto individual collection fibers. These fibers transfer the emitted light to the collection optics, as shown in Figure 1-18.

**Figure 1-18** Side view of flow cell, nozzle, and objective lens

The collection optics are set up in octagon- and trigon-shaped arrays that are engineered to maximize signal detection from each laser. This is accomplished by transmitting the highest wavelengths to the first photomultiplier tube (PMT), and reflecting lower wavelengths to the next PMT through a series of longpass dichroic mirrors. Bandpass filters in front of each PMT allow fine-tuning of the...
spectral wavelengths that need to be collected. Since reflection is more efficient than transmittance, this design greatly increases the multicolor detection capabilities of the cytometer. See Figure 1-19.

**Figure 1-19** Transmission pathways in an octagon

![Diagram of transmission pathways in an octagon]

**Detectors**

BD FACSARia III systems can be configured with up to six lasers, with four active at one time. For complete information about laser options, mirrors, filters, and fluorochromes required for each laser, see Laser Options on page 287.

The following figure shows the locations of detector arrays in a 6-laser system. The locations differ depending on which lasers are installed in your system.
Figure 1-20 6-laser system with two trigons and two octagons

Front trigons and octagon

488/445-nm Trigon

633-nm Trigon

405/375-nm Octagon

Back octagon

561-nm Octagon
Stream-Viewing Optics

The BD FACS™ Aria III cytometer is equipped with optical components that are used to view the stream (Figure 1-21).

- The upper camera generates an image used to monitor drop formation. It is focused on the stream, just below the nozzle, to provide an image of the drop breakoff.

- The lower camera generates an image used for the BD FACS™ Accudrop option. It enhances the ability to see the side streams and assists in setting an accurate drop delay value.

Figure 1-21 Stream-viewing optics

Special image-processing software allows you to view the stream images from each camera within separate windows in BD FACSDiva software. See Sorting on page 64 for more information about viewing the streams and to learn how Accudrop components are used to determine the drop delay.
Cytometer Electronics

The electronic components consist of power controls and connectors along with processing boards in the card cage. This section describes only adjustable cytometer electronics. For more information about the electronics, see Signal Detection on page 54.

Power Panel

Power to the cytometer, lasers, and fluidics cart is supplied by a power cord plugged directly into a standard electrical outlet. There are no special facilities requirements.

Figure 1-22  Flow cytometer power supply on 3-laser system

The cytometer circuit breaker is located next to the fluidics cart power cord (Figure 1-22). The switch needs to be reset if there is a power surge in the laboratory.

The main power button turns on the cytometer and fluidics cart, and enables the laser rotary switches. The switch labels and the functionality of the switches can vary depending on which are installed. To turn on lasers, rotate the switches to the desired settings.

Allow 30 minutes for the lasers to warm up.
Emergency Stop Button

The emergency stop button to the right of the loading port (Figure 1-23) is a safety feature that can be used to stop the movement of the loading port and ACDU stage. The button lights up when a tube is loading to remind you to keep your hands away from the loading port.

Figure 1-23  Emergency stop button
The following occur when this button is pushed:

- The tube is unloaded from the sample injection chamber.
- The ACDU stage (if in use) stops moving.
- The stream is turned off.
- The deflection plate voltage is turned off.
- The aspirator drawer (if open) closes to protect the sort collection tubes.
- A warning message appears on the screen.

**NOTE** The emergency stop button does not turn off the lasers or shut down the cytometer main power.

Do not reset the button until the message appears. To reset the button, turn the button clockwise until the light turns off and the button returns to its original position.
Workstation

Data acquisition and analysis, as well as most BD FACSAria III cytometer functions, are controlled by BD FACSDiva software on a third-party PC workstation. The workstation includes a desktop computer, one or two monitors, and a color printer, and is equipped with the following applications:

- Microsoft Windows operating system
- BD FACSDiva software, version 7.0 or later
  - Data acquisition and analysis
  - Automatic fluidics startup, shutdown, and cleaning modes
  - Sort setup, stream monitoring, clog detection, and recovery
  - CS&CT module for setup and tracking performance
- Supporting documentation for the software

For information about software features specific to the BD FACSAria III, see Chapter 2, Theory of Operation, and Chapter 3, Using BD FACSDiva Software. For general software information, see the BD FACSDiva Software Reference Manual.

Theory of Operation

This chapter describes how the BD FACSAria III cytometer works and how BD FACSDiva software components are used to operate different system components. For a general overview of the software, see Using BD FACSDiva Software on page 81.

See the following sections for a description of these BD FACSARia III functions:

- Fluid Movement on page 48
- Signal Generation on page 52
- Signal Detection on page 54
- Sorting on page 64
**Fluid Movement**

The fluidics system is responsible for moving particles from the sample injection chamber through the cuvette flow cell for interrogation, and then to waste or into a collection device during sorting (Figure 2-1). The following sections describe the controls used to move fluids through the BD FACSaria III fluidics system.

*Figure 2-1*  Fluidic movement via the fluidics system
Sheath Flow

When you turn on the cytometer, the main air compressor starts up. The fluidics system is activated when you select the Fluidics Startup command in BD FACSDiva software. During fluidics startup, sheath fluid is forced from the pressurized sheath tank through a filter and is delivered to the cuvette flow cell at a constant pressure. You can view the current sheath pressure setting by selecting Cytometer > Sheath Pressure (Figure 2-2).

Figure 2-2  Sheath pressure level

After fluidics startup, sheath flow is controlled using the Stream button in the Breakoff window (Figure 2-3). When clicked, the button changes from a red “X” to a green check mark, and sheath flows through the cuvette flow cell at the rate that is specified in the Sheath Pressure dialog. (See Drop Formation on page 65 for a complete description of the Breakoff window.)

Figure 2-3  Stream control in Breakoff window

As a general rule, the sheath pressure level is set by selecting a sort setup mode from the Sort menu, rather than by adjusting the sheath pressure control. Each sort setup mode is optimized at a preset sheath pressure. If you change the sheath pressure, a multitude of other values will be affected and need updating, including the drop drive frequency, drop delay value, laser delay, area scaling factor, and other values. For more information, see Sort Setup on page 104.
Sample Flow

Sample is introduced into the cuvette when the Load button is clicked on the Acquisition Dashboard (Figure 2-4). After Load is clicked, the loading port rises to enclose the tube within the sample injection chamber. The chamber is automatically pressurized and the chamber pressure forces sample through the sample line into the cuvette flow cell. To stop sample flow after a tube is loaded, click the **Stop Acquiring** button.

The sample flow rate is specified using the Flow Rate field in the Acquisition Dashboard. You can adjust the flow rate from 1–11, which corresponds to approximately 10–80 µL/min.

**Figure 2-4** Load button and Flow Rate field on Acquisition Dashboard

Note that the relatively longer sample tubing on the BD FACSAria III cytometer results in a different flow rate between cells and beads. Thus, absolute counting using BD Trucount™ beads can yield erroneous results.
Hydrodynamic Focusing

In the flow cell, pressurized sheath fluid surrounds the sample fluid to hydrodynamically focus the core stream of suspended cells into the center of the cuvette, where the particles are intercepted by the laser beam.

The difference in pressure between the sheath fluid and the sample fluid can be used to vary the diameter of the sample core. A lower difference results in a relatively narrow core stream, while a higher difference results in a wider sample stream.

Ideally, you want the core stream at its minimum diameter so that cells pass through the laser beam in a single-file stream. However, depending on your application, a lower resolution might be acceptable in order to acquire the data more quickly. For example, with this three-laser configuration, a higher flow rate is generally used for qualitative measurements such as immunophenotyping—the data is less resolved but is acquired more quickly. A lower flow rate is generally used in applications where greater resolution is critical.
Signal Generation

The following sections describe how signals are generated when cells or particles intercept the laser within the cuvette flow cell.

Light Scatter

When a cell or particle passes through a focused laser beam, laser light is scattered in all directions. Light that scatters axial to the laser beam is called forward scatter (FSC). Light that scatters perpendicular to the laser beam is called side scatter (SSC). FSC and SSC are related to certain physical properties of cells:

- FSC indicates relative differences in the size of the cells or particles.
- SSC indicates relative differences in the internal complexity or granularity of the cells or particles.
Fluorescent Signals

When cells or particles stained with fluorochrome-conjugated antibodies or other dyes pass through a laser beam, the dyes can absorb photons (energy) and be promoted to an excited electronic state. In returning to their ground state, the dyes release energy, most of which is emitted as light. This light emission is known as fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon) than the excitation wavelength. The difference between the excitation wavelength and the emission wavelength is known as the Stokes shift. Some fluorescent compounds such as PerCP exhibit a large Stokes shift, absorbing blue light (488 nm) and emitting red light (675 nm), while other fluorochromes such as FITC have a smaller Stokes shift, absorbing blue light and emitting green light (530 nm).

The emission spectra for some commonly used fluorochromes are shown in Figure 2-5.

Figure 2-5  Emission spectra of commonly used fluorochromes
**Signal Detection**

From the cuvette flow cell, scattered and fluorescent light is collected by the fluorescence objective lens. The lens collects and focuses fluorescent light emitted at each of the laser focal points onto individual collection fibers. These fibers transfer the emitted light to the individual detector arrays.

The following sections describe how laser light is detected and translated into signals that can be displayed in a plot.

**Detector Arrays**

There are two types of detector arrays in the BD FACS Aria III flow cytometer: octagons and trigons. Each detector array houses dichroic and bandpass filters, which steer and filter the emitted light, and PMTs, which detect light signals.

In the configuration shown in Figure 2-6, the octagon detects SSC and up to seven fluorescence signals excited by the 488-nm (blue) laser. The trigons detect fluorescence signals excited by the 633-nm (red) and 405-nm (violet) lasers, respectively. Each trigon can detect up to three fluorescence channels. (An optical upgrade is required to fill all detection channels.)

*Figure 2-6 3-laser system with two trigons and one octagon*
Filters

Optical filters modify the spectral distribution of light scatter and fluorescence directed to the detectors. Three kinds of filters are used in the detector arrays: longpass (LP) filters are used to steer light between the detectors within a detector array, while bandpass (BP) and neutral density (ND) filters allow fine-tuning of the spectral wavelengths that need to be collected (Figure 2-7).

Figure 2-7  Detectors and filters in an octagon array
Longpass Filters

LP filters pass wavelengths longer than the filter rating and reflect shorter wavelengths. For example, a 500 LP filter permits wavelengths longer than 500 nm to pass through it and reflects wavelengths shorter than 500 nm (Figure 2-8).

Figure 2-8 Light reflection by longpass filter

![Figure 2-8](image)

Dichroic filters that are used to direct different color light signals to different detectors are called dichroic mirrors or beam splitters.

Although dichroic mirrors have the properties of LP optical filters, you cannot necessarily use any type of LP filter as a beam splitter. A beam splitter must have a surface coating that reflects certain wavelengths, but many types of LP filters are absorbance filters that do not have any specific reflective characteristics. Also, optical filters and beam splitters are rated at a specific angle of incidence. When used as a beam splitter, they are placed at an angle relative to the light source. Their optical properties are therefore designed for that angle of incidence.

The detector arrays use LP dichroic mirrors to steer progressively shorter wavelengths of light to the next PMT in the array. For example, in the octagon array, light first passes through a 735 LP filter in the A position, followed by a 655 LP filter in the B position. Thus, wavelengths longer than 735 nm are detected at PMT-A. All wavelengths <735 nm are reflected to PMT-B. Wavelengths between 655 nm and 735 nm are detected at PMT-B. All wavelengths <655 nm are reflected to PMT-C, and so on. For a list of the longpass filters used in the detector arrays, see Laser Options on page 287.
Bandpass Filters

BP filters transmit a relatively narrow range or band of light. Bandpass filters are typically designated by two numbers. The first number indicates the center wavelength and the second refers to the width of the band of light that is passed. For example, a 500/50 BP filter transmits light that is centered at 500 nm and has a total bandwidth of 50 nm. Therefore, this filter transmits light between 475 and 525 nm (Figure 2-9).

Figure 2-9 Light transmittance by bandpass filters

Discriminating (DF) filters have the same general function—they transmit a relatively narrow band of light. The principal difference between BP and DF filters is their construction. DF filters have more cavities or layers of optical coatings, resulting in a steeper transmission curve than the curve for a BP filter. This steep slope means that a DF filter is better at blocking light outside the rated bandwidth of the filter. See Figure 2-10 on page 58.
In the detector arrays, DF filters block high-intensity laser light and filter the remaining light to ensure that only the required wavelengths reach their intended detector. For example, in the octagon array, PMT-A has a 780/60 DF filter in front of it, which transmits light of 750–810 nm. Thus, the only wavelengths that will reach the A detector are those between 750 and 810 nm.

For optimal detection of fluorescent light, a bandpass filter must always be installed in front of each detector. For a list of the bandpass filters used in the detector arrays, see Laser Options on page 287.

Neutral Density Filters

ND filters transmit a fixed percentage of light, reducing the transmitted intensity of all wavelengths equally. ND filters are neutral with respect to wavelength.
The ND1 filter on the BD FACSAria III allows approximately 10% of the light to be transmitted. You can find the ND filter in front of the FSC detector. For applications involving small particles (e.g., bacteria or platelets), you might need to remove the FSC ND filter. For applications involving large particles where events appear off scale on the FSC axis with a gain of zero, a higher value ND filter is needed to decrease the FSC signal and keep the events on scale.

The system comes with three ND filters: 1, 1.5, and 2. See Removing or Installing the FSC ND Filter on page 246.

**Detectors**

Detectors within each detector array convert light signals into electrical signals that can be processed by the electronics system.

There are two types of signal detectors in the BD FACSAria III flow cytometer: the photodiode and PMTs. The photodiode is less sensitive to light signals than the PMTs, and is used to detect the stronger FSC signal. The photodiode detects FSC light from the blue laser, and is stored outside the detector arrays. PMTs are used to detect the weaker signals generated by SSC and all fluorescence channels. The octagon can hold up to eight PMTs. Each trigon can contain up to three PMTs.

Each PMT detects only one fluorochrome at a time. In BD FACSDiva software, the Cytometer Configuration window lets you define which fluorochromes or cell parameters will be measured at each PMT detector. If more than one fluorochrome is measured using the same PMT, you can add additional parameters to your configuration and select the appropriate fluorochrome within your software experiment. See Cytometer Configuration on page 87 for more information.
Electronic Processing

As cells or other particles pass through the focused laser beams, they scatter the laser light and can emit fluorescence. Because each laser beam is focused on a small spot and particles move rapidly through the flow cell, the scatter or fluorescence emission has a very brief duration—only a few microseconds. The PMTs convert this brief flash of light into an electrical signal called a pulse (Figure 2-12).
Pulse Parameters

A parameter is a pulse property that is generated by a single PMT or photodiode, measuring fluorescent or scattered light. You can measure three characteristics of a pulse: area, height, and width. The pulse height measures the maximum digitized value for the pulse, the pulse area calculates the sum of all height areas for the pulse, and the pulse width calculates \( \text{area} \times \frac{64000}{\text{height}} \).
You can select which pulse characteristics you want to measure for each parameter using the Parameters tab. Pulse area (A) is measured by default. The Parameters tab also contains voltage controls that allow you to amplify signals by applying a voltage to PMTs or an electronic gain to the FSC signal. As the voltage is increased, the detector sensitivity increases, resulting in increased signal. As the voltage is decreased, the detector sensitivity decreases, resulting in decreased signal.

Digital data is displayed on an 18-bit linear scale, from 2.6–262,144. Select the Log check box to convert the display to a log scale. The Experiment Inspector contains an option to display log data on a four- or five-decade scale. (See the BD FACSDiva Software Reference Manual for more information.)
Laser Delay

Sample interrogation takes place within the cuvette flow cell. Fiber optic cables are used to direct laser light through a series of prisms that focus each laser on the stream at a separate position. This allows optimal detection of fluorescence signals from each laser with minimal cross-contamination from the other beams.

In a three-laser system, the red laser intercepts the stream first, followed by the blue and then the violet laser. Because the laser signals are spatially separated, there is a slight delay between the detection of each laser’s signal (Figure 2-13).

The delay factor in BD FACSDiva software is used to realign the signals so they can be measured and displayed on the same time scale. Note that signals are aligned with respect to the blue laser, so the red laser signals always have a negative delay value.

When using a forth laser beam spot, you will notice a difference in default laser delays with the 561-nm or 445-nm laser compared to a three-laser configuration.

Laser delay is set automatically when you use the CS&T module. For information about manually adjusting the laser delay, see Manual Adjustment of Laser Delay on page 163.
Sorting

During sorting, drop drive energy is applied to the stream to break it into highly uniform droplets. Droplets detach from the stream a few millimeters downstream from the nozzle. The time between when a particle intercepts the laser and when it reaches the droplet breakoff point is determined using BD FACS Accudrop technology (see Drop Delay Overview on page 71).

When a particle is detected and meets the predefined sorting criteria, an electrical charge is applied to the stream just as the droplet containing that particle breaks off from the stream. Once broken off from the stream, the droplet—now surrounded by air—still retains its charge. The charged droplet passes by two strongly charged deflection plates. Electrostatic attraction and repulsion cause each charged droplet to be deflected to the left or right, depending on the droplet’s charge polarity. Uncharged droplets are not affected by the electric field and pass down the center to the waste aspirator. See Figure 2-14 on page 65.

The following sections describe how the BD FACSARia III cytometer creates and charges drops, how the drops are deflected, and how sorting populations are identified.
Drop Formation

The BD FACSARia III cytometer constantly applies drop-drive energy to the stream. Droplets form as soon as you turn on the stream. Sample interrogation takes place upstream of the stream vibration so that analysis is not affected by the drop drive.

A drop breakoff image is created using an LED strobe and a video camera. The image is displayed in the Breakoff window (see Breakoff Window on page 66). Patented Sweet Spot technology analyzes the drop breakoff image and provides feedback to the appropriate cytometer controls.
Breakoff Window

Use the Breakoff window to control a number of aspects related to drop formation.

Table 2-1 Breakoff window controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stream button</td>
<td>Turns the stream on and off.</td>
</tr>
<tr>
<td>Sweet Spot button</td>
<td>Enables automatic adjustment of the drop drive amplitude to maintain the stability of the breakoff point.</td>
</tr>
<tr>
<td>Amplitude field</td>
<td>Adjusts the amplitude or intensity of the drop drive, from 1.0–80.0 volts.</td>
</tr>
<tr>
<td>Frequency field</td>
<td>Determines the number of drops formed per second and the size of the drops. (Drop size is also influenced by the nozzle size.)</td>
</tr>
</tbody>
</table>
Breakoff Functionality

The upper camera transmits an image of the drop breakoff to the Breakoff window, where video image processing software converts the visual characteristics of the image into numerical properties. The drop breakoff is analyzed for two key features: Drop 1 and Gap.

Drop 1 is defined as the number of pixels from the top of the image to the center of gravity of the first broken-off drop. A thin gray line on the image is used to identify this drop. The number shown to the right of the Drop 1 field at the bottom of the window is the actual pixel location of the gray line. The number entered into the Drop 1 field is the user-defined Drop 1 target.

The Gap is defined as the number of pixels from the first discontinuity in the stream to the next stream object, generally the first broken-off drop. A gray line of varying thickness represents the Gap. The number shown to the right of the Gap field is the pixel width of the gray line. The number entered into the Gap field is a user-defined target.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency field (continued)</td>
<td>In general, the drop drive frequency should not need adjustment. We recommend using the default values that are entered with each Sort Setup mode.</td>
</tr>
<tr>
<td>Drop 1 field</td>
<td>The distance between the top of the image and the center of the first broken-off drop, from 100–600 pixels. When you enter a value and turn on the Sweet Spot, the cytometer automatically adjusts the amplitude to attain your target value. Note that not all Drop 1 targets are attainable. The Drop 1 value jumps in whole increments of approximately 57 pixels according to your drop spacing. The same Drop 1 setting can be used from day to day. A difference of up to 10 pixels between the target value and the actual value is acceptable.</td>
</tr>
<tr>
<td>Gap field</td>
<td>The gap between the stream breakoff and the top of the first drop. The default Gap setting for a 70-micron nozzle is 6 pixels.</td>
</tr>
</tbody>
</table>
When the Sweet Spot is turned on, the drop drive amplitude (Ampl) is automatically adjusted to approximately match the target Drop 1 and Gap values. The amplitude is initially adjusted in larger increments until Drop 1 is achieved. The amplitude is then adjusted in smaller increments until the cytometer attains the target Gap. The Sweet Spot feature will make adjustments as necessary to maintain the required breakoff conditions throughout the day.

The Sweet Spot performs two other functions during sorting. When sorting, if the Drop 1 or Gap are out of range, sorting is paused until the values are back within range. This ensures that sorting occurs only under the proper breakoff conditions. If a more severe problem such as a clog is detected by the Sweet Spot, the stream is shut off and sorting is stopped, the deflection plates shut off, the aspirator drawer closes, and the sample tube is unloaded.

Pre-programmed values can be downloaded to the Breakoff window by selecting one of the nozzle sizes (70, 85, 100, or 130 micron) from the Sort > Sort Setup menu.

Note that changes to values in the Sort Setup windows (Breakoff and Side Stream) are automatically saved. At startup, the last settings used on the cytometer are restored, except the Stream and Sweet Spot controls which always default to off. For more information, see Sort Setup on page 104.

Typically, when setting up for sorting, you use the Amplitude to set the required drop breakoff, and copy the generated Drop 1 value to the target field. Then, you turn on the Sweet Spot to maintain the drop breakoff. When the Sweet Spot detects a >1-pixel difference between the target Gap setting and the actual Gap, it adjusts the Amplitude to reduce the Gap. When a >2-pixel difference is detected, the Sweet Spot stops sorting temporarily (stops charging the stream) until the Gap is restored. Note that when the sort is paused, the sample continues to flow. Once the Gap is back within range, sorting automatically resumes.

For information on setting the breakoff, see Setting Up the Breakoff on page 124.
Side Stream Formation

Side streams are formed when the voltage is on and you are sorting, or when you click Voltage, then Test Sort in the Side Stream window.

The Side Stream window displays an image of the side streams as transmitted by the lower camera. In addition to the stream image, the Side Stream window contains the controls used to adjust electrical charges and to determine the drop delay using Accudrop, as described in Drop Delay Overview on page 71.

**Figure 2-15** Side Stream window

Controls in the Side Stream window are described in Table 2-2 on page 70. You can send different values to the Side Stream window by selecting a nozzle size from the Sort > Sort Setup menu.

Note that changes to values in the Sort Setup windows (Side Stream and Breakoff) are linked to the sort setup and are automatically saved. At startup, the last settings used on the cytometer are restored, except the states of the Voltage, Test Sort, and Optical Filter buttons, which always default to off. For more information, see Sort Setup on page 104.
Table 2-2  Side Stream window controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage button</td>
<td>Turns the plate voltage on and off.</td>
</tr>
<tr>
<td>[On] [Off]</td>
<td></td>
</tr>
<tr>
<td>Test Sort button</td>
<td>Generates test side streams based on test sort pulses.</td>
</tr>
<tr>
<td>[On] [Off]</td>
<td></td>
</tr>
<tr>
<td>Optical Filter button</td>
<td>Controls the position of the optical filter in front of the lower (Accudrop) camera.</td>
</tr>
<tr>
<td>[In] [Out]</td>
<td></td>
</tr>
<tr>
<td>Attenuation button</td>
<td>Decreases the amplitude of the drop drive. At lower pressures, you may need to turn on attenuation to dampen the amplitude.</td>
</tr>
<tr>
<td>[Off] [On]</td>
<td></td>
</tr>
<tr>
<td>Waste Drawer button</td>
<td>Opens or closes the aspirator drawer depending on its current state. The default state is closed. For more information, see Aspirator Drawer on page 32.</td>
</tr>
<tr>
<td>[Closed] [Open]</td>
<td></td>
</tr>
<tr>
<td>Drop Delay field</td>
<td>Sets the amount of time between when an event is measured and the breakoff point, from 10–140 drops. The drop delay value determines which drop will be deflected. The drop delay value is set experimentally using BD FACS Accudrop technology.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Delay</td>
<td>Opens the Auto Drop Delay dialog.</td>
</tr>
<tr>
<td>Voltage sliders (far left, left, right, far right)</td>
<td>Set the percentage of charge to be applied to the corresponding stream (as a percentage of maximum).</td>
</tr>
<tr>
<td>Voltage Center slider</td>
<td>Adjusts the relative voltage between the left and right plates which moves the streams slightly to the left or right as a whole. In general, this slider rarely needs adjusting.</td>
</tr>
</tbody>
</table>
Drop Delay Overview

The BD FACSAria III cytometer includes integrated Accudrop technology to assist in setting an accurate drop delay value. Accudrop components consist of the following:

- A diode laser, mounted to the left of the sort block
- A camera that provides an image of the side streams
- An emission filter for viewing the fluorescence from BD FACS™ Accudrop beads

The emission filter is installed in front of the lower camera and can be moved in and out by clicking the Optical Filter control. When the button is green ( ), the filter is out. This position is used to view the center and side streams.

Click the button to move the filter in front of the camera when you are determining the drop delay. The button changes to red ( ). To determine the drop delay, the streams are illuminated by the diode laser just below the point of deflection. Specialized fluorescent particles (Accudrop beads) can be viewed in the center and left side streams as the delay is adjusted. The best delay yields the most particles in the left stream and the fewest in the center stream.

### Table 2-2 Side Stream window controls (continued)

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Voltage field</td>
<td>Adjusts the total voltage difference between the plates, which determines the angle of stream deflection. The voltage values change with different nozzle sizes.</td>
</tr>
<tr>
<td>2nd, 3rd, 4th Drop fields</td>
<td>Apply a correction factor for the drop charge as a percentage of the previous drop, from –100% to 100%.</td>
</tr>
<tr>
<td>Phase field</td>
<td>Adjusts the phase between drop generation and charging of the droplets from 0–360°. The selected value is sent to both the drop-charging electrode and the drop strobe. In general, the Phase never needs adjusting. You can keep the default value of zero.</td>
</tr>
</tbody>
</table>

Chapter 2: Theory of Operation  71
See Determining the Drop Delay – Manual Method on page 172 for more information.

**Auto Drop Delay**

The Auto Drop Delay feature enables the system to optimize the drop delay automatically. See Determining the Drop Delay – Automatic Method on page 177.

**Drop Charging**

Drops are charged when an event is detected and meets the defined sorting criteria, as specified in the Sort Layout window.

The Sort Layout window contains all sorting instructions and controls (Figure 2-16). The sort layout designates which device will be used to collect sorted particles and which particles will be sorted into each sort location. Up to four sort counters can be displayed in the window to give ongoing status during a sort. Depending on your system's configuration, your setup values may vary. For more information about the Sort Layout window, see Table 3-2 on page 105.

**Figure 2-16 Sort layout for a four-way sort**

![Sort layout for a four-way sort](image)

Target events are identified by drawing gates around populations of interest in plots. The Sort Layout window specifies which gated population should be sorted into each sort collection tube or spot in a plate or on a slide. During sorting, when an event is identified within one of the sort gates, the drop containing the particle of interest is charged via the stream-charging wire attached to the flow cell. See Figure 2-17.
The amount and type of charge determines where the drop will be sorted. For example, in a four-way sort, drops with the most charge will be deflected into the outer streams, while drops with less charge will be deflected into the inner streams.

**Conflict Resolution During Sorting**

During sorting, the cytometer deflects drops based on the characteristics of the particles in each drop and where the user wants to deflect them. Conflicts can occur depending on the type of target particle, where the particle is located within a drop, or whether the drop is free of contaminating particles. BD FACSDiva software accurately measures particle position to within 1/32 of a drop.

Mask settings determine how drops are deflected when sorting conflicts occur. There are three mask settings, each of which addresses a different type of conflict. These settings are combined to define sort precision modes. Each mode is made up of a set of masks. Precision modes are defined in the Sort Precision dialog, accessed from the Sort menu.
Yield Mask

The yield mask setting defines how close to the edge of the drop, in 1/32-drop increments, a particle of interest can be located before sorting an additional drop. Half of each yield mask setting defines an equal area at each end of the drop.

For example, when the yield mask is set to 16 and an event is within 8/32 from the beginning of a drop, the previous (leading) drop will be sorted. If an event is within 8/32 from the end of a drop, the following (trailing) drop will be sorted. See Figure 2-18.

**Figure 2-18** Target particle within a yield mask of 16

![Target particle within a yield mask of 16](image)

If the yield mask were set to 8 for the same target particle, the target particle would fall outside of the yield mask. Therefore, no additional drops would be sorted. See Figure 2-19.

**Figure 2-19** Target particle outside a yield mask of 8

![Target particle outside a yield mask of 8](image)

When the yield mask is set to zero, only one drop (the drop containing the target particle) will be deflected. When the mask is set to 32, two drops will always be deflected. Yield masks between 0–32 will sort either one or two drops.

Yield masks cannot be used in conjunction with phase masks. Therefore, when the yield mask is greater than zero, the phase mask automatically reverts to zero.
Purity Mask

The purity mask setting defines how close, in 1/32-drop increments, a contaminating drop can be located before ignoring the drop being interrogated.

For example, when the purity mask is set to 16, the drop being interrogated will not be sorted if a non-target particle falls within the first or last 8/32 of the leading or trailing drop. In the following example, a non-target particle falls within the first 8/32, so the interrogated drop will not be sorted. See Figure 2-20.

![Figure 2-20 Non-target particle within a purity mask of 16](image)

If the purity mask were set to 8 for the same target particle, the non-target particle would fall outside of the purity mask, so the interrogated drop would be sorted. See Figure 2-21.

![Figure 2-21 Non-target particle outside a purity mask of 8](image)

With any purity mask greater than zero, the drop being interrogated must be free of contaminating particles or the drop will not be sorted. If the purity mask is set to zero, a droplet containing the event of interest will be sorted regardless of contaminating particles.
Phase Mask

Particles near the drop edge can affect the breakoff and alter the trajectory of the deflected drop. The phase mask restricts drop deflection when an event is too close to the edge of a drop or when there are events close to the edge of adjacent drops. A phase mask is used to improve counting accuracy and side-stream quality at the expense of yield.

For example, when the phase mask is set to 16, the drop being interrogated will be sorted only if the target particle falls outside the phase mask. See Figure 2-22.

![Figure 2-22 Sorted and unsorted drop with phase mask of 16](image)

Decreasing the phase mask to 8 allows more drops to be sorted. However, because the target particle is closer to the edge of the drop, there is more variability in drop trajectory. See Figure 2-23.

![Figure 2-23 Sorted drop with phase mask of 8](image)

Tip We recommend using a phase mask of at least 8 when sorting single cells.

Phase masks cannot be used in conjunction with yield masks. Therefore, when the phase mask is greater than zero, the yield mask automatically reverts to zero.
Sort Precision Modes

Mask values can be combined in many different ways. By default, six sort precision modes are already defined: Purity, 4-Way Purity, Yield, Single Cell, Initial, and Fine Tune.

- **Purity mode.** The yield mask is set to the maximum to obtain the greatest number of particles. Because the purity mask is also set to the maximum, only drops free of contaminating particles will be sorted. Sorting in Purity mode results in a sorted sample that is highly pure, at the expense of recovery and yield.

- **4-Way Purity mode.** The purity mask is set to the maximum, so only drops free of contaminating particles will be sorted. The yield mask is set to zero to ensure that residual charges from adjoining drops do not degrade the quality of side streams. The 4-Way Purity mode is recommended for four-way sorting where precise deflection is required.
• **Yield mode.** Only the yield mask is used at its maximum value. Recovery and yield are optimized at the expense of purity. The yield mode could be used as a first round sort for enrichment of target particles, followed by a sort for purity.

• **Single Cell mode.** The purity mask is set to the maximum, so only drops free of contaminating particles will be sorted. The phase mask is set to half the maximum, so only particles centered within the sorted drop are deflected. Drop trajectory and count accuracy are optimized at the expense of yield. This mode is recommended for plate sorting or situations where precise counting is required.

The remaining modes are used mainly during drop delay determination. Initial mode is equivalent to Yield mode, but it is named differently as a reminder to use this as the initial mode when using Accudrop to set the drop delay.

• **Initial mode.** Only the yield mask is used at its maximum value. Recovery and yield are optimized at the expense of purity.

• **Fine Tune mode.** All masks are set to zero to deflect the maximum number of drops. This mode is used to fine-tune the drop delay value. See Determining the Drop Delay – Manual Method on page 172 for more information.
Defining New Precision Modes

Default precision modes cannot be edited or deleted. However, you can create new modes and then select them from the Precision Mode menu.

1. Select Sort > Sort Precision.

![Sort Precision dialog box]

2. Click Add.

   The current sort mode is duplicated and the Mask fields are enabled.

3. (Optional) Change the name of the mode in the Precision Mode field.

4. Enter values for Yield Mask, Purity Mask, and Phase Mask.

5. Select the Single Cell checkbox, if needed.

6. Click Close.

   The new mode is added to the Precision Mode menu.

To delete a mode, select it from the Precision Mode menu and click Delete.
Many BD FACS Aria III cytometer functions are controlled using BD FACSDiva software. This chapter provides a general overview of the workspace components and describes software controls that are unique to the BD FACS Aria III cytometer. For an in-depth description of software components not described in this chapter, see the *BD FACSDiva Software Reference Manual*.

The following topics are covered in this chapter:

- Workspace Components on page 82
- Cytometer Controls on page 83
- Sorting Controls on page 102
- Templates on page 115
Workspace Components

When you start BD FACSDiva software, the workspace appears (See Figure 3-1). For a general overview of the workspace and to get started using the software, see the tutorials and quick reference guides located in the Resource Library on the BD Biosciences website (bdbiosciences.com). When running BD FACSDiva with the BD FACS Aria III, two additional windows can be displayed by clicking the Sorting button on the Workspace toolbar. See Sorting Controls on page 102 for a description.

Figure 3-1 BD FACSDiva workspace
Cytometer Controls

Most BD FACS Aria III–specific cytometer controls are accessed through the Cytometer menu. Controls on the Cytometer menu are described in the following sections:

- Fluidics Controls on page 83
- Cytometer Configuration on page 87
- Cytometer Status Report on page 90

The Cytometer Details and the Catalogs menu commands are described in the *BD FACSDiva Software Reference Manual*. Additional cytometer controls are located in the Acquisition Dashboard. See Acquisition Controls on page 101.

Fluidics Controls

Fluidics control of the BD FACS Aria III cytometer is partially automated by BD FACSDiva software. The software contains pre-programmed fluidics protocols that are activated by selecting the corresponding menu command from the Cytometer menu. In addition, fluidics level indicators are available in the Cytometer window. See Fluidics Level Indicators on page 86.

Fluidics Startup

During fluidics startup, waste and sheath levels are verified and the fluidics system is primed with sheath solution. The fluidics status is displayed at the bottom of the main window.

See Cytometer Startup on page 118 for more information.
Fluidics Shutdown

Fluidics shutdown removes sheath fluid from the lines, replaces it with ethanol, and cleans the cuvette with a cleaning solution. See Fluidics Shutdown on page 203 for more details.

Change Sample Filter

Sample line filters can be installed to filter a sample before sorting. This selection opens the Sample Filter Change wizard, which guides you through the process. See Installing or Removing a Sample Line Filter on page 235 for the instructions.

Cleaning Modes

BD FACSDiva software contains pre-programmed cleaning modes that are activated by selecting the corresponding menu command from the Cytometer > Cleaning Modes menu. See Internal Cleaning on page 208 for more information.

Sheath Pressure

The sheath pressure determines how quickly particles pass through the laser beam. Select Cytometer > Sheath Pressure to view the current sheath pressure and change the pressure for custom sort setups.

⚠️ Each sort setup option is optimized at a preset sheath pressure. If you change the sheath pressure, many other values will be affected and need updating, including the drop drive frequency, drop delay value, laser delay, and area scaling factor. For proper cytometer operation, change the sheath pressure by selecting an option from the Sort > Sort Setup menu. Do not adjust the pressure using controls in the Sheath Pressure dialog. Note that the Sheath Pressure command is disabled when the Sweet Spot is on.
Sample Agitation

Select **Cytometer > Sample Agitation** to specify the speed at which samples are agitated. You can select from one of the specified values, or select **Off** to turn off agitation.

<table>
<thead>
<tr>
<th>Cytometer</th>
<th>Set</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fluidics Startup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluidics Shutdown</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Sample Filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cleaning Modes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smooth Pressure...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sample Agitation &gt; Sample Temperature</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cytometer Defaults...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wave Configurations...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CST...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Performance Tracking (L3)...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cytometer Status Report...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Catalog...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standby</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Sample Temperature

Use the **Sample Temperature** command to set the temperature inside the sample injection chamber. You can select from one of the specified values, or select **Off** to turn off temperature control (Figure 3-2).

**Figure 3-2** Setting the sample temperature
The cooling/heating unit is designed to maintain the temperature of a sample tube. It is not designed to cool or heat the sample. It takes approximately 45 minutes to reach the required temperature inside the chamber, during which time the chamber must be kept closed.

To cool or heat the chamber, install a sample tube and click **Load**. Click **Stop Acquiring** to keep the chamber closed and stop running the sample. To maintain the temperature, do not leave the chamber open for extended periods while changing sample tubes.

The sample temperature retains the last setting after startup. For example, if it was set to 20°C the last time the system was used, then it will return to that setting the next time the system is started up.

### Fluidics Level Indicators

BD FACSDiva software provides fluidics level indicators in the Cytometer window (Figure 3-3). The sheath and waste indicators provide an approximate indication of the fluid levels in each tank. The DI, bleach, and ethanol tank indicators appear full until the fluid level is below 20% of the tank capacity. When this occurs, the corresponding level indicator changes to black.

**NOTE** The stainless steel ethanol shutdown tank does not have a level sensor. It must be checked manually.

**Figure 3-3** Fluid level indicators

When the sheath is low or the waste is full while the stream is running, the corresponding indicator turns red and the following warning message is displayed every 5 minutes until the stream is turned off. If the warning message is not dismissed, the system automatically turns off the stream after 15 minutes.
Cytometer Configuration

The menu selections shown in Figure 3-4 open the CS&T module in a separate window. The CS&T module enables you to perform multiple functions related to cytometer configuration.

**NOTE** When the CS&T module is open, BD FACSDiva software goes into a holding mode and does not accept any user input. When CS&T is closed, BD FACSDiva becomes active again.

Figure 3-4  Cytometer menu selections that open CS&T
• **View Configurations.** Opens the Cytometer Configuration window within the main CS&T window. See the following section for an overview of this function.

• **CST.** Opens the CS&T module. See the *BD Cytometer Setup and Tracking Application Guide* for complete information on using CS&T.

• **Performance Tracking (LJ).** Opens the performance tracking feature within the main CS&T window. See the *BD Cytometer Setup and Tracking Application Guide* for complete information on using this feature.

**Cytometer Configuration Window**

The BD FACS Aria III cytometer is equipped with a specific set of lasers, filters, and dichroic mirrors. The Cytometer Configuration window lets you define which fluorochromes or cell parameters will be measured at each PMT detector. Within this window, you can define parameters for an unlimited number of fluorochromes, up to four lasers, and all of the detectors.

Select **Cytometer > View Configurations** to open the window shown in Figure 3-5. Click the **Parameter** tabs for a list of parameters. Click the **Filters and Mirrors** tab for the list of optics.

The Cytometer Configuration window also displays the following settings:

• Sheath pressure

• Nozzle size

• Window extension

See the *BD Cytometer Setup and Tracking Application Guide* for more information on editing configurations, including adding parameters, mirrors, and filters.
Before you start any experiment, verify that the cytometer configuration contains the appropriate parameters for the samples you are running and that the cytometer optics match the current configuration. You cannot modify an existing configuration once it has been baselined. However, you can copy, paste, or modify a configuration as described in Custom Configurations on page 93.

⚠️ For accurate data results, the cytometer optics must match the current cytometer configuration.

Selections in the Cytometer Configuration window determine which parameters are available for your experiment. When more than one parameter is available for a detector, the first parameter is listed by default. To select a different parameter, click the name in the Parameters tab of the Cytometer window in BD FACSDiva software and select a different parameter from the menu.
Cytometer Status Report

The Cytometer Status Report provides a list of all cytometer settings at the time the report was created. You must be connected to the cytometer to create the report. In an open experiment, click to set the current tube pointer and select Cytometer > Cytometer Status Report. The report is displayed in a separate window with a menu bar above the report header. The header lists the cytometer name, type, serial number, and the date and time the report was generated. See Figure 3-6 on page 92 for a sample report.
For a full description of the Cytometer Status Report, see the *BD FACSDiva Software Reference Manual*. A BD FACSARia III cytometer report includes the following additional information: user access privileges, cytometer information, cytometer settings, and sorting settings. The report can be printed or exported.

- The User Access Privileges section lists access settings for the current user.
- The Cytometer Info section lists values for laser delay, area scaling, window extension, FSC area scaling, sheath pressure, and sample flow rate.
- The Parameters section displays settings for the current acquisition tube.
- The Sort Settings section lists all sort setup values, along with the Plate Voltage and Voltage Center values. If the Sweet Spot is off, Breakoff and Gap values are shown. If the Sweet Spot is on, Drop 1 and target Gap values are shown.
#### Figure 3-6  Cytometer Status Report

**User Access Privileges**
- Window Extension Access: Yes
- FSC Area Scaling Access: Yes
- Laser Delay Access: Yes
- Laser Area Scaling Access: Yes
- Edit Data Subset Access: No

### Cytometer Info

<table>
<thead>
<tr>
<th>Laser</th>
<th>Delay</th>
<th>Area Scaling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>0.0</td>
<td>0.7</td>
</tr>
<tr>
<td>Red</td>
<td>-41.24</td>
<td>0.75</td>
</tr>
<tr>
<td>VioletTURQ</td>
<td>35.18</td>
<td>0.75</td>
</tr>
</tbody>
</table>

**Window Extension**:
- FSC Area Scaling: 0.6
- Sheath Pressure: 20.00
- Sample Flow Rate: 1.0

### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Log</th>
<th>Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>FSC</td>
<td>A, H, W</td>
<td>Off</td>
<td>150</td>
</tr>
<tr>
<td>SSC</td>
<td>A, H, W</td>
<td>Off</td>
<td>545</td>
</tr>
<tr>
<td>FITC</td>
<td>A, H</td>
<td>On</td>
<td>446</td>
</tr>
<tr>
<td>PE</td>
<td>A, H</td>
<td>On</td>
<td>401</td>
</tr>
<tr>
<td>PE-Texas Red</td>
<td>A, H</td>
<td>On</td>
<td>510</td>
</tr>
<tr>
<td>PerCP-Cy5-5</td>
<td>A, H</td>
<td>On</td>
<td>569</td>
</tr>
<tr>
<td>PE-Cy7</td>
<td>A, H</td>
<td>On</td>
<td>565</td>
</tr>
<tr>
<td>APC</td>
<td>A, H</td>
<td>On</td>
<td>543</td>
</tr>
<tr>
<td>APC-H7</td>
<td>A, H</td>
<td>On</td>
<td>499</td>
</tr>
<tr>
<td>Pacific Blue</td>
<td>A, H</td>
<td>On</td>
<td>517</td>
</tr>
</tbody>
</table>

**Threshold**
- Value: 5000
- Operator: Or

### Spectral Overlap (%)

<table>
<thead>
<tr>
<th>Channel</th>
<th>FSC</th>
<th>PE</th>
<th>PE-Texas Red</th>
<th>PerCP-Cy5-5</th>
<th>PE-Cy7</th>
<th>APC</th>
<th>APC-H7</th>
<th>Pacific Blue</th>
<th>Ann</th>
</tr>
</thead>
<tbody>
<tr>
<td>FITC</td>
<td>100.00</td>
<td>1.21</td>
<td>0.32</td>
<td>0.00</td>
<td>0.12</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>25</td>
</tr>
<tr>
<td>PE</td>
<td>14.19</td>
<td>100.00</td>
<td>15.12</td>
<td>0.00</td>
<td>2.20</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00 2</td>
</tr>
<tr>
<td>PE-Texas Red</td>
<td>7.41</td>
<td>56.18</td>
<td>100.00</td>
<td>0.00</td>
<td>1.35</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00 1</td>
</tr>
<tr>
<td>PerCP-Cy5-5</td>
<td>2.25</td>
<td>10.61</td>
<td>55.27</td>
<td>100.00</td>
<td>8.75</td>
<td>0.48</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00 0</td>
</tr>
<tr>
<td>PE-Cy7</td>
<td>0.28</td>
<td>2.80</td>
<td>7.66</td>
<td>20.76</td>
<td>100.00</td>
<td>0.12</td>
<td>2.11</td>
<td>0.00</td>
<td>0.00 0</td>
</tr>
<tr>
<td>APC</td>
<td>0.00</td>
<td>0.00</td>
<td>1.11</td>
<td>4.90</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00 0</td>
</tr>
<tr>
<td>APC-H7</td>
<td>0.00</td>
<td>0.00</td>
<td>0.33</td>
<td>7.40</td>
<td>5.95</td>
<td>6.45</td>
<td>100.00</td>
<td>0.00</td>
<td>0.00 0</td>
</tr>
<tr>
<td>Pacific Blue</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>100.00</td>
<td>0.00</td>
<td>0.00 1</td>
</tr>
<tr>
<td>Ann</td>
<td>0.21</td>
<td>0.19</td>
<td>0.09</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>7.98</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Sort Settings**
- Sort Setup: 100 microns
- Frequency: 20.00
- Analyte: 16.23
- Phase: 5.00
- Drop Delay: 27.60
- Attenuation: Off
- Sample Spot: On
- First Drop: 296
- Target Gap: 0
- Plate Voltage: 2,900.00
- Voltage Centering: 0

**Side Beam Voltages (V):**
- Far Left
- Left
- Right
- Far Right

---

92  BD FACSaria III User’s Guide
Custom Configurations

Before you can record data, you must first ensure that the cytometer configuration is appropriate for the experiment. If needed, you can create custom configurations to add parameters or filters and mirrors that are not listed in the base configuration. You will also need to create custom configurations for each sheath pressure you would like to run.

When creating custom configurations, use descriptive names that make it easy to identify the configuration. See the BD FACSDiva Software Reference Manual and the BD Cytometer Setup and Tracking Application Guide for more information.

Preparing for Custom Configurations

Custom configurations can only be created by users with administrator access. The easiest way to create a custom configuration is to copy and edit a base configuration. You can also create a new, blank configuration.

1. Log in to the software as an administrator.
2. Select Sort > Sort Setup and select the setup mode that matches the nozzle size you are using.
3. Verify that the correct nozzle is installed, then start the stream.
4. Select Cytometer > CST.

The Cytometer Configuration window opens (see Figure 3-5 on page 89). For users with administrator access, the window displays the Parameters and Filters and Mirrors tabs, which are not visible to users with operator access.

**NOTE**  When you create a new configuration in CS&T, you need to run a new baseline for that configuration. Once the baseline is established, you cannot edit any of the settings in the configuration.
Adding Parameters, Filters, and Mirrors

Before creating a custom configuration, verify that the necessary parameters, filters, and mirrors required for the custom configuration are defined.

1. To add new parameters, do the following in the Parameters tab:
   a. Click Add.
   b. Enter a parameter name in the field provided.

2. To add filters or mirrors, do the following in the Filters and Mirrors tab:
   a. To add a filter, click Add under the Filter list. To add a mirror, click Add under the Mirror list.
   b. Select a pass type and enter a wavelength in the field provided.
Copying a Base Configuration

You cannot edit or delete your base configuration. However, you can use it as a starting point to create a custom configuration.

1. In the Configurations tab, right-click the Base Configurations folder and select New Folder.

2. Rename the new folder Custom Configurations.

3. Right-click the base configuration and select Copy.
4 If your base configuration contains lasers that share optical paths, you have to select which laser will be active by making selections in the dialog similar to the one shown in the following figure.

5 Right-click the Custom Configurations folder and select Paste.

A copy of the base configuration is added to the Custom Configurations folder.

6 Enter a descriptive name and press Enter.

For example, use the name 70-70, meaning 70-micron nozzle at 70 PSI. If you need to rename the configuration, right-click the new configuration and select Rename.
Editing the Copied Configuration

Once the base configuration is copied, you can customize the parameters, filters, and mirrors in the configuration.

1. In the configuration list, right-click the new configuration and select Edit Configuration.

The following window opens.

Use the tabs at the bottom of the window to view each laser’s detectors separately.

2. To edit the nozzle size and sheath pressure for this configuration:

   a. Enter the appropriate sheath pressure value at the bottom of the configuration window.

   b. Select the appropriate nozzle size.
Do the following to edit the optical configuration.

- To change the parameter label for a detector, select and drag a new parameter from the **Parameters** list to the appropriate detector.

- To add more than one parameter label to a detector, Ctrl+click the parameters in the **Parameters** list, then drag them to the detector.

- To change a filter, select and drag a new filter from the **Filters** list to the filter slot.

- To change a mirror, select and drag a new mirror from the **Mirrors** list to the mirror slot.
When you drag parameter labels to a detector, any labels already assigned to that detector are deleted. Therefore, when assigning multiple parameter labels to a detector, you must drag all appropriate labels to the detector at the same time.

**Verifying that the Configuration Matches the Sort Setup**

To verify that the sheath pressure in the sort setup matches the sheath pressure in the configuration:

1. Select **File > Exit** to exit CS&T.
2. Select **Sort > Sort Setup**, and select the sort setup that matches the nozzle size listed in your configuration.

3. Select **Cytometer > Sheath Pressure** and verify that the pressure matches the pressure in your configuration. Enter a new sheath pressure, if needed.

The new sheath pressure is automatically saved with the current sort setup mode.
The name of the configuration is displayed at the top of the BD FACSDiva workspace. If you use a descriptive name for each configuration (such as 100-15-Custom, for nozzle size-sheath pressure-sort setup mode), it will be easier to verify that the appropriate settings match without going back to view the configuration.

### Configuration Mismatch Dialog

If there is a mismatch between the CS&T settings and those in BD FACSDiva software, a dialog opens (Figure 3-7) to indicate what the differences are, and gives the following options:

- **Use CS&T Settings.** Select this option if you have run a performance check or created a new configuration, and want to use those values.

- **Keep Current Settings.** Select this option if you were viewing a configuration in CS&T and don’t want to change the values. For example, settings for area scaling for the particle of interest.

---

**Figure 3-7** CS&T Mismatch dialog
Acquisition Controls

Along with the controls described in the BD FACSDiva Software Reference Manual, the following acquisition controls are available for the BD FACSaria III cytometer.

- **Load.** Lifts a tube into the sample injection chamber, starts sample agitation (if agitation is turned on), and starts acquisition of the sample.

  When a tube is already loaded, the button changes to Unload. Clicking Unload stops acquisition of the sample, turns off the agitator, and lowers the tube from the sample injection chamber.

  **NOTE**  The Load button is enabled only when the workstation is connected to the cytometer, an experiment is open, the stream is turned on, and the current tube pointer is set to a tube.

- **Stop Acquiring.** Stops sample acquisition without unloading the sample tube.

  The Acquire Data button functions only when a tube is loaded.

- **Flow Rate.** Controls sample flow rate, from 1.0–11.0 (10–80 µL/min).
Do one of the following to change the flow rate:

- Select the value in the field and enter a new value.
- Click the pointer in the slider bar and drag it to a new value.
- Use the mouse to click the up and down arrows or press the arrow keys on your keyboard to increase or decrease the values in small increments.

**Sorting Controls**

All sorting on the BD FACSARia III cytometer is controlled by BD FACSDiva software. Sorting controls are shown in Figure 3-8. See Table 3-1 on page 103 for explanations of each area.

**Figure 3-8** BD FACSDiva sorting controls
Table 3-1 Description of sorting controls

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Sort menu provides access to the sort setup and sort precision modes, sort layouts, sort reports, and sort devices used with the ACDU unit. See Sort Menu on page 103.</td>
</tr>
<tr>
<td>2</td>
<td>The Sort Layout window designates which device will be used to collect sorted particles and which particles will be sorted into each sort location. Depending on your system's configuration, your setup values may vary. See Table 3-2 on page 105 for more information.</td>
</tr>
<tr>
<td>3</td>
<td>The Breakoff window displays an image of the stream and contains controls to adjust drop formation. See Drop Formation on page 65.</td>
</tr>
<tr>
<td>4</td>
<td>The Side Stream window displays an image of the side streams, and contains controls to adjust electrical charges and the drop delay. See Side Stream Formation on page 69.</td>
</tr>
</tbody>
</table>

Sort Menu

Select commands in the Sort menu for the following:

- **Sort Setup.** Downloads the most recently used settings for selected nozzle size. See Sort Setup on page 104.

- **Sort Precision.** Opens a dialog where you can select or define a sort precision mode for handling sorting conflicts. See Conflict Resolution During Sorting on page 73.

- **New Sort Layout.** Opens the default 2-Tube Sort Layout window where other sort layouts can be selected. (Note that clicking the Sort Layout button on the Browser toolbar performs the same function.)

- **Open Sort Layout.** Opens an existing sort layout. A sort layout must be selected in the Browser for this menu command to be enabled. Alternatively, double-click any sort layout to open it.
• **Home Device.** Opens a dialog containing commands to move the tray support arm, either manually or to the home position. See Setting Up the Stream on page 190.

• **Custom Devices.** Opens a dialog where custom devices can be defined. See Creating a Custom Device on page 192.

• **Sort Report.** Displays a report showing the sort settings, acquisition counters, and sort layout information from the current sort. See Sort Report on page 113.

## Sort Setup

Sort setup values for four different nozzle sizes can be downloaded using the **Sort > Sort Setup** command. Default settings are provided for each sorting option, along with a custom setting for each option.

As a general rule, for optimal results when sorting large or fragile cells, use a larger nozzle size and lower pressure. To increase throughput and yield when sorting smaller or less fragile cells, use a smaller nozzle size and higher pressure.

<table>
<thead>
<tr>
<th>Sort Setup Name</th>
<th>Nozzle (microns)</th>
<th>Default Pressure (PSI)</th>
</tr>
</thead>
<tbody>
<tr>
<td>70 micron</td>
<td>70</td>
<td>70</td>
</tr>
<tr>
<td>85 micron</td>
<td>85</td>
<td>45</td>
</tr>
<tr>
<td>100 micron</td>
<td>100</td>
<td>20</td>
</tr>
<tr>
<td>130 micron</td>
<td>130</td>
<td>10</td>
</tr>
</tbody>
</table>

If you make changes to any of the settings, the changes are automatically saved when you exit BD FACSDiva software or when you switch to a different sort setup mode. When you restart, the most recently used set of values is restored. Default settings are shown in Table 3-2 on page 105.

In addition, the Sort Setup menu has following menu items: 70 Custom, 85 Custom, 100 Custom, and 130 Custom. Initially, all of these new setups are exact copies of the corresponding original setups with the same defaults. This allows
you to create two sets of sort values (pressure, for example) for the same nozzle size.

⚠️ Do not use a nozzle size that is different from the sort setup setting. The gap values and sensitivity algorithms are optimized for particular nozzles and are not suitable for other nozzle sizes. The system performance could be unstable.

Table 3-2 shows typical sort setup values. Depending on your system’s configurations, your setup values may vary.

**Table 3-2  Typical sort setup values**

<table>
<thead>
<tr>
<th>Setting</th>
<th>70 micron</th>
<th>85 micron</th>
<th>100 micron</th>
<th>130 micron</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheath Pressure</td>
<td>70</td>
<td>45</td>
<td>20</td>
<td>10</td>
</tr>
<tr>
<td>Amplitude</td>
<td>60</td>
<td>32</td>
<td>12</td>
<td>24</td>
</tr>
<tr>
<td>Frequency</td>
<td>87</td>
<td>47</td>
<td>30</td>
<td>12</td>
</tr>
<tr>
<td>Drop 1</td>
<td>150</td>
<td>150</td>
<td>150</td>
<td>150</td>
</tr>
<tr>
<td>Gap (upper limit)</td>
<td>6 (14)</td>
<td>7 (17)</td>
<td>10 (21)</td>
<td>12 (21)</td>
</tr>
<tr>
<td>Attenuation</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Drop Delay</td>
<td>47.00</td>
<td>30.00</td>
<td>27.00</td>
<td>16.00</td>
</tr>
<tr>
<td>Far left voltage</td>
<td>100</td>
<td>100</td>
<td>80</td>
<td>60</td>
</tr>
<tr>
<td>Left voltage</td>
<td>40</td>
<td>35</td>
<td>30</td>
<td>20</td>
</tr>
<tr>
<td>Right voltage</td>
<td>40</td>
<td>35</td>
<td>30</td>
<td>20</td>
</tr>
<tr>
<td>Far right voltage</td>
<td>100</td>
<td>100</td>
<td>80</td>
<td>60</td>
</tr>
<tr>
<td>Plate voltage</td>
<td>4,500</td>
<td>4,000</td>
<td>2,500</td>
<td>2,000</td>
</tr>
<tr>
<td>2nd Drop</td>
<td>20</td>
<td>20</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>3rd Drop</td>
<td>10</td>
<td>10</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>4th Drop</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Laser Delay (blue)</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
The Sort Layout window contains all sorting instructions and controls. The sort layout designates which device will be used to collect sorted particles and which particles will be sorted into each sort location. Up to four sort counters can be displayed in the window to give ongoing status during a sort.

Only one sort layout can be open at a time, but you can create several layouts for a single tube, as long as each sort layout has a different name. Sort layouts can also be added to global worksheets.

Sort layouts are available for up to nine default collection devices (shown in the following figure). Additional custom devices can be defined. See Creating a Custom Device on page 192.

<table>
<thead>
<tr>
<th>Setting</th>
<th>70 micron</th>
<th>85 micron</th>
<th>100 micron</th>
<th>130 micron</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laser Delay (red)</td>
<td>-78.00</td>
<td>-71.00</td>
<td>-80.00</td>
<td>-78.00</td>
</tr>
<tr>
<td>Laser Delay (violet)</td>
<td>39.00</td>
<td>35.00</td>
<td>40.00</td>
<td>39.00</td>
</tr>
<tr>
<td>Laser Delay (yellow green)</td>
<td>-39.00</td>
<td>-35.00</td>
<td>-40.00</td>
<td>-39.00</td>
</tr>
<tr>
<td>Area Scaling (blue)</td>
<td>0.70</td>
<td>1.00</td>
<td>0.90</td>
<td>0.90</td>
</tr>
<tr>
<td>Area Scaling (red)</td>
<td>0.60</td>
<td>0.75</td>
<td>0.65</td>
<td>0.65</td>
</tr>
<tr>
<td>Area Scaling (violet)</td>
<td>0.50</td>
<td>0.50</td>
<td>0.50</td>
<td>0.50</td>
</tr>
<tr>
<td>Area Scaling (yellow green)</td>
<td>0.80</td>
<td>0.80</td>
<td>0.90</td>
<td>0.95</td>
</tr>
<tr>
<td>Window Extension</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>4.00</td>
</tr>
</tbody>
</table>

Table 3-2 Typical sort setup values (continued)
Examples of sort layouts for different devices are shown in the following figures. Instructions for setting up a sort layout can be found in Setting Up a Sort Layout on page 108.

Figure 3-9  Sort layout for collection tubes (top) and for a 48-well plate (bottom)

Figure 3-10  Sort layout for a frosted slide
Setting Up a Sort Layout

Sort layouts can be added to tubes or global worksheets.

- Create tube-specific layouts if you are sorting different populations or using different sort devices for each tube in the experiment.

- Create global worksheet-specific layouts if you are sorting the same populations into the same sort device for all tubes in the experiment.

**NOTE** To create a tube-specific sort layout, make sure a normal worksheet (white tab) is shown in the Worksheet window before you create the layout.

To set up a sort layout:

1. Select the icon for a tube or global worksheet in an open experiment and click the **New Sort Layout** button on the **Browser** toolbar.

2. In the **Sort Layout** window, select the type of device from the **Device** menu.

   Default sorting devices are listed along with any defined custom devices. The Sort Layout window changes depending on the selected device. The number of rows and columns in the window matches the number of tubes, wells, or spots in the collection device.

3. Select the sort precision mode from the **Precision** menu.

   For more information, see Sort Precision Modes on page 77.

4. Enter the number of events to be sorted in the **Target Events** field.

   Once entered, the number of events can be selected from the Target Events menu. For continuous sorting, select **Continuous** from the **Target Events** menu.

5. Select one of the following options from the **Save Sort Reports** menu:

   - **Save None**. Sort reports are not saved.
• **Save All.** Automatically saves a sort report each time the sort is stopped.

• **Ask User.** Prompts the user each time the sort is stopped to select whether or not to save the sort report. This is the default option.

This setting is saved with the sort layout.

6 Select the field(s) corresponding to the tube(s), well(s), or spot(s) where the population will be sorted and select a defined population from the **Add** menu.

When you click in a sort location field, a menu opens allowing you to add, delete, or clear all populations in the field (Figure 3-11).

**Figure 3-11 Adding populations to be sorted**

![Figure 3-11 Adding populations to be sorted](image)

After you add a population, the population and the number of target events are added to the corresponding sort location field.

**Tip** Select a row or column header to select all fields in that row or column. When you add a population, it will be added to all selected fields at once.

7 Specify whether to save sort conflicts by selecting the **Save Conflicts** checkbox.

This checkbox is enabled only when using a two- or four-tube layout. When selected, all sort conflicts are sorted into a default location.

• For a two-tube layout, conflicts are sorted to the right.
• For a four-tube layout, conflicts for the far left tube are sorted to the left, and conflicts for the far right tube are sorted to the right.

Editing a Sort Layout

• To change the number of events for any population, click in the Sort Location field(s) containing the population, then select a number from the Target Events menu or enter a new number.

• To remove a population from a sort location field, select the field, then select the corresponding population from the Delete menu.

• To clear all populations from a field, select the field, then select Clear All.

Using Sorting Controls

Sorting controls appear at the bottom of the Sort Layout window. Use these controls for the following functions.

• Sort. Starts sorting events for the current acquisition tube. All counters reset to zero when this button is clicked. Events are sorted until the requested number of sorted events has been reached.
Click the **Sort** button again to stop sorting before reaching the requested number of events. The counters stop at the number of sorted events. If you click **Sort** to restart sorting, the counters reset to zero.

- **Pause/Resume.** Stops sorting, but not acquisition. Sort counters and sort timers freeze when the Pause button is clicked. Click the **Resume** button to continue sorting and to continue incrementing the sort counters and timers. See Pausing and Resuming a Sort on page 185.

- **Access Stage.** When the ACDU stage is in the back, the stage is moved forward to put a plate on or take a plate off the stage. When the stage is in the front, the stage is moved to the back and out of the way so you can install a collection tube holder.

- **Move Drawer.** Moves the aspirator drawer in (closed) or out (open) depending on its current state. The default state is in. For more information, see Aspirator Drawer on page 32.

**Using Counters**

Counters provide ongoing status during sorting. Counter fields cannot be edited. To display fewer counters in the Sort Layout window, click the **View Counters** button and select a menu option. The corresponding counter is hidden. (Only counters with a checkmark next to the name are displayed.)
Counters display the following information:

- **Sort Rate.** Number of events per second that met the sort criteria and were sorted.

- **Conflict Count.** Number of events that met the sort criteria but were not sorted because of conflicts.

- **Conflict Rate.** Number of conflicts per second.

- **Efficiency.** Number of sorted events/(sort conflicts + sorted events) x 100.

**Monitoring a Sort**

During sorting, each sort location field displays the number of actual sorted events (Figure 3-12). When a target number is specified, the field displays the actual number of events along with the number of target events.

A progress bar appears behind the sort rate counter field showing the progress of the sort.

*Figure 3-12  Sort layout during sorting*
Sort Report

Select Sort > Sort Reports to view all of the saved reports for the current sort layout (see Figure 3-13). A sort report can be printed or exported. The Sort Reports menu option is enabled if either of the following is true: a sort layout is selected in the Browser (even if experiment is closed), or a sort layout is open. If both conditions are true, the Browser selection takes precedence.

Figure 3-13  Select Sort Reports dialog

A sort report (see Figure 3-14) contains the following:

- **Header information.** Experiment name, specimen name, tube name, sort layout name, type of collection device, and the date and time of printing.

- **Sort Settings.** Sort setup values, precision mode, and mask definitions.

- **Acquisition Counters.** Threshold count, processed events count, electronic conflicts count, and elapsed time.

- **Sort Counters.** Counter values per sort destination, or total sort count if sorting sequentially.

- **Sort Layout.** Population(s), sort count, and target event count for each sort location field.
Figure 3-14 Typical sort report

The Sort Report window contains a File menu where you can select to print or export the report. Exported comma-separated value (CSV) files can be opened with a spreadsheet application such as Microsoft Excel®.
Templates

When you install BD FACSDiva software for the BD FACSaria III cytometer, the following additional experiment templates are installed in the BD Export\Templates directory:

- **Accudrop Drop Delay template.** Contains a single specimen and tube, a gated plot on a standard worksheet, and a predefined sort layout. This experiment is used for setting the drop delay during sorting as described in Determining the Drop Delay – Manual Method on page 172.

- **Doublet Discrimination Gating template.** Contains custom cytometer settings, a single specimen and tube, and three gated plots on a global worksheet. This experiment is used to eliminate doublets as described in Data Collection on page 148.

- **QC Experiment template.** Contains cytometer settings, a single specimen, one tube, and two global worksheets containing gated plots and statistics for data from each laser. This experiment is used for daily cytometer quality control. For more information see Checking Cytometer Performance on page 135.
Running Samples

The following topics are covered in this chapter:

- Cytometer Startup on page 118
- Checking Cytometer Performance on page 135
- Application Settings on page 141
- Data Collection on page 148
- Data Recording and Analysis on page 155
- Manual Adjustment of Laser Delay on page 163
Cytometer Startup

Follow these steps to start up your BD FACSAria III cytometer.

1. Start up the workstation.
2. Turn on the cytometer main power.

**Figure 4-1** Power panel

If the cytometer was just shut down, wait until the system is fully depressurized (stops hissing) before you turn on the main power.

**NOTE** The power switch will vary depending on which lasers you have installed on your system.

3. Press the main power switch. Wait 30 minutes for the lasers to warm up.

To turn on the lasers, rotate the rotary switches to the desired settings. (Figure 4-1).

**Tip** If you are using the temperature control option, start heating or cooling the sample injection chamber or the recirculating water bath while the lasers are warming up. See Sample Temperature on page 85.
4 Start BD FACSDiva software and log in with your user name and password.

To start the software, double-click the application shortcut on the desktop.

5 Check the fluidics levels in the Cytometer window. Replenish fluids or empty the waste, if needed.

To display the Cytometer window, click the Cytometer button on the Workspace toolbar. Check the fluid levels at the bottom of the window (Figure 4-2). Roll the mouse pointer over fluid indicators to show the fluid type.

Figure 4-2 Fluid levels in the Cytometer window

To service the fluid containers, see Table 4-1 on page 126 and Emptying the Waste Container on page 133.
Performing Fluidics Startup

This section describes the fluidics startup procedure. The status of the fluidics system is displayed in the bottom right corner of the main window.

1. From the BD FACSDiva Cytometer menu, select Fluidics Startup. The following window opens.

2. Verify that the air and fluid lines are disconnected from the ethanol tank and connected to the sheath tank, then click Done. See Figure 4-3.

Caution: Do not run fluidics startup with the air and fluid lines connected to the ethanol shutdown tank. This can cause damage to the system. Always verify that the lines are connected to the sheath tank.
3 Verify that a closed-loop nozzle is installed in the flow cell, then click **Done**.

The fluidics startup process starts and the progress is displayed at the bottom of the dialog.

4 Turn the nozzle-locking lever counter-clockwise to the 6:00 position, pull the closed-loop nozzle out of the cuvette flow cell, then click **Done**.

⚠️ Caution: Do not open the sort block door while the nozzle locking lever is in the 6:00 position. The flow cell can be damaged by the top of the door during opening. Always turn the lever clockwise back to the 12:00 position before opening the sort block door.
5 Insert the correct nozzle size in the flow cell.

a Verify that the O-ring is present and that it is installed in the nozzle groove. For more information, see Integrated Nozzle on page 30.

b Make sure the top side of the nozzle is facing up as you insert the nozzle.

c Push the nozzle all the way back into the flow cell.

d Turn the nozzle-locking lever clockwise to the 12:00 position.

6 Click OK to complete the process.

7 When fluidics startup is complete, select Sort > Sort Setup and verify that the setup mode matches the nozzle size.

For information about Sort Setup modes, see Sort Setup on page 104.

Starting the Stream

The system can take anywhere from 20 seconds to several minutes to reach the correct pressure and turn on the stream, depending on the state of the system and the sort setup selected.

1 Start the stream.

a Click the Sorting button on the Workspace toolbar to display the Breakoff and Side Stream windows.

b Click the Stream button in the Breakoff window to turn on the stream.

2 Open the sort block door and check the stream.

The stream should flow smoothly from the nozzle into the center of the waste aspirator.
If the stream is flowing but is unsteady, check for bubbles in the flow cell. If you see bubbles, turn off the stream, wait for 10 seconds, and turn on the stream again.

If you see any dripping or spraying, or the stream image appears abnormal, turn off the stream and see Troubleshooting the Stream on page 250.

3 Close the sort block door.

**NOTE** If you encounter bubbles in the sheath fluid stream at the 130-micron sort setting, perform a sample line backflush for approximately 1 minute. Select Cytometer > Cleaning Modes > Sample Line Backflush.

To prevent this, the sheath tank should be depressurized while not in use to prevent air from dissolving into the sheath solution.
Setting Up the Breakoff

Establishing a stable drop pattern in the breakoff window is an important step in getting optimal results from the system. See Breakoff Window on page 66 for more information on the parameters and controls in the breakoff window.

The figure below shows good versus poor break off patterns.
1 Adjust the Ampl slider until the drop breakoff is approximately in the top third of the Breakoff window.

Do not exceed 70 volts. If you cannot achieve a drop breakoff at <70 volts, do the following:

- Check the flow cell for air bubbles. If you see bubbles, turn the stream off and back on.
- Make sure the sheath pressure and drop drive frequency are appropriate. See Table 3-2 on page 105 for starting values.
- If the amplitude is <10 volts, turn on attenuation in the Side Stream window. See Table 2-2 on page 70.

2 Verify that the small satellite droplets are merging with the large droplets.

If the satellites are not merging, you might need to clean the nozzle by sonicating. The satellite drops should merge into the drops in 6 satellites or fewer.

3 Enter the actual Drop 1 value as the target in the Drop 1 field.

The actual value appears in the gray background next to the Drop 1 field. Once a valid target has been established, you do not need to reset it unless you change the nozzle or your sort setup option.

Tip If the target value causes the amplitude to exceed 70 volts, perform the recommendations under step 1 and re-enter the Drop 1 target value.

4 Turn on the Sweet Spot when the drop pattern is stable.

The Sweet Spot is designed to automatically adjust the drop drive amplitude to maintain the stability of the breakoff point. When the Sweet Spot is on, the Amplitude and Frequency fields are disabled. The values are automatically adjusted by the software. For more information, see Breakoff Window on page 66.
The breakoff patterns in Table 4-1 are intended as examples. The patterns will not always look exactly like these.

**Table 4-1** Examples of breakoff patterns at each nozzle size

<table>
<thead>
<tr>
<th>70 micron</th>
<th>85 micron</th>
<th>100 micron</th>
<th>130 micron</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Images of breakoff patterns]</td>
<td>[Images of breakoff patterns]</td>
<td>[Images of breakoff patterns]</td>
<td>[Images of breakoff patterns]</td>
</tr>
</tbody>
</table>
Chapter 4: Running Samples

Setting Up the Fluidics Cart

Check the fluid levels in the sheath tank and waste containers every time you use the cytometer. This ensures that you will not run out of sheath fluid during an experiment or have to service the containers during a sort. Fluidics level indicators are shown in the Cytometer window in BD FACSDiva software. See Figure 4-2 on page 119.

**NOTE** When the fluidics cart is in the correct position in the lab, lock the rolling casters by turning the orange disk until the feet contact the floor. This helps minimize any vibrations that could affect the stability of the stream.

If a fluidics container is running low, refill it with the fluid indicated on the container label. For best results, fill the containers only with the fluids shown in Table 4-2. For ordering information, see Reagents on page 285.

For instructions on emptying the waste, see page 133.

**Table 4-2** Recommended fluids

<table>
<thead>
<tr>
<th>Container</th>
<th>Compatible Fluids</th>
<th>Capacity</th>
</tr>
</thead>
</table>
| Sheath a  | • BD FACSFlow™ sheath fluid (non-sterile)  
            • 1X phosphate-buffered saline (PBS), with or without preservatives | One 10-L stainless steel container |
| Ethanol Shutdown | 70% solution diluted in deionized (DI) or laboratory-grade water | One 5-L stainless steel container |
| Bleach | • 10% household bleach (0.5% sodium hypochlorite)  
          • BD™ FACSClean solution | 5 L |
| DI | Deionized water (Milli-Q or equivalent). Add 3 mL of bleach per liter of DI water. | 5 L |
| Ethanol | 70% solution diluted in DI or laboratory-grade water | 5 L |

a. Users should select solutions that are compatible with their specific samples and experiments.
NOTE  Make sure the blue sheath fluid line between the sheath tank and the cytometer does not come into contact with anything that could introduce vibration that might affect the stability of the stream.

Refilling the Sheath Tank

The fluid level in the pressurized stainless steel sheath tank should be checked often and refilled when low. The startup times for the breakoff stream will increase when the tank is low. If the cytometer is run until the sheath supply is too low, the system will turn off the stream.

Figure 4-4  Sheath tank connectors

To refill the sheath tank:

1  Turn off the stream.
2  Disconnect the air line.
3  Pull up on the ring of the pressure relief valve to release pressure from the tank.

Make sure the tank is fully vented.
4 Unscrew the sheath tank cover knob and remove the cover.

5 Fill the tank with sheath fluid up to the upper weld line on the inside of the tank. See Figure 4-5.

**NOTE** Do not overfill the sheath tank because this can cause incorrect sample flow rates.

**Figure 4-5** Sheath tank fill level

6 Replace the cover and tighten the knob.

Make sure the large O-ring on the inside lip of the cover is seated correctly and has not slipped out of position. The tank can leak if the cover is not secured properly.

7 If you removed the sheath tank from the fluidics cart to refill it, place the tank back in its original position on the cart. See Figure 4-6 on page 130.

The flow rate is calibrated with the sheath tank on the fluidics cart. If the location or elevation of the sheath tank is changed, it could affect the flow rate calibration.
8  Connect the air line. The system is ready to run again.

**Refilling the Ethanol Shutdown Tank**

The fluid level in the stainless steel ethanol shutdown tank should be checked before starting the fluidics shutdown procedure and refilled when low. This tank does not have a sensor, so it must be checked manually.

**Figure 4-7 Ethanol shutdown tank connectors**

1  Turn off the stream.

2  If it is connected, disconnect the air line on the ethanol shutdown tank.

3  Pull up on the ring of the pressure relief valve to release pressure from the tank.

   Make sure the tank is fully vented.
4 Unscrew the tank cover knob and remove the cover.

5 Fill the tank with ethanol to the level shown in Figure 4-8.

6 Replace the cover and tighten the knob.

   Make sure the large O-ring on the inside of the cover is seated correctly and has not slipped out of position. The tank can leak if the cover is not secured properly.

7 If you are going to perform fluidics shutdown, connect the air line.

![Figure 4-8 Ethanol shutdown tank fill level](image)

**Refilling the Plastic Containers**

You can refill the plastic containers directly on the fluidics cart without detaching any lines, or you can remove the container for refilling. Note that during operation, you can add fluid to a container through the large cap without any interruption to your experiment, but if you detach any lines, you will need to prime the system.

1 (Optional) Disconnect the container’s sensor and quick-release connector if you need to move the container. (See Figure 4-9.)

   If you do not need to move the container, skip to step 2.
2 Remove the large-sized cap from the container (See Figure 4-9.)

3 Fill the container with the fluid indicated on the container label.

4 Replace the container cap and hand-tighten it until it is fully closed.

5 If you disconnected the sensor and quick-release connectors in step 1:

   a Reconnect the sensor and quick-release connectors to their respective ports.

   b Prime the fluidics system.

   From the BD FACS\textit{D}iva menu bar, select \textit{Cytometer > Cleaning Modes > Prime after Tank Refill}. In the dialog that opens, select the fluid to prime, then click \textit{OK}.

\textbf{Figure 4-9} Plastic fluidics container
Emptying the Waste Container

Empty the waste container daily and when the fluid indicator shows the waste is getting full. To prolong the life of the container, we recommend that you switch to the alternate container each time the waste is emptied.

⚠️ ⚠️ All biological specimens and materials coming into contact with them can transmit potentially fatal disease. To prevent exposure to biohazardous agents, expose waste container contents to bleach (10% of total volume) before disposal. Dispose of waste in accordance with local regulations. Use proper precautions and wear suitable protective clothing, eyewear, and gloves.

⚠️ ⚠️ Change the waste container cap every month, or when it has gotten wet, to prevent container pressurization. To order new replacement caps (BD Part No. 33885407, pack of 12), contact your local BD Biosciences representative.

Figure 4-10  Waste container details

1 Disconnect the waste container’s sensor and fluid line connectors from their respective ports on the fluidics cart.
Remove the disposable waste cap (large-sized cap) and attached trap from the container. Place the assembly on the bench label-side up.

The waste container can become pressurized when the cytometer is running. Always disconnect the container from the fluidics cart before you empty it. Wait at least 1 minute for pressure to dissipate before you open the container.

2  Remove the disposable waste cap (large-sized cap) and attached trap from the container. Place the assembly on the bench label-side up.

3  Empty the waste container according to your standard laboratory procedures for biohazardous waste.

4  Add approximately 1 L of bleach to the waste container (10-L container).

   Add a sufficient amount so that 10% of the total waste volume is bleach.
5 Replace the waste trap and attached filter cap. Hand-tighten the trap and cap until they are fully closed.

⚠️ To prevent over-pressurization during fluidics startup, do not overtighten the trap or attached filter cap. Tighten each component only until it is hand-tight. Do not use sealants such as Teflon® tape or other adhesives.

6 If one month has passed since you last changed the cap, replace the filter cap with a new one. Write the date on the new cap as a reminder.

7 Reconnect the sensor and fluid line connectors to their respective ports.

Checking Cytometer Performance

Before setting up an experiment, you should first run a performance check. A performance check ensures that the cytometer is performing consistently over time. It also generates default cytometer settings that places each PMT within an optimal range.

NOTE You can also use the quality control process originally established for BD FACSDiva software. See the BD Cytometer Setup and Tracking Application Guide.

To run a performance check, start the CS&T application within BD FACSDiva software and select the appropriate cytometer configuration. Each configuration must have a valid baseline. See the BD Cytometer Setup and Tracking Application Guide for more information on running a baseline.
Preparing the CS&T Workspace

To ensure that your cytometer is performing consistently over time, it’s important to keep as many variables constant as possible, such as bead type, sheath pressure, and cytometer settings. For this reason, you should run the daily performance check using the same cytometer configuration each day.

1. Turn off the Sweet Spot (if it is on), then select **Cytometer > CST**.

   The cytometer disconnects from the BD FACSDiva interface and connects to the CS&T interface. A window similar to Figure 4-12 opens.

   **Figure 4-12**  Main CS&T window

2. Verify that the bead lot information under **Setup Beads** matches the CS&T bead lot.

136  BD FACSaria III User’s Guide
Select the correct lot ID from the menu. The bead lot ID number is located on the CS&T bead vial.

3 Verify that the cytometer configuration is correct for your experiment.

If the cytometer is not set to the correct configuration:

a Click Select Configuration in the Setup Control window.

b Select the correct configuration from the list.
c Click Set Configuration. Click OK.

4 Verify that the current configuration has a valid baseline defined.

If not, see the *BD Cytometer Setup and Tracking Application Guide* for more information on running a baseline.

---

**Preparing the CS&T Beads**

CS&T research beads consist of bright, mid, and dim beads dyed with a mixture of fluorochromes. Use the beads to define a baseline and to check cytometer performance using the CS&T application.

**NOTE** For BD FACSDiva software version 7.0 or later, you must use CS&T research beads.
See the CS&T research beads technical data sheet for more instructions about preparing the bead suspension.

1 Mix the beads by gently inverting the vial.

2 In a 12 x 75-mm tube, add 0.35 mL of sheath fluid and 1 drop of beads.

   **NOTE**  Beads are stable at 2°C to 25°C for no more than 20 minutes if stored in direct light, and up to 8 hours if protected from light.

### Running a Performance Check

The performance check feature of CS&T will check the cytometer's daily performance.

1 Install the bead tube onto the cytometer loading port.

2 In the **Setup Control** window, select **Check Performance** from the **Characterize** menu.

3 Click **Run**.

   ![Setup Control Window](image)

   Plots appear under the Setup tab and the performance check is run. The performance check takes approximately 5 minutes to complete.

### Reviewing the Results

1 Once the performance check is complete, click **View Report**.

2 Print the report.
3 Verify that the performance check passed.

In the Setup tab, the Cytometer Performance Results should have a green checkmark and the word Passed next to it.

If any parameters did not pass, see the BD Cytometer Setup and Tracking Application Guide for troubleshooting information.

4 Select File > Exit to close the CS&T window and connect back to the BD FACSDiva interface.

5 Click Use CST Settings in the dialog that opens.

**NOTE** There is a system preference to always use current CS&T settings that can be set by the administrator. If you tend to switch between sheath pressures manually, you can request that the administrator clear that preference.
By selecting Use CST Settings, the laser delay, area scaling, and other cytometer settings will be updated to the latest optimized settings from the performance check.

Click the Details button to verify which cytometer settings will be updated.

At this point you can do one of the following:

- Continue to the next section to create application settings for an experiment you will use frequently.

- Collect data using existing application settings. See Data Collection on page 148.

### Application Settings

Application settings are associated with a cytometer configuration and include the parameters needed for the application, area scaling values, PMT voltages, and threshold values, but not compensation. Each time a performance check is run for a configuration, the application settings associated with that configuration are updated to the latest run.

Using application settings provides an easy, consistent, and reproducible way to reuse cytometer settings for your commonly used applications. See the *BD Cytometer Setup and Tracking Application Guide* for information on running a baseline and for other details on using the CS&T application.

Before creating application settings you must:

- Perform the cytometer startup procedure described in Cytometer Startup on page 118.

- Run a performance check for the cytometer configuration that will be used for the application.
Creating Application Settings

This section describes how to create and save application settings for a multi-color immunophenotyping sample.

Setting Up the Workspace

1. Create a new folder.
2. Create a new experiment.
3. Select the Cytometer Settings in the Browser.
4. In the Inspector window, click the Parameters tab and delete any unneeded parameters.
5. Select the H check box to select height for each parameter.

![Inspector - Cytometer Settings](image)

Adjusting Area Scaling

The required area scaling factor changes based on sheath pressure and particle size. The area scaling factors should be verified for each experiment performed on the cytometer.
NOTE You will need to modify the template to support the lasers installed on your system. Don’t forget to save the settings when you are done.

1 In the Browser, right-click Global Sheet1 and select Apply Analysis Template.

2 In the Template dialog, select the Area Scaling worksheet and click OK.

3 Create a new specimen by clicking the New Specimen button on the Browser toolbar.

4 Expand the new specimen, then click to set the current tube pointer to Tube_001.

5 Install the FITC-positive control tube onto the loading port and click Load in the Acquisition Dashboard.

6 Adjust the FSC and SSC voltages to place the particles on scale.

7 Adjust the P1 gate around the population of interest in the FSC vs SSC plot.
8 Adjust the FSC area scaling.

a Click the Laser tab in the Cytometer window.

b Adjust the FSC area scaling factor until the FSC-A signal matches the FSC-H signal. See Figure 4-13.

- Increase the area scaling factor if the FSC-A signal is lower than FSC-H.
- Decrease the area scaling factor if the FSC-A signal is higher than FSC-H.

c View the result of your change in the histograms and statistics views.
Adjust the blue laser area scaling until the FITC-A signal matches the FITC-H signal, if needed.

Unload the FITC-positive control tube, then load the APC-positive control tube.

Adjust the red laser area scaling until the APC-A signal matches the APC-H signal, if needed.

In the Inspector window, clear the checkboxes for height for all parameter.
Optimizing PMT Voltages

1. Right-click Cytometer Settings in the Browser, then select Application Settings > Create Worksheet.

A second global sheet is added with the plots created according to your selections in the parameters tab. (See Figure 4-14.) Use the gray boxes and crosshairs to guide your optimization.

Figure 4-14 Optimizing PMT voltages

2. Load the unstained control tube onto the cytometer.

3. In the Cytometer window, optimize the settings for your application.
   a. Optimize the FSC and SSC voltages to place the population of interest on scale.
b  Optimize the FSC threshold value to eliminate debris without interfering with the population of interest.

c  If needed, increase the fluorescence PMT voltages to place the negative population within the gray boxes. Try to align the center of the negative population with the crosshair shown in the gray box.

**NOTE**  Do not decrease the fluorescence PMT voltages at this point. Doing so may decrease your ability to resolve dim populations from the negative population.

4  Unload the unstained control tube from the cytometer.

5  Load the multicolor sample onto the cytometer.

6  Verify that the positive populations are on scale.

   If a positive population is off scale, lower the PMT voltage for that parameter until the positive population can be seen entirely on scale.

7  Unload the multicolor sample from the cytometer.
Saving Application Settings

1 Right-click Cytometer Settings in the Browser, then select Application Settings > Save, to save the values for reuse. See Figure 4-15.

![Figure 4-15 Saving application settings](image)

a In the Applications Settings dialog, rename the application settings with a descriptive name.

b Click OK.

The application settings are saved to the catalog.

Data Collection

Before you record data for a sample, cytometer settings should be optimized to position the cells of interest on scale for scatter and fluorescence parameters. In the previous section, application settings were created by taking into consideration the following:

- FSC and fluorescence area scaling
- FSC and SSC voltages
- FSC threshold
- Fluorescence PMT voltages

In this section, the application settings will be applied and compensation will be calculated before collecting test data.
The following sections describe how to use previously optimized application settings for a 4-color experiment. See Application Settings on page 141 for more information.

Compensation will be automatically calculated using the compensation setup feature. For more information about this feature, see the BD FACSDiva Software Reference Manual. If you are performing compensation manually, not all steps will apply.

**Setting Up the Workspace**

Before you begin optimizing settings, it is important to verify the cytometer configuration and create an experiment containing appropriate parameters for the assay.

1. Select **Cytometer > View Configurations**, and verify that the current configuration is appropriate for the type of sample you are running.

2. Verify that there is a valid performance check for the configuration.

3. Make sure the octagon and trigon(s) contain appropriate filters.

   For assistance, see Cytometer Configuration on page 87.

⚠️ For accurate data results, the cytometer optics must match the current cytometer configuration.

4. Click the corresponding buttons on the Workspace toolbar to display the Browser ( ), Cytometer ( ), Inspector ( ), Worksheet ( ), and Acquisition Dashboard ( ) windows, as needed.

5. (Optional) Create a folder for your experiment.

   Select the icon for your database and press Ctrl+N. Rename the folder appropriately. See the BD FACSDiva Software Reference Manual for ideas on how to organize experiments.
Tip  To place an experiment inside a folder, select the folder before you create the experiment.

6  Create an experiment from the Doublet Discrimination Gating template.

For best results, we recommend that you perform doublet discrimination in order to record only singlet events. This template contains cytometer settings and gated plots for this purpose. A procedure is given in Recording Data on page 158.

For experiments where you do not need to distinguish singlets from doublets, you can start with a default experiment or a template of your choice.

To use the template, select Experiment > New Experiment and select the Doublet Discrimination Gating template. Click OK to add a copy of the template to the Browser.

7  Rename the experiment appropriately (for example, 4-Color experiment).

8  Right-click the experiment level Cytometer Settings in the Browser and select Apply Application Settings. See Figure 4-16.
Figure 4-16  Application Settings window

![Application Settings window]

See Application Settings on page 141 for instructions on creating application settings.

9 Select the application setting for your sample and click Apply.

See Figure 4-17 for a typical error message if there are any mismatches between the application and cytometer settings.

Figure 4-17  Example mismatch error message

![Cytometer Settings Mismatch]

10 Select Experiment > Compensation Setup > Create Compensation Controls.

The Create Compensation Controls dialog opens, listing only those parameters associated with the application settings.

11 Click OK to add the specified controls.

Alternatively, add and define label-specific controls, then click OK.
Add label-specific controls when your experiment contains samples stained with the same fluorophore conjugated to different antibodies (labels) that require different compensation values. This is especially useful with tandem conjugates due to lot-to-lot variation. See the *BD FACSDiva Software Reference Manual* for more information about this feature.

A compensation specimen is added to the experiment, along with a stained control tube for each compensation control. (Expand the specimen to view all tubes.) Worksheets containing appropriate plots are added for each compensation tube.

### Calculating Compensation

The unstained control will be used to verify the settings for FSC, SSC, and FSC threshold, and to gate the population of interest.

1. Install the unstained control tube onto the cytometer.
2. Expand the compensation specimen in the Browser.
3. Set the current tube pointer to the unstained control tube and click Load.
4 Verify that the population of interest is displayed appropriately on the FSC vs SSC plot. Adjust if needed. (See Figure 4-18.)

Since the application settings have already been optimized for your sample, the cytometer settings should require little or no adjustment.

**Figure 4-18** Voltages adjusted

5 Click the **Threshold** tab and adjust the FSC threshold, if needed.

Set the threshold to remove most of the debris without cutting off the singlet population (Figure 4-18).

6 Adjust the P1 gate to surround only the singlets (Figure 4-18).

7 Right-click the P1 gate and select **Apply to All Compensation Controls**.

The P1 gate on each stained control worksheet is updated with your changes.

8 **Click Record Data**.

9 When recording is finished, click **Unload** and remove the unstained control tube from the cytometer.

⚠️ Do not change the PMT voltages after the first compensation control has been recorded. In order to calculate compensation, all controls must be recorded with the same PMT voltage settings. If you need to adjust the PMT voltage for a subsequent compensation control, you will need to record all compensation controls again.
10 Install the next tube onto the cytometer and repeat steps 8 and 9 until data for all stained control tubes has been recorded.

11 Double-click the first stained control tube to display the corresponding worksheet.

12 Verify that the snap-to interval gate encompasses the positive population. Adjust the gate, if needed.

13 Repeat steps 11 and 12 for the remaining compensation tubes.

14 Select Experiment > Compensation Setup > Calculate Compensation.

15 Enter the name of your experiment as the setup name, then click Link & Save.

**Tip** To keep track of compensation setups, include the experiment name, date, or both in the setup name.

**NOTE** We recommend that you always visually and statistically inspect automatically calculated overlap values. The means of the positive controls should be aligned with the means of the negative.
Data Recording and Analysis

Once you have optimized the cytometer electronics for your sample type, you are ready to record and analyze data.

Before you record data, we recommend that you gate out doublets in order to record only singlet events. The Doublet Discrimination Gating template provides gated plots for this purpose.

During analysis, recorded data is displayed in plots, and gates are used to define populations of interest. BD FACSDiva software analyzes the gated data and calculates statistics that you can print or export. With global worksheets, data can be shown for a series of tubes on the same worksheet, manually or in an automated batch analysis.

The following sections describe how to use BD FACSDiva software features to record and analyze sample data.

Setting Up the Experiment

Before you record data, set up an experiment with appropriate tubes, plots, and labels for your assay. This section describes how to add Browser and worksheet elements to the experiment that was started in the previous section, Data Collection.

1. Rename Specimen_001 to a descriptive name.
2. Rename Tube_001 to 4-color_001.
3. Set the current tube pointer to the 4-color_001 tube.
4. Click Next Tube in the Acquisition Dashboard to duplicate the first tube with the name 4-color_002.
5. Use the experiment layout to specify the number of events to record for each tube.
The experiment layout can be used to define the events to record as well as parameter labels for all tubes in an experiment. Labels appear on the plot axes and in all statistics views.

**a** Select Experiment > Experiment Layout.

**b** In the Acquisition tab, select the events to record field for all specimen tubes, and select or enter 5,000 events.

**c** Click OK.

---

### Setting Up the Global Worksheet

A global worksheet is used to perform doublet discrimination and to set up plots to preview and record data.

1. Click the Worksheets View button on the Worksheet toolbar.

   The global worksheet is shown. If you are using the Doublet Discrimination Gating template, the worksheet shows the predefined plots and gates used to distinguish singlets from doublets.
The second and third plots are set up to display gated data from the first and second plots, respectively, as shown in the population hierarchy.

2 Create two dot plots for previewing and recording data.

For this example, create a FITC vs PE plot and an APC vs PerCP-Cy\textsuperscript{TM}5.5 plot.

**Tip** Double-click the *Plot* button to keep it selected until you create all plots. Click any other button to undo the selection.

3 Turn on biexponential display.

   a Select the two plots.

   b In the *Inspector*, select the checkbox for *X Axis* and *Y Axis* under *Biexponential Display*.

4 Set up the fluorescence plots to display data from the FSC gate.

The FSC gate defines singlet events. By gating the fluorescence plots through this population, only singlet events will be recorded.

   a Select the two plots.
In the Inspector, select the FSC Gate checkbox.

Arrange the fluorescence plots so they fill the page vertically.

For an example, see Figure 4-20 on page 161.

**Recording Data**

This section describes how to adjust the gates to eliminate doublets and record singlet events.

1. Move the current tube pointer to the 4-color_001 tube.
2. Install the first mixed sample tube onto the loading port and click **Load**.
3. Change the **Events to Display** to 5,000 events.
4. Adjust the scatter gate to encompass the singlet events.
5. Adjust the SSC gate to encompass the low SSC-W population.
6. Adjust the FSC gate to encompass the low FSC-W population.

**Figure 4-19** Discriminating singlet events
Chapter 4: Running Samples

7 Click **Record** in the **Acquisition Dashboard** to record data.

8 When all events have been recorded, click **Unload** and remove the tube from the cytometer.

9 Install the next tube, then click **Next Tube** in the **Acquisition Dashboard** to move the current tube pointer to the next tube.

10 Repeat steps 7 through 9 for the remaining tubes.

**Analyzing Data**

This section describes how to set up plots, gates, and a statistics view to analyze the recorded data. By the end of this section, your analysis should look similar to that shown in Figure 4-20 on page 161.

1 Select **Edit > User Preferences**.

2 In the **Gates** tab, set the preferences as follows.

3 Create the following gates:
   - Quadrant gate on the FITC vs PE plot.
   - Interval gate on the APC vs PerCP-Cy5.5 plot to capture the APC beads.
• Rectangle gate on the APC vs PerCP-Cy5.5 plot to capture the PerCP-Cy5.5 beads.

4 Rename each population in the population hierarchy.

☑ Tip Press the Enter key twice to move to the next population without using the mouse.

5 Right-click either fluorescence plot and select Create Statistics View.

A statistics view is added to the worksheet.

6 Right-click the statistics view and select Edit Statistics View.

7 Edit the statistics view as follows:

• In the Header tab, select the Use 2 columns for display checkbox.

• In the Populations tab, clear the checkboxes for all populations except FITC, PE, PerCP-Cy5.5, and APC.

• In the Statistics tab, select the Mean checkboxes for the fluorescence-A parameters.

8 Resize the statistics view so it fits on the page.

9 (Optional) Print the analysis.
Performing a Batch Analysis

Batch analysis allows you to automatically advance through a selected set of tube data when using a global worksheet.

To perform a batch analysis:

1. Verify that the global worksheet you will be using for analysis is displayed in the worksheet window.
Right-click the specimen to analyze in the **Browser** and select **Batch Analysis**.

The Batch Analysis dialog opens.

Only tubes under the selected specimen will be processed. Tubes without data are skipped during a batch analysis.

Do the following in the **Batch Analysis** dialog.

- Select **Auto** to analyze all the files without user intervention.
- Select 5 from the **View Time** menu to pause the analysis for 5 seconds after each tube is loaded.
- Select the **Output to Printer** checkbox to print a copy of the analysis after the data for each tube is loaded.
- Select the **Statistics** checkbox to export the statistics to a separate file, then enter a name for the statistics file. By default, the file is saved at D:\BDExport\Statistics.
- Select the **Freeze Biexponential Scales** checkbox to process all files with the same biexponential scales.
- Clear the **Use Preferred Global Worksheet** checkbox to display analyses of tubes within the same global worksheets. This option is useful for analyzing panels that require a separate global worksheet for each tube.
See the *BD FACSDiva Software Reference Manual* for more information on batch analysis.

4. Click **Start** to begin the analysis.

When the analysis is finished, a completion dialog opens.

---

**Manual Adjustment of Laser Delay**

Laser delay is automatically adjusted during performance checks. However, you may want to adjust laser delay manually, for example, when changing sheath pressure.

In a BD FACS Aria III system with red, blue, and violet lasers, the red laser intercepts the stream first, followed by the blue and violet lasers, respectively. Because the laser signals are spatially separated, there is a slight delay between the detection of each laser’s signal.

The laser delay factor in BD FACSDiva software is used to realign the signals so they can be measured and displayed on the same time scale. Signals are aligned with respect to the blue laser, so the blue laser will have a 0 delay value, the red laser will have a negative delay value, and the violet laser will have a positive delay value.

To manually adjust the delay:

1. Select your experiment folder in the **Browser** and create a new experiment.

2. Rename the experiment **Laser Delay**.

3. Create a specimen and a tube in the experiment and set the current tube pointer next to the tube.
4 On the global worksheet, create a plot for FSC vs SSC and then histograms for each laser.

5 Create a P1 gate on the FSC vs SSC plot and change the histograms to view P1.

6 Prepare and load a tube of Spherotech Rainbow beads.

<table>
<thead>
<tr>
<th>BD FACSFlow Solution</th>
<th>SPHERO™ Rainbow Particles (3.0–3.4 µm)</th>
<th>Ordering Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 mL</td>
<td>2 to 3 drops</td>
<td>BD Biosciences Cat. No. 556291</td>
</tr>
</tbody>
</table>

7 Place the population on scale in the FSC vs SSC plot.

8 Adjust P1 to encompass the singlet population, if needed.

- Optimize the delay setting for the red laser.
b Click the Laser tab in the Cytometer window.

c While watching the peak in the APC-A histogram, change the window extension to 0.

- If the APC-A signal stayed the same or had little change, then go to step d.
- If the APC-A signal decreased, then follow steps c through d.

d Adjust the laser delay value until the maximum APC-A signal is achieved.

e Reset the window extension to the appropriate setting (typically 2).

9 Repeat step a for each laser, using the appropriate fluorochrome for each laser.

10 (Optional) To return to the laser delay values determined by CS&T, right-click the cytometer settings in the Browser and select Apply CST Settings.
(Optional) To save this worksheet for future use, export it as an analysis template.

a  Right-click the global worksheet in the Browser.

b  Select Export > Analysis Template.

c  Name the template *Laser Delay Plots* and click Save.
You can program BD FACSDiva software to sort a specified number of particles from multiple populations into a variety of sorting devices including tubes, plates, and slides. Hardware for sorting into plates and slides is available as an option. Up to four defined populations can be sorted into each tube, allowing up to 16 populations to be sorted at one time.

The following topics are covered in this chapter:

- Setting Up for Sorting on page 168
- Determining the Drop Delay – Manual Method on page 172
- Determining the Drop Delay – Automatic Method on page 177
- Sorting on page 179
- Setting Up for Sorting Onto a Plate or Slide on page 188
- Index Sorting on page 195
- Terasaki Plate Adapter on page 199
Setting Up for Sorting

In general, do the following to set up for a sorting experiment. Each step is explained in more detail in previous or subsequent sections.

1 Start up the cytometer and the computer.

   See Cytometer Startup on page 118.

2 Install the appropriate size nozzle.

3 Select a new sort setup mode, if needed, and select an appropriate cytometer configuration.

   To change your current sort setup mode, select a nozzle size from the Sort > Sort Setup menu.

   For more information, see Sort Setup on page 104.

4 Install a sample line filter, if needed.

   See Installing or Removing a Sample Line Filter on page 235.

5 Check the laser delay for your sheath pressure and particle size.

   • To set the laser delay automatically using the CS&T module, see Checking Cytometer Performance on page 135.

   • To set the laser delay manually, see Manual Adjustment of Laser Delay on page 163.

6 If you have the AMO, turn it on at 20%.

   See Operating the BD Aerosol Management Option on page 304.

7 Optimize cytometer settings for the sample to be sorted.

   See Data Collection on page 148.
8 Install the required collection device and set up the side streams.

See Setting Up for Bulk Sorting on page 169 or Setting Up for Sorting Onto a Plate or Slide on page 188.

9 Calculate the drop delay.

See Determining the Drop Delay – Manual Method on page 172.

10 Use gating tools and subsetting methods to define the population(s) of interest.

Examples of gating analyses can be found in Analyzing Data on page 159.

11 Define a sort layout for the tube containing the defined sort populations and proceed with sorting.

See Sorting on page 179.

### Setting Up for Bulk Sorting

This section describes how to set up the streams for two- or four-way sorting. For sorting using the ACDU option, see Setting Up for Sorting Onto a Plate or Slide on page 188.

Any cytometer surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing and gloves.

To set up for bulk sorting:

1 Install collection tubes in the required collection device.

Collection tube holders are available for 1-mL microtubes, 1.5-mL Eppendorf® tubes, 12 x 75-mm tubes, and 15-mL centrifuge tubes. For compatible tubes, see Labware on page 286.

2 Install the collection tube holder onto the cytometer.
a  Close the sort block door and open the sort collection chamber door, if needed. The sort block door must be closed to install the tube holder.

b  Slide the holder into the slotted fittings below the sort aspirator drawer, then close the sort collection chamber door.

⚠ Before installing the collection tube holder, ensure that an O-ring is installed in the groove between the two sections of the tube holder. The O-ring minimizes the chance of aerosols escaping. It can be found in the accessory kit (Catalog No. 337897).

3  Turn on the deflection plates.

Click the Voltage button in the Side Stream window (Figure 5-1 on page 170). The voltage warning light illuminates, indicating that the plates are charged.

⚠ A 12,000-volt potential exists between the deflection plates when they are on. Contact with the charged plates results in serious electrical shock. Do not touch the deflection plates when the plate voltage is on. The plates remain energized even when the sort block door is open.

Figure 5-1  Turning on the deflection plates

Make sure the center stream image does not move after the plates are turned on. Major movement of the center stream could indicate that the plates or the area around the plates needs cleaning.
4 Click the Test Sort button and optimize the side streams. See Figure 5-2.

Adjust the voltage sliders to view the required number of streams.

**Figure 5-2** Turning on Test Sort

If you cannot see a stream image or the image is dim, adjust the micrometer dial on the diode laser to better view the streams (Figure 1-21 on page 42).

5 Adjust the 2nd, 3rd, and 4th Drop settings to tighten the center stream and fine-tune the side streams, if needed.

Generally, the sort setup mode provides good starting values for these settings. Adjust the values only if needed to optimize the streams.

6 Open the aspirator drawer and aim the side stream(s) into each collection tube.

   a In the Side Stream window, click the Waste Drawer button to open the drawer.

   b Open the sort block door and aim each side stream into the tube as you adjust the corresponding slider in the Side Stream window.

   c When you are satisfied with the side stream deflection, close the sort block door.

7 Click the Voltage button to turn off the deflection plates.
Determining the Drop Delay – Manual Method

BD FACS Accudrop technology is used to determine the optimal drop delay setting for your sorting application. For more information, see Drop Delay Overview on page 71.

There are two methods for determining the drop delay.

- **Manual drop delay.** Using the standard method as described in the following sections.

- **Auto drop delay.** Using an automated algorithm method. See Determining the Drop Delay – Automatic Method on page 177.

**NOTE** Before beginning these procedures, make sure the stream is stable and the Sweet Spot is on.

Setting Up the Experiment

This section describes how to set the drop delay using the Accudrop experiment template. Because no data is recorded, the experiment can be reused as often as you like.

1. Create an experiment from the Accudrop Drop Delay template.

   Select Experiment > New Experiment. Select the Accudrop Drop Delay experiment and click OK.
2 Expand Specimen_001 and Tube_001.
3 Set the current tube pointer to Tube_001.
4 Open the sort layout by double-clicking it.
Using Manual Drop Delay

This section describes the manual method of optimizing the drop delay.

1. Load a tube filled with a suspension of Accudrop beads (approximately one to two drops of beads in 0.5 mL of PBS).

2. In the Laser tab of the Cytometer window, set the window extension to zero.

3. Adjust the flow rate to achieve an event rate of 1,000–3,000 events per second.

4. Turn on the voltage in the Side Stream window. Click Sort in the Sort Layout window.

5. Click Cancel at the Confirm dialog.
There is no need to collect the beads. When the drawer is closed, the beads are sorted to waste.

6 Adjust the micrometer dial (see Figure 1-21 on page 42) to obtain the brightest bead spot on the center stream.

7 Click the Optical Filter button in the Side Stream window.

This control moves the emission filter that allows you to view the Accudrop beads in front of the lower camera. When the control is clicked, the image switches from a raw image to a processed (digitized) image. The two boxes indicate the region of the image where the left and center stream intensities are calculated during image processing. The numbers shown are percentages of the total intensity.

If the left side stream is not completely contained in the left region, adjust the voltage slider to place the stream in the center of the region.

8 Verify that the sort precision mode is set to Initial.

See Sort Precision Modes on page 77 for more information.

9 Optimize the drop delay.

Adjust the drop delay value in 1-drop increments (Ctrl+click arrow control) to achieve close to 100% intensity in the left side stream. Wait a few seconds after each click for a complete response to the delay change.

Figure 5-3 Sorting Accudrop beads in Initial mode
10 In the Sort Layout window, change the precision mode to Fine Tune.

11 Optimize the drop delay.

   Adjust the drop delay value in 0.03-drop increments (click the arrow control) until the left side stream intensity is greater than or equal to 90%. Wait a few seconds after each click for a complete response to the delay change.

   **Figure 5-4** Sorting Accudrop beads in Fine-Tune mode

12 Click the Optical Filter button to move the emission filter away from the camera.

13 Reset the window extension to its original setting (typically 2).

14 Turn off the deflection plates.
Determining the Drop Delay – Automatic Method

The auto drop delay feature automates setting the drop delay to get optimized results from sorting. You should use this method after you have a good understanding of how drop delay works in general. See Using Manual Drop Delay on page 174 for more information.

Overview of Auto Drop Delay

Auto drop delay works best when the sort system is stable, and assumes that Accudrop beads are used. When the process is started, the auto drop algorithm uses several passes to find best drop delay possible under the current conditions of the system. Coarse passes are used to find the initial drop delay within 2 drops of the ideal. The coarse passes are faster than the fine-tune passes. Fine-tune passes are used to locate the ideal drop delay value considering the current conditions.

Using Auto Drop Delay

1. Set up an experiment for drop delay as described in Setting Up the Experiment on page 172.

2. Load a tube filled with a suspension of Accudrop beads (approximately 2 drops of beads in 0.5 mL of PBS).

3. Adjust the flow rate to achieve these values of events per second:

   - 70 micron = 1,000 to 3,000
   - 85 micron = 800 to 2,000
   - 100 micron = 600 to 1,500
   - 130 micron = 400 to 1,200

   **Tip** If this cannot be achieved using a flow rate setting between 1 and 5, adjust the bead concentration.

4. Turn on the voltage in the Side Stream window. Click Sort in the Sort Layout window.
5 Click **Cancel** in the **Confirm** dialog.

There is no need to collect the beads. When the drawer is closed, the beads are sorted to waste.

6 Adjust the micrometer dial (see Figure 1-21 on page 42) to obtain the brightest bead spot on the center stream.

7 Click the **Auto Delay** button in the **Side Stream** window.

A dialog similar to Figure 5-5 on page 179 opens. The graph in the left pane of the dialog represents brightness of the stream (Y axis) versus drop delay (X axis). Typically the graph should have a flat portion, with several small peaks in either direction (up or down) or one prominent peak.

**NOTE** If the original drop delay value was close to the appropriate value prior to starting auto delay, then you may not get a graph displayed because few data points were required to determine the optimal drop delay.

8 Select **Start Run** in the **Auto Drop Delay** dialog.

9 Monitor the **Auto Drop Delay** dialog for progress.

A message is displayed when the process is completed.

**NOTE** If the sort is stopped during algorithm execution (either by user action or because the system detected a failure), the run will be stopped with an appropriate message. Start the sort again, verify that the stream is stable and the sort is not pausing, and re-run the auto drop delay.
Before beginning the sort, do the following:

1. Perform the steps outlined in Setting Up for Sorting on page 168.

2. Use gating tools and subsetting methods to define the population(s) of interest.

Examples of gating analysis can be found in Analyzing Data on page 159.

**NOTE** Gates drawn on a biexponential scale can be used for sorting. However, the cytometer will sort on a log scale. Therefore, a gate that crosses the zero boundaries will sort all events below zero into that gated population. This can cause a variance between the sort results and the statistical results in the software. If the gate is completely below zero on a biexponential plot, no events will be sorted.

**NOTE** Snap-to gates cannot be used for sort gates.
Setting Up the Experiment

**Tip** When more than one drop is deflected in the same direction, residual charge from the first drop degrades the quality of the side streams. Thus, when four-way sorting or sorting into small wells where precise deflection is required, use the 4-Way Purity mode or select a mode with a yield mask of zero. For more information, see Yield Mask on page 74.

1. Create a new sort layout by clicking the **New Sort Layout** button on the **Browser** toolbar.

   By default, the 2-Tube Sort Layout appears.

2. Make appropriate entries in the **Sort Layout** window.

   - Select the collection device from the **Device** menu.
   - Change the sort precision mode to **Purity** (two tubes), **4-Way Purity** (four tubes), or **Single Cell** (plate or slide).
   - Enter the number of target events by selecting a value from the menu or entering a number in the field.
   - Select a **Save Sort Reports** option: **Save None**, **Save All**, or **Ask User**. See Setting Up a Sort Layout on page 108.
   - Select the **Save Conflicts** checkbox if you are using a 2- or 4-tube sort layout and want to save conflicts.
• Select the Index Sorting checkbox if you are doing an index sort. See Index Sorting on page 195.

• Select the sort location field(s) to be sorted into. Select multiple fields by dragging the mouse. Select a row or column by clicking the row or column header.

• Add the required population(s) to each sort location field.

• To display fewer counters in the Sort Layout window, click the View Counters button and clear a menu option. The corresponding counter is hidden. (Only counters with a checkmark next to the name are displayed.)

Starting and Monitoring the Sort

1 Open the sort collection chamber door and install the collection tubes, plate, or slide.

2 Install the sample tube onto the loading port and click Load.

3 Adjust the flow rate.

   Sorting results are typically optimized at lower flow rates.

4 (Optional) Turn on the deflection plates and open the aspirator drawer.

   The deflection plates turn off automatically each time a tube is unloaded. If you do not turn them back on before beginning a sort, a dialog appears where you can turn on the plates and open the aspirator drawer by clicking OK.

5 Verify that the current tube pointer is indicating the appropriate tube in the Browser, then click Sort.

6 Click OK if you are prompted to open the aspirator drawer or turn on the deflection plates.
If you click Cancel, sorting will begin with the deflection plates off and the drawer closed. As a result, sort populations will be identified and counted, but no deflection (or sorting) will occur. If you sort with the drawer closed, events will be sorted to waste.

**Tip**  Click **Record Data** to save data for the tube. Acquisition and sorting continue after the required number of events has been recorded.

Sorting continues until the required number of cells has been sorted. Acquisition stops and the drawer closes when sorting is complete. If the number of Target Events is set to Continuous, sorting continues until you manually stop sorting by clicking the Stop Acquiring button in the Dashboard, or the Sort button in the Sort Layout window.

Monitor the sort progress in the Sort Layout window. The number of events sorted into each sort location appears in the corresponding field. The sort rate and sort conflict rate are displayed in the corresponding counter fields.

**NOTE**  When the Sweet Spot is on, sorting pauses automatically if the Drop 1 or Gap values are out of range. This ensures that sorting occurs
only under the proper breakoff conditions. If a more severe problem such as a clog is detected, the stream shuts off and sorting stops. The deflection plates shut off, the aspirator drawer closes, and the sample tube is unloaded. To clear a clogged nozzle, see Responding to a Nozzle Clog During a Sort on page 186.

7  (Optional) You can print the sort report at this time, or open the report later and print it then. You can also export the report.

**Stopping and Resuming a Sort**

The Stop/Resume feature allows you to temporarily stop the sort and still retain the counter values. This is particularly useful when the sample volume is low and you need to refill the tube, or to replace collection tubes.

**Replacing a Sample Tube**

1  To stop a sort while it is running, click the **Sort** button in the **Sort Layout** window.

2  If prompted, click **OK** to save the sort report.

   You can set the sort report to save automatically after each sort. See Setting Up a Sort Layout on page 108.

3  Unload the sample tube by clicking **Unload** in the **Acquisition Dashboard**.

4  Refill the sample tube, then click **Load** in the **Acquisition Dashboard**.

5  Click the **Resume** button in the **Sort Layout** window to continue sorting.

6  Click **OK** when you are prompted to open the aspirator drawer or turn on the deflection plates.

   The sort counters resume from the value where they stopped. The threshold counter restarts. However, the value is accumulated and the total count is saved in the final sort report.
Replacing the Collection Tubes

1. To stop a sort while it is running, click the Sort button in the Sort Layout window.

2. If prompted, click OK to save the sort report. You can set the sort report to save automatically after each sort. See Setting Up a Sort Layout on page 108.

3. Click Stop Acquiring in the Acquisition Dashboard to stop the sample flow.

4. Turn off the deflection plates by clicking the Voltage button in the Side Stream window.

5. Remove the lower section of collection tube holder by lifting up on the handle and pulling the lower section of the holder down and forward.

6. Replace the collection tubes as needed.

7. Reinstall the tube holder and pull down on the handle to secure it in place.

8. Click Acquire Data in the Acquisition Dashboard to restart the sample flow.

9. Click the Resume button in the Sort Layout window to continue sorting.

10. Click OK when you are prompted to open the aspirator drawer or turn on the deflection plates.

The sort counters resume from the value where they stopped. The threshold counter restarts. However, the value is accumulated and the total count is saved in the final sort report.
Pausing and Resuming a Sort

The Pause/Resume feature allows you to temporarily pause the sort, and still retain the sort counter values. This is useful when you need to make adjustments to an experiment during a sort. Be aware that the sample continues to flow during a pause.

**NOTE** If you need to replace the sample tube to refill it, or to replace collection tubes, you should stop the sort. See Stopping and Resuming a Sort on page 183.

1. To pause a sort while it is running, click the **Pause** button in the **Sort Layout** window.

2. Make adjustments to the experiment as needed.

3. Click the **Resume** button in the **Sort Layout** window to continue sorting.
Responding to a Nozzle Clog During a Sort

If the stream is disturbed during the sort (due in part to a clogged nozzle), the sort is designed to stop automatically and block the sort tubes (if Sweet Spot is on). The sort will not restart until the operator has cleared the clog. In the event of a nozzle clog, do not open sort collection chamber door or access the sort tubes before following this procedure.

**NOTE** If your system has the AMO, see Responding to a Nozzle Clog During a Sort with the AMO on page 308.

To clear a clogged nozzle:

1. If the stream has not already shut down automatically, turn off the stream by clicking the Stream button (with a checkmark) at the top of the Breakoff window.

   This will shut off the stream, unload the sample, and close the aspirator drawer.

2. Turn on the stream and view the breakoff.

   If the clog is removed, the breakoff will be similar to the breakoff before the clog.

3. If the clog is not cleared, turn the stream on and off several times to see if the clog will clear itself.

4. If the clog is not removed, turn the stream off and perform the Clean Flow Cell procedure with DI water (see Cleaning the Flow Cell on page 202), followed by turning the stream on to see if the clog will clear itself.
5. With the aspirator drawer closed, wait for at least 3 minutes to clear aerosols before opening the sort collection chamber and the sort block door.

6. If it is necessary to change nozzles or remove a clog from a nozzle, see Cleaning the Integrated Nozzle on page 229.

7. With the stream turned off, open the sort block door and dry the plates and surfaces as needed.

8. When removing collection tubes, be aware that the outside of the tube is potentially contaminated. Use alcohol swabs or bleach to wipe the outsides of tubes.

9. Make sure that all chamber doors are closed and restart the stream.

10. Perform these tasks if needed:

    • Turn on the Sweet Spot
    • Check drop delay
    • Check side stream deflection
Setting Up for Sorting Onto a Plate or Slide

The following sections describe how to set up for sorting onto a plate or slide. For general guidelines, see Setting Up for Sorting on page 168.

Installing the Sorting Hardware

⚠️⚠️ Any cytometer surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing and gloves.

1 Install the splash shield below the aspirator drawer.

   a Close the sort block door and open the sort collection chamber door, if needed.

      The sort block door must be closed in order to open the collection chamber door.

   b Remove the tube holder, if one is installed.

   c Slide the splash shield into the slotted fittings below the sort aspirator drawer and push it all the way in.
2. Click the Access Stage button to bring the ACDU stage to the front.
   
a. Open an experiment, if one is not already open, and create a sort layout for any of the tubes.
   
b. In the Sort Layout window, click the Access Stage button to move the stage to the front of the sort collection chamber.

3. Install the required collection device on the stage (Figure 5-6).
   
   • If you are sorting into a plate, install the plate with well A1 toward the front of the stage.
   
   • If you are sorting onto a slide, install the slide-adapter tray with the printed side up. If your slide has a frosted end, place the frosted end to the right.

*Figure 5-6* ACDU stage set up with plate (left) and slide (right)

Sorting starts on the front left corner of the device (A1 location), and proceeds from front to back, and then from left to right, sorting in a serpentine motion. Thus, for a plate, sorting proceeds from well A1–A12, B12–B1, C1–C12, and so on.

When sorting onto a slide, sorting proceeds in rows across the short end of the slide, and in columns along the long end of the slide. Make sure that you set up your sort layout accordingly. See Figure 5-7.
Setting Up the Stream

This section describes how to optimize side stream deflection and how to adjust the home location.

When sorting onto a plate or slide, the stage is pre-programmed to move a set distance between wells on a plate or spots on a slide. The home location is used as the starting point. The far left stream should hit the center of the well in the top left corner of a plate or the top left corner of a slide at the home location.

Default home location coordinates exist for each standard sort collection device: BD Falcon™ multiwell plates with 6, 24, 48, 96, and 384 wells, and standard or frosted-end slides. For other plate types, you will need to create a custom device. See Creating a Custom Device on page 192.

Use the following procedure to verify the home location and adjust it.

1. Optimize the drop delay.

   See Determining the Drop Delay – Manual Method on page 172.
2 Turn on the deflection plates.

Click the Voltage button in the Side Stream window. The voltage warning light illuminates, indicating that the plates are charged.

**NOTE** Make sure the center stream image does not move after the plates are turned on. Major movement of the center stream could indicate that the plates or the area around the plates needs cleaning. See External Cleaning on page 206.

3 Click the Test Sort button and optimize the far left side stream, then click the Test Sort button again to turn it off.

Adjust the far left slider for minimal deflection of the stream. The stream should be deflected just enough to clear the hole in the splash shield. Do not adjust the other sliders.

If you cannot see a stream image or the image is dim, adjust the micrometer dial on the diode laser (Figure 1-21 on page 42) to better view the streams.

4 Select Sort > Home Device.

5 In the Device Setup dialog, select the collection device you are using and click Go to Home.
The stage moves to the pre-programmed home position.

6. Double-click the Test Sort button to deposit a drop at the home location.

7. Inspect the collection device to see where the drop was deposited.

   If you need to move the stage to the front, close the Device Setup dialog and click the Access Stage button in the Sort Layout window.

8. Wipe the collection device dry and place it back on the tray support.

   If needed, click the Access Stage button to send the stage back and select Sort > Home Position to access the Device Setup dialog again.

9. Adjust the home location, if necessary.

   Click the appropriate arrow buttons to move the tray support as needed. Large arrows move the tray by five steps. Small arrows move the tray by one step.

10. Repeat steps 6 through 9 until the drop is centered appropriately.

11. Click Set Home, then Close.

12. Click the Voltage button to turn off the deflection plates.

13. Proceed with Sorting on page 179.

Creating a Custom Device

You can program the ACDU stage to sort into any grid configuration. Create a custom device by entering the number of rows and columns and setting the home and farthest locations. BD FACSDiva software calculates the increment between rows and columns to determine the sort locations. The home and farthest locations for a 96-well plate are A1 and H12, respectively.
1. Select Sort > Custom Devices.

2. Click the Add button in the Custom Devices dialog.

A new device is added to the list of custom devices. By default, devices are named Custom Device_00x, where x is the next consecutively numbered device.

3. Select the text in the Name field and enter a new name.

4. Enter the number of sort location rows and columns.

A device can have up to 60 rows and 25 columns.

5. Use the arrow buttons and the Test Sort button to set the home location, then click Set Home.
See Setting Up the Stream on page 190 for details. There are no default values for custom devices, so greater initial adjustment with the arrow buttons is required.

6 Use the same procedure to set the farthest location, then click Set Farthest.

The farthest sort location is the well or spot on the lower-right corner of the collection device.

7 Click Close.

After you set the home and farthest locations, custom devices are listed in the Device menu in the Sort Layout window.

**NOTE** Once custom devices are defined, you cannot change the number of rows and columns.

8 Click the Voltage button to turn off the deflection plates.

9 Proceed with Determining the Drop Delay – Manual Method on page 172 and Sorting on page 179.

**Deleting a Custom Device**

1 Select Sort > Custom Devices.

2 Select the name of the custom device to be deleted in the Custom Devices dialog.

3 Click Delete.

The device is deleted from the Custom Device list, but is retained within any sort layouts where it was used.
Index Sorting

Index sorting allows you to sort single cells onto a plate or slide and indexes the well or slide location to the collected parameters for that cell. You can use this feature to ensure that a sorted cell with a specific phenotype has been sorted. Index sorting is useful in characterizing subpopulations of phenotypically similar events using post-sort genetic, chemical, and/or metabolic applications.

Setting Up for Index Sorting

Index sorting uses the same steps as required in setting up for a plate or slide sort. Review the instructions in these sections:

- Setting Up for Sorting on page 168
- Setting Up for Sorting Onto a Plate or Slide on page 188

To perform an index sort:

1. Create a new experiment for the index sort.
2. Create the plots and gates needed to define the populations of interest.
3. Create a new sort layout or select an existing sort layout defined for index sorting.
4. Select these items in the sort layout window.
   - Precision = Single cell
   - Target events = 1
   - Index sorting checkbox = Selected

Make the other selections in the Sort Layout window according to your experiment requirements.
5 Click the Sort button in the Sort Layout window to start the sort. A new tube is automatically added to the experiment.

6 When the sort is finished, right-click the new tube in the experiment and select Index Sorting Analysis.

The Index Sorting Analysis displays, as shown in the following figure.
The color legend for the wells is shown in the following table.

<table>
<thead>
<tr>
<th>Color</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>Sorted well data is showing in the plots</td>
</tr>
<tr>
<td>Gray</td>
<td>Sorted well data is available, but not showing in the plots</td>
</tr>
<tr>
<td>White</td>
<td>No sorted events</td>
</tr>
<tr>
<td>Red</td>
<td>More than one event sorted into a well</td>
</tr>
</tbody>
</table>

Select a well in the Index Sort Analysis to see the event sorted into that well displayed in a plot.

After selecting an individual well, the other wells in the Index Sort Analysis turn to gray, indicating that they contain data, but are not being displayed.

You can select multiple wells by holding down the Shift or the Control keys. You can also click and drag over multiple wells in the Index Sort Analysis to display multiple wells.
To increase the size of a dot on a plot for better visibility, open the population hierarchy, select a population, navigate to the Population Inspector and select a larger size.

To see the statistics for an index sort, right-click a plot and select Create Statistics View.

To export the statistics for an index sort as a CSV file, right-click in the statistics view and select Export Index Sort Statistics.

In the dialog that opens, navigate to the location where you want to save the CSV file.
A Terasaki plate adapter is available as an option to enable the use of 60-well and 72-well Terasaki plates with the ACDU. A Terasaki plate is installed into the adapter, and then the plate/adapter assembly is loaded onto the ACDU.

Using the Adapter

The adapter has three set screws that enable the fit to be adjusted for the plates.

1. Install a Terasaki plate into the adapter with the A10 or A12 well at the bottom left corner of the adapter.

2. Tighten the set screws so the plate is held firmly and does not move within the adapter, but do not over-tighten because you need to be able to remove plates easily.

The set screws should not have to be adjusted after the initial fitting process.
Using the Correct Device in the Sort Layout

During the sort layout setup process, you have to select the correct device in the Sort Layout window so the ACDU knows the layout and location of the wells on the Terasaki plate.

1. In the Sort Layout window, select the Device menu.

2. Navigate to the bottom of the list, then select the plate you are using (60-well or 72-well).

The sort layout displays with the correct number of rows and columns.
The BD FACSARia III cytometer is designed to require minimum maintenance. However, to preserve the reliability of the cytometer, you must regularly perform basic preventive maintenance procedures. This chapter explains the routine maintenance procedures you should follow to keep your cytometer in good condition.

Maintenance procedures are presented as follows:

- Daily Shutdown on page 202
- Scheduled Maintenance on page 207
- Unscheduled Maintenance on page 227
Daily Shutdown

In the BD FACSARia III system, the recommended daily shutdown procedure is to run the Clean Flow Cell command with the closed-loop nozzle installed (see the next section). This procedure fills the flow cell with cleaning solution. This is normally sufficient to keep the flow cell clean and operating properly.

If the system is used to process many different sample types, or the system has problems with contamination, you can perform a more extensive cleaning by running the Fluidics Shutdown command. See Fluidics Shutdown on page 203.

In addition to one of the choices listed above, you should also perform an external cleaning. See External Cleaning on page 206.

Cleaning the Flow Cell

Use the Clean Flow Cell command to run a tube of DI water through the sample line and flow cell. This procedure can be used in two ways:

- As the daily shutdown procedure.
- Any time poor optical performance indicates that additional cleaning is needed.

NOTE After the procedure is complete, the DI water remains in the flow cell until the stream is restarted.

To clean the flow cell:

1 Turn off the stream.

2 Remove the nozzle and install the integrated closed-loop nozzle. See Figure 6-1 on page 204.

   If you are using a standard closed-loop nozzle, verify that there is an O-ring in the nozzle before installing it.

3 Select Cytometer > Cleaning Modes > Clean Flow Cell.
4 When prompted, install a tube containing approximately 3 mL of sterile, filtered DI water, then click **OK**.

The cytometer loads the tube and fills the flow cell with the DI water.

5 Click **OK** when the completion dialog opens.

6 If this is part of a daily shutdown, perform these steps:
   
   **a** Turn off the cytometer main power.

   **b** Exit BD FACSDiva software and shut down the computer.

   **c** Vent the air pressure from the sheath tank by pulling up on the vent ring.

**Fluidics Shutdown**

The Fluidics Shutdown command can be used to perform an extensive cleaning if the system is used to process many different sample types, or the system has problems with contamination. This procedure removes sheath fluid from the lines and fills them with 70% ethanol, and cleans the flow cell.

**Preparing for Shutdown**

1 Unload the sample tube, if one is loaded.

2 Turn off the stream.

3 Check the waste container and empty it if needed.

   See Emptying the Waste Container on page 133.

4 Check the ethanol shutdown tank and refill if it needed.

   See Refilling the Ethanol Shutdown Tank on page 130.
Running Fluidics Shutdown

1 Select Cytometer > Fluidics Shutdown.

The Fluidics Shutdown dialog opens.

2 Remove the nozzle from the flow cell assembly and click Done.

3 Insert the integrated closed-loop nozzle into the flow cell assembly and click Done. See Figure 6-1.

If you are using a standard closed-loop nozzle, verify that there is an O-ring in the nozzle before installing it.

Figure 6-1 Closed-loop nozzle installed in flow cell

4 Connect the air and fluid lines to the stainless steel ethanol (ETOH) shutdown tank. See Figure 6-2 on page 205.

   a Disconnect the air line from the sheath tank and connect it to the air port on the ETOH shutdown tank.

   b Disconnect the fluid line from the bottom side of the sheath filter and connect it to the ethanol filter on the ETOH shutdown tank. See Figure 6-2 on page 205.

   Keep the sheath filter attached to the sheath tank. Do not run ethanol through the sheath filter.

   c Click Done.
The system starts the cleaning process, and then displays a message at the bottom of the dialog.

Figure 6-2 Connecting air and fluid lines for shutdown procedure

When prompted, install a tube containing 3 mL of sterile, filtered DI water on the loading port, then click Done.

The cytometer loads the tube and continues the cleaning process. A progress message appears, and then displays Done when the process is complete.

Click OK when you see a message informing you that the system can be turned off.

Vent the air pressure from the sheath tank by pulling up on the ring on the pressure relief valve.
8 Turn off the cytometer main power.
9 Exit BD FACSDiva software and shut down the computer.

External Cleaning

To keep the system free from salt buildup, wipe down all cytometer surfaces that have been exposed to sheath fluid. Clean surfaces with a cloth dampened with a 10% bleach solution, followed by DI water.

⚠️⚠️ All cytometer surfaces that come in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when cleaning cytometer surfaces. Wear suitable protective clothing and gloves.

⚠️⚠️ To prevent shock, turn off the plate voltage before cleaning on or around the deflection plates. To prevent arcing (sparking), make sure the plates are completely dry before you turn the plate voltage back on.

The following surfaces should be inspected and cleaned when necessary:

- Inside the sort chamber
- Deflection plates
- Sample loading port
- Collection devices
Scheduled Maintenance

For optimal cytometer functioning, perform the following procedures according to the recommended maintenance schedule.

**Table 6-1** Scheduled Maintenance

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Recommended Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Cleaning on this page</td>
<td>See Table 6-2 on page 208</td>
</tr>
<tr>
<td>Purging the Fluid Filters on page 213</td>
<td>Weekly</td>
</tr>
<tr>
<td>Purging the Sheath Filter on page 214</td>
<td>Weekly</td>
</tr>
<tr>
<td>Changing the disposable waste cap (see Emptying the Waste Container on page 133)</td>
<td>Monthly</td>
</tr>
<tr>
<td>Changing the Fluid Filters on page 215</td>
<td>Every 6 months</td>
</tr>
<tr>
<td>Changing the Sheath Filter on page 216</td>
<td>Every 3 months</td>
</tr>
<tr>
<td>Changing the Ethanol Shutdown Filter on page 217</td>
<td>Every 6 months</td>
</tr>
<tr>
<td>Changing the Sample Lines on page 218</td>
<td>Every 4–6 months, or as needed</td>
</tr>
<tr>
<td>Changing the Air Filters on page 225</td>
<td>Every 6–12 months, depending on cytometer use and the quality of the air</td>
</tr>
<tr>
<td>Changing the Sheath Tank Air Filter on page 225</td>
<td>Every 6 months</td>
</tr>
<tr>
<td>Checking the Fluidics Cart Drip Tray on page 226</td>
<td>Weekly</td>
</tr>
</tbody>
</table>
Internal Cleaning

BD FACSDiva software includes four pre-programmed cleaning modes that can be used alone, or in combination to provide the required level of cleaning. The following sections describe the different cleaning modes. See Table 6-2 on page 208 for an overview of each mode.

Table 6-2 Cytometer cleaning modes

<table>
<thead>
<tr>
<th>Cleaning Mode</th>
<th>Summary</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Line Backflush on page 208</td>
<td>Flushes the sample line with sheath fluid.</td>
<td>After running samples with adherent cells or dye.</td>
</tr>
<tr>
<td>Cleaning the Flow Cell on page 202</td>
<td>Cleans the sample path and the flow cell with DI water.</td>
<td>When indicated by distorted scatter or high CVs, or as a daily shutdown procedure.</td>
</tr>
<tr>
<td>Prime After Tank Refill on page 209</td>
<td>Primes the fluid lines for the designated fluid(s).</td>
<td>When a fluidics line is unplugged to refill a tank.</td>
</tr>
<tr>
<td>Prepare for Aseptic Sort on page 211</td>
<td>Decontaminates the complete sheath path and sample path with bleach, DI water, and ethanol.</td>
<td>When needed before aseptic sorting.</td>
</tr>
</tbody>
</table>

Sample Line Backflush

After a sample tube is unloaded, the sample line tubing within the sample injection chamber is automatically flushed inside and out with sheath fluid to eliminate potential sample carryover. Use the Sample Line Backflush command to perform additional backflushing of the inside of the sample line after a tube is unloaded. Perform the sample line backflush when you observe sample carryover or after running samples with adherent cells or dye.

NOTE Keep the stream running while performing the backflush.

1 Select Cytometer > Cleaning Modes > Sample Line Backflush.

2 Click Start to start the backflush.
3  Click **Stop** to stop the backflush, or click **Cancel** to stop the backflush and close the dialog.

   The backflush does not stop automatically.

**Prime After Tank Refill**

Use the Prime After Tank Refill command to prime the fluid lines if a 5-L plastic fluidics container was disconnected for refilling.

1  Turn off the stream.

2  Select **Cytometer > Cleaning Modes > Prime After Tank Refill**.

3  Select the checkboxes for the tanks that were refilled, then click **OK**.

   The cytometer proceeds with priming the specified tanks. A progress dialog opens while the tanks are being primed.

4  Click **OK** when the tank prime is complete.

**Removing the Sheath Probe**

The sheath probe must be removed from the sheath tank before autoclaving the tank in preparation for performing the aseptic sort procedure.

**NOTE**  Do not autoclave the sheath probe. It is not designed to withstand the conditions of autoclaving.

Make sure to follow the steps below in sequence, so the containment device works properly.

1  Disconnect the air line from the sheath tank.

2  Vent the air pressure from the sheath tank by pulling up on the pressure relief valve. Verify that all of the pressure is released by pulling up a second time.
3 Loosen the nut at the top of the probe with an 11/16-inch wrench (provided in accessory kit). See Figure 6-3.

Figure 6-3 Sheath probe containment device

4 Loosen the thumbscrew on the containment device.

5 Pull the top section of the containment device straight up and out of the bottom section. See Figure 6-4.

Figure 6-4 Removing sheath probe

6 Finish loosening the 11/16-inch nut at the top of the probe and pull the probe straight up and out of the sheath tank.

7 Decontaminate the sheath probe using 70% ethanol. See Figure 6-5.
Prepare for Aseptic Sort

Use the Prepare for Aseptic Sort command when you want to decontaminate the entire sheath path. This procedure cleans the system with bleach, DI water, and ethanol.

Perform the following steps before starting the Prepare for Aseptic Sort command:

1. Verify that the pressure has been vented from the sheath tank and the sheath probe has been removed. See the preceding section.
2. Disconnect the fluid and air lines from the sheath tank.
3. Empty the sheath tank and rinse it with DI water.
4. Autoclave the sheath tank at 125°C and 15 psig for 30 minutes with a 7.5-minute warmup and shutdown cycle.
5. Fill the sterilized sheath tank with sterile sheath fluid.
6. Obtain a new sheath filter to replace the old filter when instructed to do so in the wizard. See Changing the Sheath Filter on page 216.
7. Install the decontaminated sheath probe into the sheath tank and tighten the nut securely with an 11/16-inch wrench.
8. Install the top section of the containment device into the bottom section, and then tighten the thumbscrew.
9. Sterilize the DI water sensor by soaking in a 10% bleach solution for 10 minutes.
10 Fill the DI water container with sterile DI water and 3 mL of bleach per liter of DI water, and then reinstall the sterilized DI water sensor.

To run the Prepare for Aseptic Sort command:

1 Select **Cytometer > Cleaning Modes > Prepare for Aseptic Sort**.

Follow the instructions on screen as you perform the procedure.

2 Install the integrated closed-loop nozzle in the flow cell and click **Done**.

If you are using a standard closed-loop nozzle, verify that there is an O-ring in the nozzle before installing it.

3 Remove the fluid line from the DI water port, connect the fluid line from the bleach container to the DI water port, then click **Done**. See Figure 6-6.

Do not disconnect the sensors from either container.

**Figure 6-6 Moving the bleach fluid line**

![Diagram of DI water line disconnected and bleach line connected to DI water port]

4 Disconnect the bleach fluid line from the DI water port, and connect it back to the bleach container port, then reconnect the fluid line to the DI water port, and click **Done**.
5 Disconnect the fluid line from the sheath tank (at the output side of the sheath filter) and connect it to the fluid out port on the side of the fluidics cart (see Figure 6-7). Click Done.

The system cleaning takes approximately 20 minutes.

Figure 6-7 Moving the sheath fluid line

6 Disconnect the fluid line from the fluid out port on the side of the fluidics cart and connect it to a new 0.2-µm sheath filter. See Changing the Sheath Filter on page 216.

7 Remove the old sheath filter and connect the new 0.2-µm sheath filter to the liquid port of the sterilized sheath tank.

8 To complete the process, select one of the two options.
   • To continue running samples, perform fluidics startup.
   • To turn off the system, perform the flow cell cleaning procedure.
Purging the Fluid Filters

Once a week, purge air from the fluid filters for the 5-L plastic containers by opening the bleeder valve on the top of each filter. This ensures that the filters will not dry out.

1. Open the bleeder valve a small amount and leave it open until fluid seeps out through the valve (see Figure 6-8 on page 215).

2. Close the valve.

3. Wipe up any excess fluid that might have dripped onto the fluidics cart.

Purging the Sheath Filter

Once a week, purge air from the sheath filter by opening the bleeder valve on the top of the filter. The sheath tank is pressurized, so do this task carefully to avoid spraying sheath fluid on any equipment.

1. Place a small container under the bleeder valve to catch any fluid.

2. Slowly open the bleeder valve a small amount and leave it open until fluid seeps out through the valve (see Figure 6-9 on page 216).

3. Close the valve.

4. Wipe up any excess fluid that might have dripped onto the fluidics cart.
Changing the Fluid Filters

We recommend changing the fluid filters every six months. Spare filters are included with the accessory kit.

**Figure 6-8** Fluid filters

1. Remove the filter by pressing the tabs on each quick-disconnect coupling. (See Figure 6-8.)

2. Install the new filter and connect the quick-disconnect couplings.

3. Write the current date on the new filter so you will know when to replace it.

4. Open the bleeder valve on top of the filter a small amount and leave it open until fluid seeps out through the valve.

5. Close the valve.

6. Wipe up any excess fluid that might have dripped onto the fluidics cart.
Changing the Sheath Filter

We recommend changing the sheath filter every three months, or when increased debris in an FSC vs SSC plot indicates that the sheath filter needs to be replaced. Spare filters are included with the accessory kit.

**NOTE** The sheath filter is the same as the one used for the ethanol shutdown filter. The filters can be used for either purpose.

1. Turn off the stream.
2. Remove the filter by pressing the tabs on each quick-disconnect coupling. (See Figure 6-9.)

   **Figure 6-9** Sheath filter
   
   Direction of flow

3. Unscrew the nuts at each end of the filter to remove the connecting tubing.
4. Locate a new filter and wrap the threads at each end with Teflon tape.
5. Observe the direction of flow on the filter and replace it in the same orientation.
   a. Screw the nuts with connecting tubing onto each end of the filter and tighten finger-tight.
   b. Tighten each nut 1 to 2 additional turns with a wrench.
   c. Check for leaks once the pressure is turned on.
   d. Write the current date on the filter so you will know when to replace it.
6. Open the bleeder valve on top of the filter a small amount and leave it open until fluid seeps out through the valve.
Close the valve.

### Changing the Ethanol Shutdown Filter

We recommend changing the ethanol shutdown filter every six months. Spare filters are included with the accessory kit.

**NOTE** The ethanol shutdown filter is the same as the one used for the sheath filter. The filters can be used for either purpose.

1. Remove the filter by pressing the tabs on each quick-disconnect coupling. (See Figure 6-10.)

   ![Ethanol filter](image)

   **Figure 6-10** Ethanol filter

   - Direction of flow

2. Unscrew the nuts at each end of the filter to remove the connecting tubing.

3. Locate a new filter and wrap the threads at each end with Teflon tape.

4. Observe the direction of flow on the filter and replace it in the same orientation.
   - a. Screw the nuts with connecting tubing onto each end of the filter and tighten finger-tight.
   - b. Tighten each nut 1 to 2 additional turns with a wrench.
   - c. Check for leaks once the pressure is turned on.
   - d. Write the current date on the filter so you will know when to replace it.

5. Open the bleeder valve on top of the filter a small amount and leave it open until fluid seeps out through the valve.
Close the valve.

Changing the Sample Lines

The primary sample line between the sample injection chamber and the pinch valve should be changed every 4–6 months or when decreased event rates indicate that the sample line might be clogged. The secondary sample line between the pinch valve and the cuvette flow cell needs changing only when it is kinked or clogged.

Figure 6-11 Primary and secondary sample lines

To withstand the high pressures generated by the BD FACS Aria III flow cytometer, the sample lines are attached using a two-piece compression fitting, where a cone-shaped ferrule is compressed onto the tubing as the connecting nut is tightened.

To replace the tubing, you will need a 12-inch length of replacement tubing for the primary sample line, or a 7-inch length for the secondary line. Replacement tubing is supplied in the accessory kit. The ferrules and connecting nuts can be reused when the tubing is replaced.

All biological specimens and materials coming into contact with them can transmit potentially fatal disease. Handle used tubing and fittings as if capable of transmitting infection. Wear suitable protective clothing and gloves.
Changing the Primary Sample Line

To replace the primary sample line, you will need a 12-inch length of replacement tubing from the accessory kit. There is a different fitting at each end of the tubing, so the procedure is divided into two sections.

Assembling the Collet Fitting at the Pinch Valve

At the pinch valve end of the primary sample line, a collet fitting joins the sample line to the pinch tubing.

To replace the tubing:

1. Turn the stream off (if needed). Make sure the loading port is in the unload position.

2. Unscrew the nut from the collet fitting and pull the nut and collet apart.

3. Pull the pinch tubing out of the nut, and then pull the sample line out of the pinch tubing. See Figure 6-12.

4. Locate a new 12-inch piece of sample line tubing.
   a. Slide the collet over the pinch valve tubing, then slide the nut over the new sample line tubing.

Figure 6-12  Collet nut fitting on pinch valve tubing
b Slide the pinch valve tubing over one end of the sample line tubing until approximately 6 mm of the sample line is inside the pinch valve tubing.

c Slide the pinch valve tubing on the inside of the teeth of the nut until it stops.

d Couple both pieces of the fitting together and then tighten until finger-tight.

Primary Sample Line – Sample Injection End

At the sample injection end of the primary sample line, a compression fitting secures the sample line at the top of the sample injection chamber.

Figure 6-13  Primary sample line insertion

1 Turn the stream off (if needed). Make sure the loading port is in the unload position.

2 If there is a sample line filter installed, remove it by pulling it off of the sample line.

   To gain access to the filter, see Installing or Removing a Sample Line Filter on page 235.
3 Unscrew the connecting nut at the top of the sample injection chamber and slowly pull out the sample line. (See Figure 6-11 on page 218.)

4 Ensure that a cone-shaped ferrule is attached to the sample line.

Figure 6-13 shows an example of a ferrule. If the ferrule was left behind in the injection chamber fitting, gently push the tip of the ferrule-removal tool (included in the accessory kit) into the top of the ferrule and pull the ferrule straight out. See Figure 6-14.

After using the tool, you might need to replace the ferrule. If the ferrule is damaged, replace it with a spare (included in the accessory kit).

Figure 6-14 Ferrule tool

5 Slide the ferrule and nut off the end of the sample line.

6 Slide the nut and then the ferrule onto the end of the new sample tubing.

Leave approximately 5 inches (12.7 cm) of tubing extending out of the sample injection chamber end. (This length can be adjusted depending on the depth of your sample tube.) This length is referred to as the pilot, as shown in Figure 6-15.

Figure 6-15 Components of a compression fitting
7 Insert the pilot tubing into its fitting, ensuring that the tubing reaches the intended pilot depth.

⚠️ Do not bend the primary sample line during insertion.

Insert the sample line into the sample injection chamber fitting. Push the tubing from the top until it is slightly above the bottom of the chamber viewing window. Finger-tighten the nut on top of the chamber so the sample line is secure.

⚠️ Do not overtighten the nut and do not use tools. Over-tightening the nut can kink or damage the tubing.

8 Check the fitting connections at both ends to make sure they are not leaking.

Turn on the stream, load a tube of DI water, and make sure none of the fittings are leaking. If needed, unload the tube, turn off the stream, and tighten the fittings. After tightening, if leaking still occurs, replace the ferrule.

⚠️ Make sure all fittings are securely tightened. If any fitting is loose, the tubing could detach during high-pressure operation, exposing the operator to potentially biohazardous sample spray.

9 Verify the length of the sample line.

The sample line should not bow or bend when a tube is loaded. If you need to adjust the length, unscrew the nut on top of the sample injection chamber, adjust the length, and tighten the nut again.
Changing the Secondary Sample Line

This section describes changing the secondary sample line (see Figure 6-11 on page 218). There is a different fitting at each end of the tubing, so the procedure is divided into two sections.

Pinch Valve End

The procedure to replace the secondary sample line at the pinch valve end is the same as for the primary sample line, except the replacement line is a 7-inch length. See Assembling the Collet Fitting at the Pinch Valve on page 219.

Flow Cell End

1. Turn the stream off (if needed).

2. Unscrew the connecting nut at the top of the flow cell and slowly pull out the sample line. (See Figure 6-16.)

3. Ensure that a cone-shaped ferrule is attached to the sample line.

If the ferrule was left behind in the flow cell fitting, gently push the tip of the ferrule-removal tool (included in the accessory kit) into the top of the ferrule and pull the ferrule straight out.
After using the tool, you might need to replace the ferrule. If the ferrule is damaged, replace it with a spare (included in the accessory kit).

4 Slide the ferrule and nut off the end of the sample line.

5 Slide the nut and then the ferrule onto the end of the new sample tubing.

Leave approximately 0.1 inch (0.25 cm) of tubing extending out of the ferrule. This length is referred to as the pilot, as shown in Figure 6-15 on page 221.

6 Insert the pilot tubing into its fitting at the top of the flow cell, ensuring that the tubing reaches the intended pilot depth.

⚠️ Within the cuvette flow cell fitting, make sure the pilot is seated flush against the pilot depth. Dead volume between the pilot and the pilot depth can lead to sample carryover or leaking.

7 Finger-tighten the nut at the top of the flow cell to secure the sample line.

⚠️ Do not overtighten the nut and do not use tools. Over-tightening the nut can kink or damage the tubing.

8 Check the fitting connections at both ends to make sure they are not leaking.

Turn on the stream, load a tube of DI water, and make sure none of the fittings are leaking. If needed, unload the tube, turn off the stream, and tighten the fittings. After tightening, if leaking still occurs, replace the ferrule.

⚠️⚠️ Make sure all fittings are securely tightened. If any fitting is loose, the tubing could detach during high-pressure operation, exposing the operator to potentially biohazardous sample spray.
Changing the Air Filters

The BD FACSARia III cytometer has two air filters: one in the sort collection chamber door and one in the side door.

- To change the filter in the sort collection chamber door, slide out the old filter and slide in the new filter. See Replacing the Air Filter on page 315 for more information.

- To change the air filter in the side door (Figure 6-17), loosen the screws at the top corners of the filter and remove the old filter. Install a new filter and tighten the screws to hold the filter in place. Replace the filter once or twice a year, depending on the quality of the air in the laboratory.

![Figure 6-17 Changing the air filter](image)

Changing the Sheath Tank Air Filter

Check the inline air filter on the sheath tank air line periodically for any signs of debris or discoloration. Replace with a new air filter from the accessory kit every six months, or sooner if needed.
1. Turn off the cytometer.
2. Pull the tubing off each end of the air filter.
3. Install a new filter with the directional arrow pointing toward the sheath tank.

**Checking the Fluidics Cart Drip Tray**

Check the drip tray on the fluidics cart weekly for signs of excess liquid and empty the tray if needed.
Unscheduled Maintenance

There are several cytometer components that should be cleaned periodically or checked for wear and replaced if necessary. See the indicated sections for the following maintenance procedures.

Table 6-3 Unscheduled maintenance

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Recommended Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing the Integrated Nozzle on page 228</td>
<td>As needed for different sized particles</td>
</tr>
<tr>
<td>Cleaning the Integrated Nozzle on page 229</td>
<td>When stream irregularities indicate that the nozzle is clogged</td>
</tr>
<tr>
<td>Temporary Replacement of a Seal on page 232</td>
<td>As needed when seal is lost or damaged in an integrated nozzle</td>
</tr>
<tr>
<td>Closed-Loop Nozzle Maintenance on page 232</td>
<td>As needed</td>
</tr>
<tr>
<td>Installing or Removing a Sample Line Filter on page 235</td>
<td>When the sample line filter needs to be installed or changed</td>
</tr>
<tr>
<td>Changing the Pinch Valve Tubing on page 237</td>
<td>As needed</td>
</tr>
<tr>
<td>Cleaning the Camera Windows on page 239</td>
<td>When smudges appear in the Breakoff or Side Stream windows</td>
</tr>
<tr>
<td>Removing the Deflection Plates on page 242</td>
<td>As needed to clean the deflection plates</td>
</tr>
<tr>
<td>Lubricating the Sample Injection Chamber O-Ring on page 243</td>
<td>As needed when the O-ring is dry</td>
</tr>
<tr>
<td>Using Custom Optical Filters on page 244</td>
<td>As needed</td>
</tr>
<tr>
<td>Cleaning the Optical Filters on page 245</td>
<td>As needed when changing a filter</td>
</tr>
<tr>
<td>Removing or Installing the FSC ND Filter on page 246</td>
<td>As needed</td>
</tr>
</tbody>
</table>
Changing the Integrated Nozzle

Three sizes of nozzles are provided with your cytometer: 70, 85, and 100 µm. A 130-µm nozzle can be ordered as an option. The size is marked on the nozzle. The closed-loop nozzle used for cleaning and shutdown procedures is also changed with this procedure.

⚠️ Any cytometer surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing and gloves.

1. Turn off the stream and open the flow cell access door.

2. Turn the nozzle-locking lever counterclockwise to the 6:00 position, and pull the nozzle out of the cuvette flow cell (Figure 6-19).

⚠️ Caution: Do not open the sort block door while the nozzle locking lever is in the 6:00 position. The flow cell can be damaged by the top of the door during opening. Always turn the lever clockwise back to the 12:00 position before opening the sort block door.

3. Insert the new nozzle into the flow cell (with the top side facing up) and push it gently all the way forward until it stops.

4. Turn the nozzle-locking lever clockwise to the 12:00 position.
5 Turn on the stream and make sure it flows smoothly from the nozzle into the center of the waste aspirator.

If the stream is flowing but the breakoff is too long or the gap is unsteady, this could indicate that there are bubbles in the flow cell. If these conditions occur, turn off the stream, wait for 10 seconds, and turn on the stream again.

If you see any dripping or spraying, or the stream image appears abnormal, turn off the stream and see Troubleshooting the Stream on page 250.

NOTE After changing the nozzle, you might need to adjust the angle of the sort block to re-center the stream in the aspirator. To do so, loosen the adjustment screws on both sides of the deflection plates and rotate the sort block (see Figure 1-11 on page 31). Tighten the screws when the stream is centered in the aspirator. For further assistance, see Troubleshooting the Stream on page 250.

Cleaning the Integrated Nozzle

Use the following procedure to clean the nozzle when the stream appears blocked or distorted. To verify that the nozzle is clogged, examine the opening at the center of the seal area under a microscope. Figure 6-20 shows an example of an unclogged nozzle tip.

Figure 6-20 Magnified view of an integrated nozzle tip

⚠️ All biological specimens and materials coming into contact with them can transmit potentially fatal disease. Handle nozzles as if capable of transmitting infection. Wear suitable protective clothing and gloves.
To clean the integrated nozzle:

1. Remove the nozzle from the flow cell by turning the nozzle-locking lever counterclockwise to the 6:00 position, then pull the nozzle straight out.

2. Sonicate the nozzle for approximately 1 minute in a test tube containing DI water. Repeat the sonication until the nozzle is clean.

⚠️ Do not use bleach, Contrad®, or any strong detergents to clean the nozzle. See Table 6-1 on page 207.

3. Allow the nozzle to air dry for a few minutes. Do not wipe the nozzle with anything, because it could leave fibers or other contamination.

4. Insert the nozzle into the flow cell with top side facing up and push it gently forward until it stops.

5. Turn the nozzle-locking lever clockwise to the 12:00 position.

6. Turn on the stream and make sure it flows through the nozzle properly.
Note that after re-installing the nozzle, you might need to change the angle of the sort block to re-center the stream in the aspirator. To do so, loosen the adjustment screws on both sides of the deflection plates and rotate the sort block (see Figure 1-11 on page 31). Tighten the screws when the stream is centered in the aspirator. For further assistance, see Troubleshooting the Stream on page 250.

## Handling the Integrated Nozzle

In addition to following proper cleaning instructions, follow these precautions when handling the integrated nozzles.

<table>
<thead>
<tr>
<th>Precaution</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always use the integrated closed-loop nozzle for cleaning and shutdown procedures.</td>
<td>Keeps the flow cell clean and reduces the chances for clogs. A clean flow cell provides improved sensitivity and higher performance.</td>
</tr>
<tr>
<td>Do not expose integrated nozzles for long periods of time to bleach or detergents. However, you can prepare for the aseptic sort procedure without causing any problems to the O-ring in the integrated nozzle.</td>
<td>Prevents the seal from coming loose and falling out.</td>
</tr>
<tr>
<td>Do not expose integrated nozzles to strong base solutions such as Contrad 70.</td>
<td>Prevents the seal from coming loose and falling out. Any contact with such solutions might damage the seal.</td>
</tr>
<tr>
<td>Do not wipe the surface of the seal with anything.</td>
<td>Prevents damage to the seal that could result in leaking.</td>
</tr>
</tbody>
</table>
Temporary Replacement of a Seal

The standard O-ring can be used as a short-term replacement in the integrated nozzle, if the original seal has been lost or damaged, but a new integrated nozzle will provide better long-term usability. See Accessory Kit on page 280 for part numbers for ordering integrated nozzles.

Standard O-rings (part number 333084) are supplied in the accessory kit. The following procedure describes how to install a standard O-ring in an integrated nozzle.

1. Make sure the groove in the nozzle is clean.

   If the any part of the seal is still in the nozzle groove, sonicate the nozzle in a bleach solution until the seal comes out. Rinse the nozzle in DI water after sonicating.

2. Use the wooden end of a cotton swab, or similar tool, to install the O-ring in the nozzle groove, then allow the nozzle to air dry for a few minutes.

   Do not wipe the nozzle with anything, because it could leave fibers or other contamination, or dislodge the O-ring.

3. Use the magnifier in the accessory kit, or a microscope, to inspect the nozzle to verify that the O-ring is installed all the way into the groove.

Closed-Loop Nozzle Maintenance

The closed-loop nozzle and related tubing should be cleaned if there are any indications of clogging or kinked tubing.
Cleaning the Integrated Closed-Loop Nozzle

1. Turn off the stream and open the flow cell access door.

2. Remove the closed-loop nozzle from the cuvette flow cell.
   - Turn the nozzle-locking lever counterclockwise to the 6:00 position.
   - Remove the nozzle by pulling it straight out. See Figure 6-21.

   **Figure 6-21** Closed-loop nozzle

3. Unscrew the nut on the side of the nozzle to remove the tubing.
   - Make sure that the ferrule stays on the tubing as you remove it.

4. Sonicate the nozzle for approximately 1 minute.
   - Sonicate the nozzle in a test tube containing DI water or a mild detergent.
   - Repeat the sonication as needed until the nozzle is clean.

5. Make sure that the ferrule is on the tubing, then screw the nut back into the hole in the side of the closed-loop nozzle. See Figure 6-22.
Replacing the Tubing on the Closed-Loop Nozzle

To replace the tubing on the closed-loop nozzle, use this procedure. Use a 7-inch length of sample tubing from the accessory kit as the replacement.

Figure 6-22  Replacing tubing from closed-loop nozzle

To replace the tubing:

1. Unscrew the nut from the closed-loop nozzle and from the union fitting and pull out the tubing from both places.

   Make sure that the ferrule comes out on the tubing on both ends. If not, use the ferrule tool to remove it. See Figure 6-14 on page 221.

2. Slide the nut and ferrule off each end of the tubing.

3. Slide the nut and ferrule onto the new tubing as shown in Figure 6-22.

   Insert the tubing into the closed-loop nozzle and slowly tighten the nut until secure. Do not over-tighten. Make sure that the tubing is pushed all the way in while tightening the nut.

4. Insert the tubing into the union fitting and slowly tighten the nut until secure. Do not over-tighten. Pull gently on the tubing to ensure that it is secure.
Installing or Removing a Sample Line Filter

Sample filters can be installed on the end of the sample line to filter out large particles from a sample. Pre-filtering the sample before beginning any sorting is recommended.

Two sizes of sample line filters are included in the accessories kit: 35 micron (green) and 50 micron (blue). The filters can be changed as often as required. The sample filters are not intended for use with the 1-mL microtubes.

NOTE When a sample filter is installed, the sample flow rate can be slowed down due to the effect of particles in the sample fluid clogging the filter.

1. With the stream turned on, select Change Sample Filter from the Cytometer menu.

2. A wizard opens with the instructions. See Figure 6-23.

   ![Sample line filter wizard](image)

3. Loosen the sample line fitting nut at the top of the injection chamber to allow the sample line to slide freely through the fitting. See Figure 6-24.
4 Push the sample line down so the end is below the bottom of the sample injection chamber.

5 Install the sample line filter by sliding it onto the end of the line, then click Done. See Figure 6-25.

Do not bend the sample line while installing the filter.

6 Pull the sample line up to operation height, slightly above the chamber viewing window.

7 Place a tube onto the loading port.
8 Click Done to raise the sample injection chamber.

⚠ Be careful of a pinching hazard as the sample injection chamber is raised.

The sample line should not bow or bend when a tube is loaded.

9 Adjust the sample line height if needed.

10 Tighten the sample line fitting and click Done.

The bulk injection chamber is lowered and the sample purge mode is turned on for about 5 seconds until several drips exit the filter. A message is displayed at the bottom of the wizard.

11 Click Done to complete the process.

Changing the Pinch Valve Tubing

The tubing that runs through the pinch valve should be changed as needed. The system ships with replacement tubing cut into 3-inch lengths, found in the accessory kit.

Figure 6-26 Pinch valve tubing

To replace the tubing:

1 Turn off the stream (if needed). Make sure the loading port is in the unload position.
2 Pull the existing pinch valve tubing out of the slot in the pinch valve.

Grasp the tubing with two fingers on each side of the pinch valve and pull it straight out from the slot. The tubing pops out of the slot with a small amount of pulling action. See Figure 6-27 on page 238.

**Figure 6-27 Tubing removed from pinch valve**

3 Unscrew the nut on the black collet fitting at each end of the tubing, and pull the pinch valve tubing out of both fittings.

Leave both pieces of the fitting on the sample line tubing.

4 Install a new 3-inch piece of pinch valve tubing. See Figure 6-28 on page 239.

   a Slip the collet over one end of the new pinch valve tubing.
   
   b Slide the pinch valve tubing over the sample line tubing until approximately 6 mm of the sample line is inside the pinch valve tubing.
   
   c Slide the pinch valve tubing on the inside of the teeth of the nut until it stops.
   
   d Couple both pieces of the fitting together and then tighten until finger-tight.
   
   e Repeat steps a through d at the other end of the tubing.
Check to see that both ends of the new pinch valve tubing are held securely in the compression fittings.

Figure 6-28  Collet nut fitting on pinch valve tubing

Install the new pinch valve tubing into the slot in the pinch valve.

Make sure that the tubing goes all the way into the back of the slot. The sample line can drip if the pinch tubing is not all the way into the slot in the pinch valve.

Cleaning the Camera Windows

Lower Camera Window

Clean the lower camera window and the diode laser window when you have trouble viewing the side streams or you cannot set the drop delay using Accudrop.

⚠️⚠️ A 12,000-volt potential exists between the deflection plates when they are on. Contact with the charged plates results in serious electrical shock. Do not touch the deflection plates when the plate voltage is on. The plates remain energized even when the sort block door is open.

To clean the lower camera window and the diode laser window:
1 Ensure that the deflection plates are turned off (warning light is not illuminated).

2 Turn off the stream.

3 Open the sort block door.

4 Wipe the windows with a soft, lint-free cloth soaked with DI water, and then dry the windows (see the following figure).

**Figure 6-29** Lower camera and diode laser windows
Upper Camera Window

Clean the strobe lens and upper camera window when smudges appear in the processed (digitized) image in the Breakoff window, or when dark spots appear to interfere with Sweet Spot monitoring. You might need to clean these components after a clog, or after sheath fluid has leaked or sprayed. Follow the steps in this section to clean the strobe lens and upper camera window.

⚠️⚠️ A 12,000-volt potential exists between the deflection plates when they are on. Contact with the charged plates results in serious electrical shock. Do not touch the deflection plates when the plate voltage is on. The plates remain energized even when the sort block door is open.

To clean the strobe lens and upper camera window:

1. Ensure that the deflection plates are turned off (warning light is not illuminated).
2. Turn off the stream.
3. Open the sort block door.
4. Place 1–2 drops of DI water or ethanol on a cotton swab.
5. Click the Breakoff window and select Raw Image.

Visible smudges are more apparent in the raw image view.

6. While viewing the image on the Breakoff window, insert the swab just below the bottom of the flow cell.

The strobe lens and upper camera windows are located behind two circular openings on either side of the top of the sort chamber. You will see the end of the swab in the Breakoff window when you intercept either opening.
7 Gently wipe the upper camera window, and then the strobe lens (opposite the window) to remove any saline.

8 Repeat with isopropyl alcohol or 70% ethanol until clean.

**Removing the Deflection Plates**

You can remove the deflection plates for cleaning by pulling the plates out using the deflection plate removal tool, supplied in the accessory kit.

*Figure 6-30* Deflection plate removal tool
1 Make sure that the deflection plates are turned off.

2 Open the sort block door.

3 Slide the deflection plate removal tool behind one of the plates and pull straight out from the sort block.

   Hold your thumb on the plate (or use your other hand) as you pull it out so it does not fall as you remove it.

Figure 6-31 Using the deflection plate removal tool

---

**Lubricating the Sample Injection Chamber O-Ring**

The O-ring at the bottom of the sample injection chamber should be lubricated as needed to maintain proper operation.

1 Verify that the loading port is in the down position, and open the hinged cover.

2 Check the O-ring (located at the opening in the bottom of the chamber) to see if it is dry.

3 If the O-ring is dry, it must be lubricated with O-ring lubricant from the accessory kit.

   a Remove the clear plastic tube holder from the tube holder base.
b Apply a small amount of O-ring lubricant to the O-ring inside the chamber and to the top, outside beveled edge of the tube holder base. This is where the base contacts the O-ring inside the sample injection chamber.

c Wipe off any excess lubricant.

d Replace the tube holder on the base.

Figure 6-32  Loading port with tube holder removed

Using Custom Optical Filters

If you want to install a custom filter or dichroic, the filter should comply with the following specifications.

Table 6-4  BD FACS®Aria III filter specifications

<table>
<thead>
<tr>
<th>Filter Characteristic</th>
<th>Dichroic LP Filters</th>
<th>BP Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diameter</td>
<td>0.622 ±0.003 in.</td>
<td>1.00 ±0.010 in.</td>
</tr>
<tr>
<td>Thickness</td>
<td>0.125 ±0.005 in.</td>
<td>0.12–0.35 in.</td>
</tr>
<tr>
<td>Minimum clear aperture</td>
<td>0.562 in.</td>
<td>0.85 in.</td>
</tr>
<tr>
<td>Incident angle</td>
<td>11 ±1°</td>
<td>0°</td>
</tr>
</tbody>
</table>
For the longpass filters, the surface that faces the center of the octagon or trigon should be coated directly on its surface, not between two or more pieces of glass. The coating should transmit >70% of the wavelength range you want the filter to transmit, with a minimum transmission of >50%, and it should reflect >90% of the wavelength range you want the filter to reflect.

The opposite surface (facing away from the center) should be coated with an anti-reflective coating with a minimum reflection of ≤1% of the wavelength range you want the filter to reflect.

Note that filters must be installed in front of each PMT to block unwanted laser light. For the dichroic, carefully assemble the glass filter in the holder using the retaining spring. Assemble the filter with the arrow pointing toward the center of the octagon or trigon. The angle of the dichroic is critical to achieving optimal results.

Note that any time you modify a detector array, you will need to create a new cytometer configuration to identify which PMT (identified by laser color and letter) will detect the emitted light. See Custom Configurations on page 93 for instructions.

**Cleaning the Optical Filters**

Optical filters should be inspected occasionally and cleaned as necessary. The frequency will depend on how often the filters are handled.

⚠️ When cleaning or replacing a filter, handle with care to avoid scratching the surface and to prevent the filter from falling out of the holder. Use cotton swabs, optical lens paper, and spectral-grade methanol or absolute ethanol in a dropper bottle (do not use acetone) to clean the optical filters.

1. Wrap a triangular section of the lens paper around the cotton end of a cotton swab. Moisten and seal the end with a few drops of alcohol.

2. Holding the cotton swab in a horizontal position, gently rub any spots on the filter surface and wipe clean.

3. Allow the solvent to evaporate and check the filter surface for streaks.
4 Inspect a ¼-inch–diameter section in the center of the filter for scratches.

Filters are coated with different dielectrics that can get scratched. If you see scratches, replace the filter.

5 Insert the cleaned filter into the octagon or trigon.

Make sure the filters are pushed all the way in.

Removing or Installing the FSC ND Filter

For applications involving large particles in which events appear off scale on the FSC axis with a voltage of zero, keep the FSC ND filter in place to decrease the FSC signal and keep the events on scale. For applications involving small particles (for example, bacteria or platelets), you might need to remove the FSC ND filter as follows.

1 Open the flow cell access door.

2 Locate and pull out the FSC ND filter (Figure 6-33 on page 246).

The filter is installed at the left end of the FSC detector block, just to the right of the flow cell. To remove the filter, loosen the set screw and pull the filter out of the slot.

Figure 6-33 Removing the FSC ND filter
To reinstall the filter, slide it into the slot with the filter side down and the label facing the flow cell.

**NOTE** You can remove the nozzle holder to get better access to the ND filter slot.
Troubleshooting

The tips in this chapter are designed to help you troubleshoot your experiments. Additional troubleshooting information can be found in the *BD FACSDiva Software Reference Manual*.

If additional assistance is required, contact your local BD Biosciences technical support representative. See Technical Assistance on page xv.

Troubleshooting suggestions in this chapter are grouped under the following headings:

- Troubleshooting the Stream on page 250
- Troubleshooting the Breakoff on page 255
- Sorting Troubleshooting on page 256
- Acquisition Troubleshooting on page 261
- Fluidics Troubleshooting on page 268
- Electronics Troubleshooting on page 270
# Troubleshooting the Stream

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stream not in center of aspirator</td>
<td>Difference in keyed stream position between nozzles</td>
<td>If you have just changed the nozzle, use an Allen wrench to loosen the screws on either side of the sort block. Adjust the angle of the sort block until the stream flows into the center of the waste aspirator, and then tighten the screws. See Figure 1-11 on page 31.</td>
</tr>
<tr>
<td>Nozzle inserted improperly</td>
<td></td>
<td>Turn off the stream. Remove the nozzle and ensure that the seal or O-ring is in place. Re-insert the nozzle and slide the nozzle in until it stops, then close the locking lever.</td>
</tr>
</tbody>
</table>
| Clogged or damaged nozzle    |                                                      | Turn off the stream, remove the nozzle, and examine the nozzle tip under a microscope.  
• If debris is visible, clean the nozzle. See Cleaning the Integrated Nozzle on page 229.  
• If the nozzle appears damaged, replace it. See Changing the Integrated Nozzle on page 228. |
| Performance check failed     | Incorrect filters                                    | You may have the incorrect filters on the 445 array or the 375/405 array.  
• Put the proper filters into the 445 array.  
• Swap the filters for the 580/20 array to run PE.  
For information about laser configurations, see Laser Options on page 287. |
### Troubleshooting the Stream (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No stream or dripping stream</td>
<td>Nozzle inserted improperly</td>
<td>Turn off the stream. Remove the nozzle. See Changing the Integrated Nozzle on page 228 for instructions.</td>
</tr>
<tr>
<td></td>
<td>Clogged or damaged nozzle</td>
<td>Turn off the stream, remove the nozzle, and examine the nozzle tip under a microscope.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If debris is visible, clean the nozzle. See Cleaning the Integrated Nozzle on page 229.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the nozzle appears damaged, replace it. See Changing the Integrated Nozzle on page 228.</td>
</tr>
<tr>
<td>Stream control disabled or no stream when stream control clicked</td>
<td>Air lock in fluidics filter</td>
<td>Prime the system with the corresponding fluid.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the control is still disabled, remove the filter, install bypass tubing, and repeat the priming procedure until you see fluid in the line.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When fluid is running through the line, remove the bypass tubing, install the filter, and repeat the priming procedure one last time.</td>
</tr>
<tr>
<td></td>
<td>Communication failure between workstation and cytometer</td>
<td>Exit the software and restart it.</td>
</tr>
</tbody>
</table>
## Troubleshooting the Stream (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No stream when Stream control clicked</td>
<td>Sheath tank low or empty</td>
<td>Refill the sheath tank. See Refilling the Sheath Tank on page 128.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note that when the empty tank warning message is not closed after 15 minutes, the stream shuts off automatically.</td>
</tr>
<tr>
<td></td>
<td>Air in sheath line</td>
<td>Prime the sheath tank. See Prime After Tank Refill on page 209.</td>
</tr>
<tr>
<td></td>
<td>Air in sheath filter</td>
<td>Purge the sheath filter. See Purging the Sheath Filter on page 214.</td>
</tr>
<tr>
<td></td>
<td>Dry filter</td>
<td>Open the bleeder valve to purge the filter. See Purging the Fluid Filters on page 213.</td>
</tr>
<tr>
<td>Fanning around center stream</td>
<td>Nozzle inserted improperly</td>
<td>Re-insert the nozzle. Push it gently all the way forward without rocking it from side to side.</td>
</tr>
<tr>
<td>Unstable stream</td>
<td>Debris in flow cell or nozzle</td>
<td>Remove the nozzle and run the stream with no nozzle in place for approximately 10 seconds. (Click the <strong>Stream</strong> control on, then off.) Sonicate the nozzle and re-install it.</td>
</tr>
<tr>
<td></td>
<td>Fluid line connected to ethanol shutdown tank</td>
<td>Move fluid and air lines to the sheath tank, then perform a fluidics startup. See Performing Fluidics Startup on page 120.</td>
</tr>
</tbody>
</table>
### Troubleshooting the Stream (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leaking or spraying around nozzle</td>
<td>Defective or damaged integrated nozzle seal</td>
<td>Replace the defective seal with a standard O-ring. See Temporary Replacement of a Seal on page 232.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Nozzle inserted improperly</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Turn off the stream. Remove the nozzle. See Changing the Integrated Nozzle on page 228 for instructions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Extra O-ring is blocking the nozzle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Remove the nozzle and use a cotton swab to clear out the cuvette.</td>
</tr>
<tr>
<td>Drop breakoff is too long</td>
<td>Bubbles in flow cell</td>
<td>Open the flow cell access door and check for bubbles in the flow cell. If they are visible, turn off the stream, wait a few seconds, and turn on the stream again.</td>
</tr>
<tr>
<td>Attenuation is on</td>
<td></td>
<td>Turn off attenuation.</td>
</tr>
<tr>
<td>Amplitude is too low</td>
<td></td>
<td>Increase the amplitude until you can see drops. If you need a very high amplitude (&gt;70 volts) to see drops, there might be air bubbles in the flow cell.</td>
</tr>
<tr>
<td>Nozzle inserted improperly</td>
<td></td>
<td>Turn off the stream. Remove the nozzle and ensure that the seal or O-ring is in place. Re-insert the nozzle and slide the nozzle in until it stops, then close the locking lever.</td>
</tr>
</tbody>
</table>
## Troubleshooting the Stream (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problems using Auto Delay feature</td>
<td>Stream is not stable</td>
<td>Make sure that the stream is stable before starting to run auto delay.</td>
</tr>
<tr>
<td></td>
<td>Diode laser does not fully intercept the sorting streams</td>
<td>Adjust the diode laser to intercept streams in the middle, producing the biggest and brightest spots in the left and center images.</td>
</tr>
<tr>
<td></td>
<td>Event rate is too low or too high</td>
<td>Adjust the flow rate to increase or decrease the event rate.</td>
</tr>
</tbody>
</table>
## Troubleshooting the Breakoff

Use the following examples to help troubleshoot problems with the breakoff image.

<table>
<thead>
<tr>
<th>Abnormal Stream Image</th>
<th>Normal stream image</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abnormal Stream Image</td>
<td>Normal stream image</td>
<td>Nozzle inserted improperly</td>
<td>Remove the nozzle and re-insert it.</td>
</tr>
<tr>
<td>Abnormal Stream Image</td>
<td>Normal stream image</td>
<td>Nozzle inserted improperly or orifice is off center</td>
<td>Remove the nozzle and re-insert it.</td>
</tr>
<tr>
<td>Abnormal Stream Image</td>
<td>Normal stream image</td>
<td>Partial clog</td>
<td>Remove the nozzle, clean it, and then re-insert it.</td>
</tr>
<tr>
<td>Abnormal Stream Image</td>
<td>Normal stream image</td>
<td>Wet or dirty strobe lens</td>
<td>Clean the lens as described in Cleaning the Camera Windows on page 239.</td>
</tr>
<tr>
<td>Abnormal Stream Image</td>
<td>Normal stream image</td>
<td>Attenuation is on at wrong pressure</td>
<td>Turn off attenuation in the Side Stream window.</td>
</tr>
</tbody>
</table>

*Chapter 7: Troubleshooting  255*
## Sorting Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unstable breakoff while Sweet Spot is engaged</td>
<td>Residual ethanol in system</td>
<td>Allow the system to run until the breakoff stabilizes.</td>
</tr>
<tr>
<td></td>
<td>Target Drop 1 value is out of range for drop spacing</td>
<td>Use an actual Drop 1 value for the target. Remember to repeat the drop delay setup each time the target value is changed.</td>
</tr>
<tr>
<td></td>
<td>Nozzle is clogged or inserted improperly</td>
<td>See Responding to a Nozzle Clog During a Sort with the AMO on page 308.</td>
</tr>
<tr>
<td></td>
<td>Dirty strobe lens or upper camera window</td>
<td>Clean the lens and the window as described in Cleaning the Camera Windows on page 239.</td>
</tr>
<tr>
<td></td>
<td>Air in sheath filter</td>
<td>Purge the sheath filter. See Purging the Sheath Filter on page 214.</td>
</tr>
<tr>
<td></td>
<td>Debris in flow cell or nozzle</td>
<td>Remove the nozzle and run the stream with no nozzle in place for approximately 10 seconds. (Click the Stream control on, and then off.) Sonicate the nozzle and re-install it.</td>
</tr>
<tr>
<td>Center stream image is dim or not visible in the Side Stream window</td>
<td>Camera window is dirty</td>
<td>Clean the lower camera window. See Cleaning the Camera Windows on page 239.</td>
</tr>
<tr>
<td></td>
<td>Stream is not intercepting the diode laser</td>
<td>Adjust the micrometer dial on the laser to make the stream intercept as bright as possible. See Figure 1-21 on page 42.</td>
</tr>
<tr>
<td>Center stream is off center when the plate voltage is turned on</td>
<td>Voltage center too low or too high</td>
<td>Adjust the Voltage Center slider to put the center stream back to center.</td>
</tr>
<tr>
<td></td>
<td>Saline spray on deflection plates or in sort block</td>
<td>Clean the deflection plates and the area around them.</td>
</tr>
</tbody>
</table>
## Sorting Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arcing between deflection plates</td>
<td>Salt bridge</td>
<td>Clean and dry the deflection plates and the area around and behind the plates.</td>
</tr>
<tr>
<td>ACDU sorting failure</td>
<td>Insufficient stream voltage</td>
<td>Increase the voltage for the far left stream.</td>
</tr>
<tr>
<td></td>
<td>Splash shield not installed</td>
<td>Install the splash shield. See Installing the Sorting Hardware on page 188.</td>
</tr>
<tr>
<td>Side stream position reversal, where the streams appear to be associated with the wrong voltage slider.</td>
<td>Voltage sliders are set too far in or too far out.</td>
<td>Move sliders in or out so they control the correct side streams.</td>
</tr>
</tbody>
</table>
## Sorting Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No deflection or insufficient deflection</td>
<td>Insufficient voltage</td>
<td>• Increase the side-stream voltages using the slider controls.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Increase the plate voltage.</td>
</tr>
<tr>
<td>Stream-charging wire is loose or missing</td>
<td>Verify that the stream-charging wire is inserted all the way into the barb.</td>
<td></td>
</tr>
<tr>
<td>Salt bridge</td>
<td>Turn off the stream. Remove the nozzle.</td>
<td>See Changing the Integrated Nozzle on page 228 for instructions.</td>
</tr>
<tr>
<td>Sorting paused because actual Drop 1 value is out of range</td>
<td>Wait until the Sweet Spot adjusts the amplitude to achieve the Drop 1 target. If this happens repeatedly during sorting, there might be debris in the nozzle or flow cell. See Troubleshooting the Stream on page 250 for suggestions.</td>
<td></td>
</tr>
<tr>
<td>Observation</td>
<td>Possible Causes</td>
<td>Recommended Solutions</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fanning around center or side streams</td>
<td>Nozzle inserted improperly</td>
<td>Turn off the stream. Remove the nozzle and ensure that the seal or O-ring is in place. Re-insert the nozzle and slide the nozzle in until it stops, then close the locking lever.</td>
</tr>
<tr>
<td>Sweet Spot is off</td>
<td></td>
<td>Turn on the Sweet Spot.</td>
</tr>
<tr>
<td>Incorrect sort precision mode</td>
<td></td>
<td>Verify that the sort precision mode is appropriate for your sorting requirements. See Sort Precision Modes on page 77.</td>
</tr>
<tr>
<td>2nd, 3rd, or 4th Drop values not optimized</td>
<td></td>
<td>Adjust the 2nd, 3rd, and 4th Drop settings to tighten the center stream and fine-tune the side streams.</td>
</tr>
<tr>
<td>Particles too big for nozzle</td>
<td></td>
<td>Change the nozzle. See Changing the Integrated Nozzle on page 228.</td>
</tr>
<tr>
<td>Sort button disabled</td>
<td>Current tube pointer not set to current tube</td>
<td>Click to move the current tube pointer to the appropriate tube.</td>
</tr>
<tr>
<td>Population not listed in Add menu on sort layout</td>
<td>Population defined using snap-to gate</td>
<td>Redefine the population using another gate type.</td>
</tr>
<tr>
<td>Viewing sort layout for another tube</td>
<td></td>
<td>Open or create a sort layout for the current acquisition tube.</td>
</tr>
<tr>
<td>Sort layout counters not updating</td>
<td>Viewing sort layout for another tube</td>
<td>Open or create a sort layout for the current acquisition tube.</td>
</tr>
<tr>
<td>High sort conflict rate</td>
<td>Event rate is too high for drop drive frequency</td>
<td>Decrease the event rate.</td>
</tr>
<tr>
<td></td>
<td>Gating conflict</td>
<td>Verify the gating hierarchy.</td>
</tr>
<tr>
<td></td>
<td>Purity mask is too high</td>
<td>Decrease the purity mask.</td>
</tr>
<tr>
<td>Observation</td>
<td>Possible Causes</td>
<td>Recommended Solutions</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>----------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Erratic sort rate</td>
<td>Flow rate is too high</td>
<td>Decrease the flow rate.</td>
</tr>
<tr>
<td>Unexpected sort results</td>
<td>Incorrect drop delay</td>
<td>Reset the drop delay. See Determining the Drop Delay – Automatic Method on page 177.</td>
</tr>
<tr>
<td>Incorrect sort precision mode</td>
<td>Verifying the sort precision mode is</td>
<td>appropriate for your sorting requirements. See Sort Precision Modes on page 77.</td>
</tr>
<tr>
<td>Sweet Spot is off</td>
<td>Keep the Sweet Spot on during sorting.</td>
<td></td>
</tr>
<tr>
<td>Drop 1 changed after setting drop delay</td>
<td>Reset the drop delay each time you</td>
<td>change the Drop 1 value. See Determining the Drop Delay – Automatic Method on page 177</td>
</tr>
<tr>
<td>Laser delay changed after setting drop delay</td>
<td>Reset the drop delay each time you</td>
<td>change the laser delay. See Determining the Drop Delay – Automatic Method on page 177</td>
</tr>
<tr>
<td>Incorrect logic in population hierarchy</td>
<td>Verify the gating strategy.</td>
<td></td>
</tr>
<tr>
<td>Sorting parent and child populations into two</td>
<td>If you try to sort a parent and its</td>
<td>different tubes, BD FACSDiva software ignores the child events in both tubes.</td>
</tr>
<tr>
<td></td>
<td>child population into two tubes,</td>
<td>Create a new subset under the parent population consisting of NOT (child). Sort the</td>
</tr>
<tr>
<td></td>
<td>BD FACSDiva software ignores the child</td>
<td>child population into one tube and the NOT (child) population into another tube.</td>
</tr>
<tr>
<td></td>
<td>events in both tubes.</td>
<td></td>
</tr>
</tbody>
</table>
## Acquisition Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No events in plots after clicking Load or Acquire Data</td>
<td>Current tube pointer is not set to current tube</td>
<td>Click to move the current tube pointer to the appropriate tube.</td>
</tr>
<tr>
<td></td>
<td>Laser shutter is engaged</td>
<td>Make sure the flow cell access door is completely closed.</td>
</tr>
<tr>
<td></td>
<td>Laser power is off</td>
<td>Turn on the laser power.</td>
</tr>
<tr>
<td>Viewing plots for a different tube</td>
<td></td>
<td>Double-click the current tube in the Browser to display the plots for that tube.</td>
</tr>
<tr>
<td>Incorrect population(s) in plot</td>
<td></td>
<td>Right-click the plot and select Show Populations. Verify that the appropriate populations are displayed.</td>
</tr>
<tr>
<td>Uncolored events in plot</td>
<td></td>
<td>• Format the plot to display all events.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Assign a color to the population displayed in the plot.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Verify the population drawing order.</td>
</tr>
<tr>
<td>Current cytometer configuration different from optical setup</td>
<td></td>
<td>Verify that the cytometer optics match the current cytometer configuration.</td>
</tr>
<tr>
<td>No sample in the tube</td>
<td></td>
<td>Add sample to the tube or install a new sample tube.</td>
</tr>
</tbody>
</table>
## Acquisition Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No events in plots after clicking Acquire Data (continued)</td>
<td>Sample is not mixed properly</td>
<td>Increase the sample agitation rate. See Sample Agitation on page 85.</td>
</tr>
<tr>
<td></td>
<td>Sample line is clogged</td>
<td>Perform a sample line backflush. See Sample Line Backflush on page 208. If necessary, change the sample line.</td>
</tr>
<tr>
<td></td>
<td>Sample filter is clogged</td>
<td>Replace the sample filter.</td>
</tr>
<tr>
<td></td>
<td>Threshold not set to the correct parameter (usually FSC)</td>
<td>Set the threshold to the correct parameter for your application.</td>
</tr>
<tr>
<td></td>
<td>Multiple threshold parameters not set correctly</td>
<td>Verify that the correct Boolean logic (And/Or) was used for the threshold parameters.</td>
</tr>
<tr>
<td></td>
<td>Threshold channel too low or too high</td>
<td>Adjust the threshold channel. See Calculating Compensation on page 152.</td>
</tr>
<tr>
<td></td>
<td>Optical filter(s) not completely seated</td>
<td>Make sure that the filters are pushed all the way in.</td>
</tr>
<tr>
<td></td>
<td>FSC area scaling is incorrect</td>
<td>Ensure that the FSC-A matches the FSC-H value.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No fluorescence signal</td>
<td>Current cytometer configuration different from optical setup</td>
<td>Verify that the cytometer optics match the current cytometer configuration.</td>
</tr>
<tr>
<td></td>
<td>Wrong filter installed or filter not completely seated</td>
<td>Make sure that the appropriate filter is installed for each fluorochrome. Make sure that the filters are pushed all the way in.</td>
</tr>
<tr>
<td></td>
<td>Laser delay is set incorrectly</td>
<td>Adjust the laser delay settings. See Manual Adjustment of Laser Delay on page 163.</td>
</tr>
</tbody>
</table>
## Acquisition Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low area signal</td>
<td>Area scaling is too low</td>
<td>Adjust area scaling for the corresponding laser. See Adjusting Area Scaling on page 142.</td>
</tr>
<tr>
<td>Unexpected events in plot</td>
<td>Incorrect logic in population hierarchy</td>
<td>Verify the gating strategy.</td>
</tr>
<tr>
<td></td>
<td>Incorrect population(s) in plot</td>
<td>Right-click the plot and select <strong>Show Populations</strong>. Verify that the appropriate populations are displayed.</td>
</tr>
<tr>
<td></td>
<td>Incorrect drawing order</td>
<td>Verify that the required population is not hidden by another population. Right-click the plot and select <strong>Order Populations by Count</strong>.</td>
</tr>
</tbody>
</table>
## Acquisition Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Erratic event rate</td>
<td>Sample aggregates</td>
<td>Filter the sample.</td>
</tr>
<tr>
<td></td>
<td>Bulk injection O-ring is worn</td>
<td>Contact your BD Biosciences service engineer.</td>
</tr>
<tr>
<td></td>
<td>Sample is contaminated</td>
<td>Re-stain the sample, making sure the tube is clean.</td>
</tr>
<tr>
<td></td>
<td>Sheath tank low</td>
<td>Fill the sheath container.</td>
</tr>
<tr>
<td>Unexpectedly high event rate</td>
<td>Threshold channel is too low</td>
<td>Adjust the threshold channel. See Calculating Compensation on page 152.</td>
</tr>
<tr>
<td></td>
<td>Sample is too concentrated</td>
<td>Dilute the sample.</td>
</tr>
<tr>
<td></td>
<td>Flow rate is too high</td>
<td>Decrease the flow rate in the Acquisition Dashboard.</td>
</tr>
<tr>
<td></td>
<td>Bubbles in flow cell</td>
<td>Turn off the stream, wait a few seconds, and turn on the stream again.</td>
</tr>
<tr>
<td>Unexpectedly low event rate</td>
<td>Sample not adequately mixed</td>
<td>Increase the sample agitation rate. See Sample Agitation on page 85.</td>
</tr>
<tr>
<td></td>
<td>Threshold channel is too high</td>
<td>Adjust the threshold channel. See Calculating Compensation on page 152.</td>
</tr>
<tr>
<td></td>
<td>Sample is too dilute</td>
<td>Concentrate the sample.</td>
</tr>
<tr>
<td></td>
<td>Sample line is clogged or kinked</td>
<td>Backflush the sample line. See Sample Line Backflush on page 208. If necessary, change the sample line.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Look for visible kinks in the line. If kinks are found, change the sample line. See Changing the Sample Lines on page 218.</td>
</tr>
</tbody>
</table>
### Acquisition Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unexpectedly low event rate (continued)</td>
<td>Sample line installed incorrectly</td>
<td>Verify the sample line installation. See Changing the Sample Lines on page 218.</td>
</tr>
<tr>
<td></td>
<td>Sample aggregates</td>
<td>Filter the sample.</td>
</tr>
<tr>
<td></td>
<td>Memory is full</td>
<td>Compare the processed event rate in BD FACSDiva software with the threshold counter. If the event rate is much lower, exit and then restart the application.</td>
</tr>
<tr>
<td>Distorted populations or high CVs</td>
<td>Cytometer settings adjusted incorrectly</td>
<td>Optimize the scatter parameters. See Calculating Compensation on page 152.</td>
</tr>
<tr>
<td></td>
<td>Flow rate is too high</td>
<td>Decrease the flow rate in the Acquisition Dashboard.</td>
</tr>
<tr>
<td></td>
<td>Window extension is too low</td>
<td>Increase the window extension.</td>
</tr>
<tr>
<td></td>
<td>Bubbles in flow cell</td>
<td>Turn off the stream, wait a few seconds, and turn on the stream again.</td>
</tr>
<tr>
<td></td>
<td>Nozzle is clogged or dirty</td>
<td>Clean the nozzle as described in Changing the Integrated Nozzle on page 228.</td>
</tr>
<tr>
<td></td>
<td>Flow cell is dirty</td>
<td>Clean the flow cell. See Cleaning the Flow Cell on page 202. Let DI water sit for 15 minutes before turning on the stream. Repeat as needed.</td>
</tr>
<tr>
<td></td>
<td>Poor sample preparation</td>
<td>Repeat sample preparation.</td>
</tr>
<tr>
<td></td>
<td>Area scaling is too low</td>
<td>Verify area scaling. See Adjusting Area Scaling on page 142.</td>
</tr>
</tbody>
</table>
### Acquisition Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excessive amount of debris in plots</td>
<td>Threshold channel is too low</td>
<td>Increase the threshold channel. See Calculating Compensation on page 152.</td>
</tr>
<tr>
<td></td>
<td>Dead cells or debris in sample</td>
<td>Examine the sample under a microscope.</td>
</tr>
<tr>
<td></td>
<td>Sample is contaminated</td>
<td>Re-stain the sample, making sure the tube is clean.</td>
</tr>
<tr>
<td>High electronic abort rate (&gt;10% of system event rate)</td>
<td>Window extension is too high</td>
<td>Decrease the window extension.</td>
</tr>
<tr>
<td></td>
<td>Threshold channel is too low</td>
<td>Increase the threshold channel.</td>
</tr>
<tr>
<td></td>
<td>Event rate is too high</td>
<td>Decrease the flow rate in the Acquisition Dashboard.</td>
</tr>
<tr>
<td></td>
<td>Sample is aggregated</td>
<td>Filter the sample.</td>
</tr>
<tr>
<td></td>
<td>Sample is too concentrated</td>
<td>Dilute the sample.</td>
</tr>
<tr>
<td>Fewer events than expected in gated population</td>
<td>Window extension set incorrectly</td>
<td>Adjust the window extension, if needed. See the <em>BD FACSStyle Software Reference Manual</em> for information.</td>
</tr>
<tr>
<td></td>
<td>Plot is zoomed</td>
<td>Unzoom the plot or make the gate bigger.</td>
</tr>
<tr>
<td></td>
<td>Events left out of the gate</td>
<td>When drawing a gate, make sure that events on the axis are included.</td>
</tr>
</tbody>
</table>
## Acquisition Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increasing threshold results in decreased area</td>
<td>Window extension is too low</td>
<td>Slightly increase the window extension to maximize the area signal.</td>
</tr>
<tr>
<td>signal</td>
<td></td>
<td>Increasing the window extension too much results in more electronic aborts or high CVs.</td>
</tr>
<tr>
<td>Area measurement off scale while the height</td>
<td>Area scaling is too high</td>
<td>Decrease area scaling to move the area measurement back on scale.</td>
</tr>
<tr>
<td>measurement is on scale</td>
<td></td>
<td>If necessary, adjust area scaling to make the area measurement match the height</td>
</tr>
<tr>
<td></td>
<td></td>
<td>measurement.</td>
</tr>
<tr>
<td>Cannot delete from Parameters, Threshold,</td>
<td>Row not selected</td>
<td>Select the row using the selection button.</td>
</tr>
<tr>
<td>Compensation, or Ratio tab views</td>
<td>Data already recorded</td>
<td>Create a new tube.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Fluidics Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No fluid in line during system prime</td>
<td>Air lock in sheath or fluidics filter</td>
<td>Remove the filter for the corresponding fluid, install bypass tubing, and run Prime After Tank Refill. Repeat the priming procedure until you see fluid in the line. When fluid is running through the line, remove the bypass tubing, install the filter, and repeat the priming procedure one last time.</td>
</tr>
<tr>
<td>Prepare for aseptic sort fails</td>
<td>Air lock in filter</td>
<td>Remove the filter for the corresponding fluid, install bypass tubing, and run Prime After Tank Refill. Repeat the priming procedure until you see fluid in the line. When fluid is running through the line, remove the bypass tubing, install the filter, and repeat the priming procedure one last time.</td>
</tr>
<tr>
<td>Fluid line is detached</td>
<td></td>
<td>Verify the fluid line connections on the fluidics cart and on the cytometer. Push firmly on each line to ensure that it is connected.</td>
</tr>
<tr>
<td>Fluidics cart air flow (&lt;80) PSI</td>
<td>Air leak</td>
<td>Contact your BD Biosciences service engineer.</td>
</tr>
<tr>
<td>Fluidics cart air flow (&gt;100) PSI</td>
<td>Regulator not adjusted properly</td>
<td>Contact your BD Biosciences service engineer.</td>
</tr>
</tbody>
</table>
## Fluidics Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fluid leak under fluidics cart or below side door</td>
<td>Condensation from pressure relief valve</td>
<td>This is a normal phenomenon that occurs when water is condensed from room air. Condensation is greater in humid environments. To avoid slipping, wipe up any water daily.</td>
</tr>
<tr>
<td>Bleeder valve is open</td>
<td>Check and close all bleeder valves for fluid and sheath filters.</td>
<td></td>
</tr>
<tr>
<td>Broken fluid line</td>
<td>Contact BD Biosciences.</td>
<td></td>
</tr>
<tr>
<td>Sample injection chamber does not close and causes a BISH or BISO error message</td>
<td>O-ring at bottom of sample injection chamber is dry and causing chamber to stick</td>
<td>Lubricate the O-ring and tube holder. See Lubricating the Sample Injection Chamber O-Ring on page 243.</td>
</tr>
</tbody>
</table>
## Electronics Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>“CytometerDisconnected” in Cytometer window</td>
<td>Cytometer power is off</td>
<td>Turn on the cytometer main power.</td>
</tr>
</tbody>
</table>
|                              | Communication failure between workstation and cytometer | • Exit the software and then restart it.  
• If restarting does not work, reset the cytometer electronics: switch off the main power, wait 10 seconds until the system is fully depressurized, and then switch the power back on.  
• Restart the computer and the cytometer. |
|                              | Ethernet cable between workstation and cytometer is disconnected | Unplug and then plug in the cable connectors and make sure they are secure.           |
|                              | IP address changed                       | Enter the correct IP address. Call BD Biosciences for assistance.                     |
| “Master DAQ Overflow” in Cytometer window | Event rate is too high                   | Decrease the event rate or verify the threshold.                                     |
|                              | Dirty flow cell                          | Clean the flow cell. See Cleaning the Flow Cell on page 202.                           |
| “Cytometer not responding” in Status tab | Unknown                                  | Perform the suggestions for a communication failure, above.                           |
Technical Specifications

- Cytometer Specifications on page 272
- Fluidics Cart Specifications on page 276
## Cytometer Specifications

**Table 8-1** Cytometer specifications

<table>
<thead>
<tr>
<th>Cytometer dimensions</th>
<th>Height: 71 cm (28 in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Width: 122 cm (48 in.)</td>
</tr>
<tr>
<td></td>
<td>Depth: 71 cm (28 in.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table (optional)</th>
<th>Height: 85.1 cm (33.5 in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Width: 266.7 cm (105 in.)</td>
</tr>
<tr>
<td></td>
<td>Depth: 134.6 cm (53 in.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Weight</th>
<th>Approximately 181.4 kg (400 lb)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power requirements</td>
<td>100/115/230 VAC and 50 or 60 Hz</td>
</tr>
<tr>
<td>Power consumption (maximum)</td>
<td>1,500 watts</td>
</tr>
</tbody>
</table>

## Environment

**Table 8-2** Required operating conditions

<table>
<thead>
<tr>
<th>Storage temperature</th>
<th>1–40°C (34–104°F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>15–30°C (59–86°F)</td>
</tr>
<tr>
<td>Operating relative humidity</td>
<td>5–80% (non-conducting)</td>
</tr>
<tr>
<td>Noise level</td>
<td>Less than or equal to 62 dBA</td>
</tr>
<tr>
<td>Facilities</td>
<td>No special room requirements</td>
</tr>
</tbody>
</table>
## Performance

### Table 8-3  Performance specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fluorescence resolution</td>
<td>Coefficient of variation PI–Area of &lt;3.0%, full G0/G1 peak for propidium iodide (PI)-stained chicken erythrocyte nuclei (CEN)</td>
</tr>
<tr>
<td></td>
<td>Coefficient of variation Hoechst–Area of &lt;3.5%, full G0/G1 peak for Hoechst-stained CEN</td>
</tr>
<tr>
<td>Fluorescence linearity</td>
<td>Doublet/singlets ratio for CEN stained with PI = 1.95–2.05 detected off the 488-nm laser or Hoechst = 1.95–2.05 detected off the 405-nm laser or 375-nm laser</td>
</tr>
<tr>
<td>Forward and side scatter sensitivity</td>
<td>Sensitivity enables separation of fixed platelets from noise, identification of bacteria, and 0.5-micron beads.</td>
</tr>
<tr>
<td>Sample acquisition rate</td>
<td>Maximum acquisition rate: 70,000 events per second with 8 parameters, 12 compensation pairs. Maximum rate &lt;70,000 events per second with more parameters, &gt;100,000 events per second with fewer parameters.</td>
</tr>
</tbody>
</table>
## Sort Performance

**Table 8-4** Sort performance specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop drive frequency</td>
<td>Range from 1 to 100,000 Hz</td>
</tr>
<tr>
<td>Purity and yield</td>
<td>At 70 PSI and 90 kHz with an average threshold rate of 25,000 events per second for a four-way sort, results in a purity of &gt;98% and a yield &gt;80% of Poisson’s expected yield.</td>
</tr>
<tr>
<td>Viability</td>
<td>Sorts were performed at a variety of sheath pressures using cell lines and human peripheral blood mononuclear cells. All sorts resulted in cells that proved viable and proliferated for several days post-sort.</td>
</tr>
<tr>
<td>Sort collection devices</td>
<td>Two-way sorting into the following sample tube collection devices: 12 x 75-mm tubes and 15-mL tubes. Four-way sorting into the following sample tube collection devices: microtubes, 12 x 75-mm tubes, and 1.5-mL Eppendorf tubes. Automatic Cell Deposition Unit (ACDU) option allows for slide and plate sorting into 6, 24, 48, 96, and 384-well plates.</td>
</tr>
<tr>
<td>Sample collection cooling</td>
<td>Water recirculator for refrigeration/heating (optional)</td>
</tr>
<tr>
<td>BD FACS Accudrop</td>
<td>660-nm red-diode laser provided for quick drop delay. Automatic drop determination in software</td>
</tr>
</tbody>
</table>
Optics Specifications

Complete specifications for laser options are available in Laser Options on page 287.

Laser Specifications

The following lasers are available on the cytometer.

Table 8-5 Laser specifications

<table>
<thead>
<tr>
<th>Wavelength (nm)</th>
<th>Shape</th>
<th>Powera</th>
</tr>
</thead>
<tbody>
<tr>
<td>375</td>
<td>Top hat</td>
<td>&gt;7 mW</td>
</tr>
<tr>
<td>405</td>
<td>Elliptical</td>
<td>&gt;50 mW</td>
</tr>
<tr>
<td>445</td>
<td>Elliptical</td>
<td>&gt;20 mW</td>
</tr>
<tr>
<td>488</td>
<td>Elliptical</td>
<td>&gt;20 mW</td>
</tr>
<tr>
<td>561</td>
<td>Elliptical</td>
<td>&gt;50 mW</td>
</tr>
<tr>
<td>633</td>
<td>Elliptical</td>
<td>&gt;18 mW</td>
</tr>
</tbody>
</table>

a. Measured out of the laser head

NOTE In addition to the excitation lasers, there is the additional BD Accudrop laser. It has a wavelength of 660 nm. See Setting Up for Sorting on page 168. See also Sorting on page 64.

The 488-nm and 633-nm lasers come standard. All other laser choices are optional. All lasers are solid state except the 633-nm laser, which is gas.

- Beam height: 9 ±3 nm
- Beam width: 65 ±7 nm
Emission Optics

Table 8-6 Emission optics specifications

<table>
<thead>
<tr>
<th>Optical coupling</th>
<th>Quartz cuvette flow cell is gel-coupled by refractive index-matching optical gel to the fluorescence objective lens for optimal collection efficiency. Numerical aperture is equal to 1.2.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forward scatter detector and filters</td>
<td>Photodiode detector with a 488/10 bandpass filter</td>
</tr>
<tr>
<td>Side scatter detector</td>
<td>Photomultiplier with a 488/10 bandpass filter</td>
</tr>
<tr>
<td>Fluorescence detectors and filters</td>
<td>Three fixed fiber apertures (200-micron separation)</td>
</tr>
</tbody>
</table>

Fluidics Cart Specifications

Table 8-7 Fluidics cart specifications

| Dimensions | Height: 66 cm (26 in.)  
|            | Width: 81cm (32 in.)  
|            | Depth: 66 cm (26 in.) |
| Weight     | 81.7 kg (180 lb) fluidics cart only, excluding tanks |
| Facilities | No air supply or vacuum required.  
|            | (Optional) Can be connected to facility air supply |
| Containers | • One 10-L stainless steel sheath tank  
|            | • One 5-L stainless steel ethanol shutdown tank  
|            | • One 10-L plastic waste container  
|            | • Three 5-L plastic fluid containers, for bleach, DI water, and ethanol |
Appendix A

Supplies and Consumables

This appendix provides a list of supplies and options that are available for the BD FACS Aria III cytometer.

- To order spare parts and consumables from BD Biosciences from within the US, call (877) 232-8995 or go to bdbiosciences.com.

  Outside the US, contact your local BD Biosciences representative.

- To order cytometer options, contact your sales representative.

This information is correct at the time of publication. For up-to-date information, see our website (bdbiosciences.com).

- Cytometer Supplies on page 278

- Consumables on page 284
# Optical Components

The following filters and mirrors are mounted on the BD FACSaria III cytometer. Use these part numbers if you need to order any replacement components. See Using Custom Optical Filters on page 244 for instructions.

<table>
<thead>
<tr>
<th>Detector Array (Laser)</th>
<th>PMT</th>
<th>LP Mirror BP Filter</th>
<th>Replacement Part No.</th>
<th>Intended Dye</th>
</tr>
</thead>
<tbody>
<tr>
<td>Octagon (488-nm blue laser)</td>
<td>A</td>
<td>735</td>
<td>343787</td>
<td>PE-Cy™7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>780/60</td>
<td>343788</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>655</td>
<td>343789</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>695/40</td>
<td>343790</td>
<td>PerCP-Cy5.5 or PI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>675/20</td>
<td>343791</td>
<td>PerCP</td>
</tr>
<tr>
<td>B</td>
<td>610</td>
<td>640879</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>616/23</td>
<td>640880</td>
<td></td>
<td>PE-Texas Red®</td>
</tr>
<tr>
<td></td>
<td>556</td>
<td>343794</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>585/42</td>
<td>343796</td>
<td></td>
<td>PE or PI</td>
</tr>
<tr>
<td>D</td>
<td>502</td>
<td>343797</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>530/30</td>
<td>343798</td>
<td></td>
<td>FITC</td>
</tr>
<tr>
<td>E</td>
<td>488/10</td>
<td>343799</td>
<td></td>
<td>SSC</td>
</tr>
<tr>
<td>F</td>
<td>1.0 ND filter</td>
<td>53-10057-01</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The following filters and mirrors are provided with the violet laser option.

<table>
<thead>
<tr>
<th>Detector Array (Laser)</th>
<th>PMT</th>
<th>LP Mirror BP Filter</th>
<th>Replacement Part No.</th>
<th>Intended Dye</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigon (633-nm red laser)</td>
<td>A</td>
<td>735</td>
<td>343787</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>755</td>
<td>650738</td>
<td>Alexa Fluor® 700</td>
</tr>
<tr>
<td></td>
<td></td>
<td>780/60</td>
<td>343788</td>
<td>APC-Cy7</td>
</tr>
<tr>
<td>B</td>
<td>660/20</td>
<td>343800</td>
<td></td>
<td>APC</td>
</tr>
</tbody>
</table>

The FSC photodiode is provided with a 1.0 ND filter. Other filters are available as options. Use the following part numbers to replace the filter.

<table>
<thead>
<tr>
<th>Detector</th>
<th>ND Filter</th>
<th>Replacement Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FSC photodiode</td>
<td>0.5</td>
<td>33710407</td>
</tr>
<tr>
<td></td>
<td>1.0</td>
<td>33710807</td>
</tr>
<tr>
<td></td>
<td>1.5</td>
<td>338651</td>
</tr>
<tr>
<td></td>
<td>2.0</td>
<td>338652</td>
</tr>
</tbody>
</table>

Appendix A: Supplies and Consumables  279
To order a filter holder, use the following part numbers.

<table>
<thead>
<tr>
<th>Holder</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mirror holder</td>
<td>336103</td>
</tr>
<tr>
<td>Mirror retainer</td>
<td>345662</td>
</tr>
<tr>
<td>Mirror backup spring</td>
<td>344979</td>
</tr>
<tr>
<td>Filter holder</td>
<td>336102</td>
</tr>
<tr>
<td>Filter retainer</td>
<td>333830</td>
</tr>
</tbody>
</table>

### Accessory Kit

The cytometer is shipped with an accessory kit containing the following items. Use these part numbers if you need to order any replacements.

<table>
<thead>
<tr>
<th>Item</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-mL microtube holder</td>
<td>333457</td>
</tr>
<tr>
<td>12 x 75-mm test tube holder</td>
<td>333456</td>
</tr>
<tr>
<td>15-mL centrifuge tube holder</td>
<td>333430</td>
</tr>
<tr>
<td>Four-way 1.5-mL Eppendorf collection tube holder</td>
<td>644349</td>
</tr>
<tr>
<td>Four-way 12 x 75-mm collection tube holder</td>
<td>641454</td>
</tr>
<tr>
<td>Two-way 12 x 75-mm collection tube holder</td>
<td>641613</td>
</tr>
<tr>
<td>Two-way 15-mL collection tube holder</td>
<td>641612</td>
</tr>
<tr>
<td>Universal top section for collection tube holders</td>
<td>652208</td>
</tr>
<tr>
<td>O-ring for collection-tube holder (3)</td>
<td>337897</td>
</tr>
<tr>
<td>Item</td>
<td>Part No.</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Integrated nozzles:</td>
<td></td>
</tr>
<tr>
<td>• 70 micron</td>
<td>647339</td>
</tr>
<tr>
<td>• 85 micron</td>
<td>647340</td>
</tr>
<tr>
<td>• 100 micron</td>
<td>647341</td>
</tr>
<tr>
<td>• 130 micron (optional)</td>
<td>643943</td>
</tr>
<tr>
<td>• Closed-loop</td>
<td>644395</td>
</tr>
<tr>
<td>Nozzle locking lever (spring and plunger included)</td>
<td>643686</td>
</tr>
<tr>
<td>Standard nozzle O-rings</td>
<td>333084</td>
</tr>
<tr>
<td>Magnifying glass</td>
<td>337599</td>
</tr>
<tr>
<td>Sample injection tubing (12-inch lengths)</td>
<td>641059</td>
</tr>
<tr>
<td>Sample injection tubing (7-inch lengths)</td>
<td>641475</td>
</tr>
<tr>
<td>Ferrule</td>
<td>335108</td>
</tr>
<tr>
<td>Ferrule-removal tool</td>
<td>335690</td>
</tr>
<tr>
<td>Collet</td>
<td>19-66455-00</td>
</tr>
<tr>
<td>Collet nut</td>
<td>19-66456-00</td>
</tr>
<tr>
<td>Pinch valve tubing</td>
<td>641900</td>
</tr>
<tr>
<td>Sample line filters (35 micron)</td>
<td>643152</td>
</tr>
<tr>
<td>Sample line filters (50 micron)</td>
<td>643153</td>
</tr>
<tr>
<td>Sheath fluid filter (also used for ethanol shutdown tank filter)</td>
<td>331394</td>
</tr>
<tr>
<td>Fluid filter (for DI water, bleach, and ethanol tanks)</td>
<td>643687</td>
</tr>
<tr>
<td>Air filter, inline, 3 micron</td>
<td>641913</td>
</tr>
<tr>
<td>Disposable waste tank caps (pack of 12)</td>
<td>338854</td>
</tr>
<tr>
<td>Cap for 5-L container (5)</td>
<td>335916</td>
</tr>
<tr>
<td>Lubricant for O-rings</td>
<td>347306</td>
</tr>
</tbody>
</table>
Other Replacement Parts

The following items are not included in the accessory kit, but you can use the indicated part numbers to order spare or replacement parts.

<table>
<thead>
<tr>
<th>Item</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>O-ring pick tool</td>
<td>331430</td>
</tr>
<tr>
<td>Deflection plate removal tool</td>
<td>643197</td>
</tr>
<tr>
<td>Allen wrench set</td>
<td>98-10004-00</td>
</tr>
<tr>
<td>Wrench, 11/16-inch, for sheath probe</td>
<td>646889</td>
</tr>
<tr>
<td>Adapter tray for microscope slides</td>
<td>335630</td>
</tr>
<tr>
<td>Power cords:</td>
<td></td>
</tr>
<tr>
<td>• Main power cord</td>
<td>333694</td>
</tr>
<tr>
<td>• Cordset for continental Europe</td>
<td>334140</td>
</tr>
<tr>
<td>• Cordset for UK</td>
<td>334141</td>
</tr>
<tr>
<td>• Cordset for Australia/Asia</td>
<td>334175</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autoclavable 10-L container</td>
<td>340261</td>
</tr>
<tr>
<td>Auxiliary 5-L container</td>
<td>333504</td>
</tr>
<tr>
<td>Sheath sensor probe</td>
<td>642012</td>
</tr>
<tr>
<td>Waste sensor probe (6-level)</td>
<td>334915</td>
</tr>
<tr>
<td>Auxiliary sensor probe (non-ethanol)</td>
<td>343835</td>
</tr>
<tr>
<td>Auxiliary sensor probe (ethanol)</td>
<td>642874</td>
</tr>
<tr>
<td>Air filter for cabinet (side door)</td>
<td>334351</td>
</tr>
<tr>
<td>Air filter for ACDU cabinet (set of 3)</td>
<td>334821</td>
</tr>
<tr>
<td>Item</td>
<td>Part No.</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>ULPA filter and tubing replacement kit</td>
<td>334822</td>
</tr>
<tr>
<td>(set of 3, for use with the AMO)</td>
<td></td>
</tr>
<tr>
<td>Hydrophobic filter for sort block door</td>
<td>651177</td>
</tr>
<tr>
<td>(for use with the AMO)</td>
<td></td>
</tr>
<tr>
<td>Four-way 1-mL collection tube holder</td>
<td>641614</td>
</tr>
</tbody>
</table>

## Consumables

### Cytometer Setup Particles

<table>
<thead>
<tr>
<th>Particle</th>
<th>Supplier</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD Calibrite™ beads</td>
<td>BD Biosciences</td>
<td>349502</td>
</tr>
<tr>
<td>• Two-color kit (unlabeled, FITC, PE)</td>
<td>BD Biosciences</td>
<td>340486</td>
</tr>
<tr>
<td>• Three-color kit (unlabeled, FITC, PE, PerCP)</td>
<td>BD Biosciences</td>
<td>340497</td>
</tr>
<tr>
<td>• PerCP beads</td>
<td></td>
<td>345036</td>
</tr>
<tr>
<td>• PerCP-Cy5.5 beads</td>
<td></td>
<td>340487</td>
</tr>
<tr>
<td>• APC beads</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fluoresbrite® Yellow-Green 2-µm beads (for the 405-nm laser)</td>
<td>Polysciences Inc.</td>
<td>18604</td>
</tr>
<tr>
<td></td>
<td>(800) 523-2575</td>
<td></td>
</tr>
<tr>
<td>SPHERO Rainbow Calibration Particles, 3.0–3.4 µm</td>
<td>BD Biosciences</td>
<td>559123 (8 peaks)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>556286</td>
</tr>
<tr>
<td></td>
<td></td>
<td>556291 (brightest peak in 556286)</td>
</tr>
<tr>
<td>BD FACS Accudrop beads</td>
<td>BD Biosciences</td>
<td>345249</td>
</tr>
<tr>
<td>BD FACSDiva CS&amp;T research beads (for use with BD FACSDiva software version 7.0 or later)</td>
<td>BD Biosciences</td>
<td>655050 (1 vial)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>655051 (3 vials)</td>
</tr>
</tbody>
</table>
## Reagents

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Supplier</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD FACSFlow sheath fluid</td>
<td>BD Biosciences</td>
<td>342003</td>
</tr>
<tr>
<td>BD™ FACSRinse detergent</td>
<td>BD Biosciences</td>
<td>340346</td>
</tr>
<tr>
<td>BD FACSClean solution</td>
<td>BD Biosciences</td>
<td>340345</td>
</tr>
<tr>
<td>Ethanol</td>
<td>Various</td>
<td>–</td>
</tr>
<tr>
<td>Chlorine bleach (5% sodium hypochlorite)</td>
<td>Clorox® or other</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>major supplier (to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ensure that the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>bleach is at the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>correct concentration and free of particulate matter)</td>
<td></td>
</tr>
<tr>
<td>Monoclonal antibodies</td>
<td>BD Biosciences</td>
<td>– a</td>
</tr>
<tr>
<td>Dyes and fluorochromes</td>
<td>Molecular Probes</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>(800) 438-2209</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sigma</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(800) 325-3010</td>
<td></td>
</tr>
<tr>
<td>BD FACSTM lysing solution</td>
<td>BD Biosciences</td>
<td>349202</td>
</tr>
</tbody>
</table>

a. See the BD Biosciences Immunocytometry Products Catalog or the BD Biosciences website, bdbiosciences.com.
### Labware

<table>
<thead>
<tr>
<th>Item</th>
<th>Supplier</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-mL microtubes</td>
<td>Bio-Rad Laboratories</td>
<td>223-9391</td>
</tr>
<tr>
<td></td>
<td>(800) 424-6723</td>
<td>(1,000 per box)</td>
</tr>
<tr>
<td>1.5-mL Eppendorf tubes</td>
<td>Various</td>
<td>--</td>
</tr>
<tr>
<td>5-mL polystyrene test tubes, 12 x 75-mm (BD Falcon)</td>
<td>BD Biosciences</td>
<td>352052</td>
</tr>
<tr>
<td>• Uncapped, 125 per bag</td>
<td></td>
<td>352054</td>
</tr>
<tr>
<td>• Capped, 125 per bag</td>
<td></td>
<td>352058</td>
</tr>
<tr>
<td>• Capped, 25 per bag</td>
<td></td>
<td>352235</td>
</tr>
<tr>
<td>• With cell-strainer cap, 25 per bag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15-mL conical centrifuge tubes (BD Falcon)</td>
<td>BD Biosciences</td>
<td>352196</td>
</tr>
<tr>
<td>• Polypropylene, 50/bag</td>
<td></td>
<td>352096</td>
</tr>
<tr>
<td>• Polypropylene, 125/bag</td>
<td></td>
<td>352097</td>
</tr>
<tr>
<td>• Polypropylene, 50/rack</td>
<td></td>
<td>352095</td>
</tr>
<tr>
<td>• Polystyrene, 125/bag</td>
<td></td>
<td>352099</td>
</tr>
<tr>
<td>• Polystyrene, 50/rack</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix B

Laser Options

BD FACSaria III systems can be configured with up to six lasers, with four lasers active at one time. Depending on how your system is configured, you can choose different laser options by adjusting the laser rotary switches on your power panel.

You can view your system’s configuration in the CS&T Cytometer Configurations window.

The following topics are described in this chapter:

- Planning Considerations on page 288
- Detector Locations on page 289
- Detector Configurations on page 290
- Special Cases on page 299
Planning Considerations

When planning your experiments, keep in mind the specific combinations of lasers, mirrors, filters, and fluorochromes you need. You also have to properly account for the specific use of the 375-nm laser and how to name a particular fluorochrome if you want to use it with multiple lasers.

Optics Choices for the 375-nm Laser

The optics listed for the 375-nm laser are specifically intended for side population studies. For other experiments, you can use the optics from the 405-nm laser with the 375-nm laser.

Optics Changes When Using the 445-nm Laser

In a system with a 445-nm laser turned on, the BP filter for the 405-nm laser must be changed to 480/20 (from the standard 450/40). This is because the 405-nm laser detector picks up scattered light from the 445-nm laser and causes CS&T to produce incorrect results. This filter change applies to the 375-nm laser when using the same optics as the 405-nm laser.

Using a Fluorochrome with Multiple Lasers

If you plan to use a fluorochrome with more than one laser, you must create a unique name for each instance. For example, if PI is listed for a 561-nm laser on PMT C, you could list it as propidium iodide for the 375-nm laser on PMT B. You could also name them PI-561 and PI-375, or something similar, as long as the names are unique.
Detector Locations

The following tables list the detector locations with respect to the number of installed lasers. See Detector Configurations on page 290 for complete details about which mirrors, filters, and fluorochromes to use.

Table B-1  2-laser systems

<table>
<thead>
<tr>
<th>Laser (nm)</th>
<th>Front Octagon</th>
<th>Back Octagon</th>
</tr>
</thead>
<tbody>
<tr>
<td>488, 633</td>
<td>488</td>
<td>None</td>
</tr>
</tbody>
</table>

Table B-2  3-laser systems

<table>
<thead>
<tr>
<th>Laser (nm)</th>
<th>Front Octagon</th>
<th>Back Octagon</th>
</tr>
</thead>
<tbody>
<tr>
<td>488, 561, 633</td>
<td>561</td>
<td>None</td>
</tr>
<tr>
<td>488, 445, 633</td>
<td>488/445</td>
<td>None</td>
</tr>
<tr>
<td>488, 633, 405</td>
<td>488</td>
<td>405</td>
</tr>
<tr>
<td>488, 633, 375</td>
<td>488</td>
<td>375</td>
</tr>
</tbody>
</table>

Table B-3  4-laser systems

<table>
<thead>
<tr>
<th>Laser (nm)</th>
<th>Front Octagon</th>
<th>Back Octagon</th>
</tr>
</thead>
<tbody>
<tr>
<td>488, 561, 633, 405</td>
<td>405</td>
<td>561</td>
</tr>
<tr>
<td>488, 561, 633, 375</td>
<td>375</td>
<td>561</td>
</tr>
<tr>
<td>488, 445, 561, 633</td>
<td>561</td>
<td>None</td>
</tr>
<tr>
<td>488, 445, 633, 405</td>
<td>488/445</td>
<td>405</td>
</tr>
<tr>
<td>488, 445, 633, 375</td>
<td>488/445</td>
<td>375</td>
</tr>
<tr>
<td>488, 633, 405, 375</td>
<td>488</td>
<td>405/375</td>
</tr>
</tbody>
</table>
### Detector Configurations

This section documents four standard sets of detector configurations along with their mirrors, filters, and fluorochromes.

#### 488/633 Two-Laser System

<table>
<thead>
<tr>
<th>Laser (nm)</th>
<th>Front Octagon</th>
<th>Back Octagon</th>
</tr>
</thead>
<tbody>
<tr>
<td>488, 561, 633, 405, 375</td>
<td>405/375</td>
<td>561</td>
</tr>
<tr>
<td>488, 445, 561, 633, 405</td>
<td>405</td>
<td>561</td>
</tr>
<tr>
<td>488, 445, 561, 633, 375</td>
<td>375</td>
<td>561</td>
</tr>
<tr>
<td>488, 445, 633, 405, 375</td>
<td>488/445</td>
<td>405/375</td>
</tr>
</tbody>
</table>

![Diagram of 488/633 Two-Laser System](image)
This is a basic two laser system with one octagon and one trigon.

**Table B-5** 488/633 configuration

<table>
<thead>
<tr>
<th>Laser and optics device</th>
<th>PMTs</th>
<th>LP mirrors</th>
<th>BP filters</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>488-nm octagon</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>735</td>
<td>780/60</td>
<td></td>
<td>PE-Cy7</td>
</tr>
<tr>
<td>B</td>
<td>655</td>
<td>695/40</td>
<td></td>
<td>• PerCP-Cy5.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• PI</td>
</tr>
<tr>
<td>C</td>
<td>610</td>
<td>610/20</td>
<td></td>
<td>PE-Texas Red®</td>
</tr>
<tr>
<td>D</td>
<td>556</td>
<td>585/42</td>
<td></td>
<td>PE</td>
</tr>
<tr>
<td>E</td>
<td>502</td>
<td>530/30</td>
<td></td>
<td>FITC</td>
</tr>
<tr>
<td>F</td>
<td>—</td>
<td>488/10</td>
<td></td>
<td>SSC</td>
</tr>
<tr>
<td>G, H - Unavailable</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>633-nm trigon</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>735</td>
<td>780/60</td>
<td></td>
<td>• APC-Cy7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• APC-H7</td>
</tr>
<tr>
<td>B</td>
<td>—</td>
<td>660/20</td>
<td></td>
<td>APC</td>
</tr>
<tr>
<td>C - Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
488(445)/561/633 Four-Laser System

This four-laser system supports the simultaneous use of three lasers, with the option to switch from the 488-nm laser to the 445-nm laser.

Although this system also uses the 488-nm laser and 633-nm lasers, note how the addition of the 561-nm laser places the 488-nm laser on a trigon when compared to the 488-nm/633-nm two laser system.

Switching lasers affects the supported combination of mirrors, filters, and dyes. These laser options are included in the following table.

**Table B-6  488(445)/561/633 configuration**

<table>
<thead>
<tr>
<th>Laser and optics device</th>
<th>PMTs</th>
<th>LP mirrors</th>
<th>BP filters</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>488-nm trigon</td>
<td>A</td>
<td>655</td>
<td>695/40</td>
<td>PerCP-Cy5.5</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>502</td>
<td>530/30</td>
<td>FITC</td>
</tr>
<tr>
<td></td>
<td>C</td>
<td>—</td>
<td>488/10</td>
<td>SSC</td>
</tr>
</tbody>
</table>
### Laser and optics device

<table>
<thead>
<tr>
<th>Laser and optics device</th>
<th>PMTs</th>
<th>LP mirrors</th>
<th>BP filters</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>445-nm trigon (Optional)</td>
<td>A</td>
<td>470</td>
<td>510/80</td>
<td>• CFP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• AmCyan fluorescent protein</td>
</tr>
<tr>
<td>B</td>
<td>—</td>
<td>445/15</td>
<td></td>
<td>SSC</td>
</tr>
<tr>
<td>C, D, E, F, G, H - Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>561-nm octagon</td>
<td>A</td>
<td>735</td>
<td>780/60</td>
<td>PE-Cy7</td>
</tr>
<tr>
<td>B</td>
<td>630</td>
<td>670/14</td>
<td>710/50</td>
<td>• PE-Cy\textsuperscript{TM}5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• PE-Cy5.5</td>
</tr>
<tr>
<td>C</td>
<td>600</td>
<td>610/20</td>
<td></td>
<td>• PE-Texas Red®</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Living Colors® mCherry</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• PI</td>
</tr>
<tr>
<td>D</td>
<td>—</td>
<td>582/15</td>
<td></td>
<td>PE</td>
</tr>
<tr>
<td>E, F - Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G, H - Unavailable</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>633-nm trigon</td>
<td>A</td>
<td>735</td>
<td>780/60</td>
<td>• APC-Cy7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• APC-H7</td>
</tr>
<tr>
<td>B</td>
<td>—</td>
<td>660/20</td>
<td></td>
<td>APC</td>
</tr>
<tr>
<td>C - Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This five-laser system supports the simultaneous use of three lasers, with the option to switch from the 488-nm laser to the 445-nm laser as well as from the 405-nm laser to the 375-nm laser.

If your system doesn’t have the 445-nm or 375-nm lasers installed, the location of the other detectors would not change.
Switching lasers affects the supported combination of mirrors, filters, and dyes. The laser options are included in the following table.

Table B-7  488(445)/633/405(375) five-laser system

<table>
<thead>
<tr>
<th>Laser and optics device</th>
<th>PMTs</th>
<th>LP mirrors</th>
<th>BP filters</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>488-nm octagon</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>735</td>
<td>780/60</td>
<td></td>
<td>PE-Cy7</td>
</tr>
<tr>
<td>B</td>
<td>655</td>
<td>695/40</td>
<td></td>
<td>PerCP-Cy5.5</td>
</tr>
<tr>
<td>C</td>
<td>610</td>
<td>610/20</td>
<td></td>
<td>PE-Texas Red®</td>
</tr>
<tr>
<td>D</td>
<td>556</td>
<td>585/42</td>
<td></td>
<td>PE</td>
</tr>
<tr>
<td>E</td>
<td>502</td>
<td>530/30</td>
<td></td>
<td>FITC</td>
</tr>
<tr>
<td>F</td>
<td>—</td>
<td></td>
<td>488/10</td>
<td>SSC</td>
</tr>
<tr>
<td>G, H - Unavailable</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>445-nm octagon (Optional)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>470</td>
<td>510/80</td>
<td></td>
<td>CFP</td>
</tr>
<tr>
<td>B</td>
<td>—</td>
<td></td>
<td>445/15</td>
<td>AmCyan fluorescent protein</td>
</tr>
<tr>
<td>C, D, E, F, G, H - Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>633-nm trigon</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>735</td>
<td>780/60</td>
<td></td>
<td>APC-Cy7</td>
</tr>
<tr>
<td>B</td>
<td>—</td>
<td></td>
<td>660/20</td>
<td>APC-H7</td>
</tr>
<tr>
<td>C - Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This six-laser system supports the simultaneous use of four lasers, with the option to switch from the 488-nm laser to the 445-nm laser as well as from the 405-nm laser to the 375-nm laser. Switching lasers affects the supported combination of mirrors, filters, and dyes.

With this configuration, the 405-nm and 375-nm optics are interchangeable unless you are doing side population studies, in which case you’ll use the optics specified for only the 375-nm laser.

<table>
<thead>
<tr>
<th>Laser and optics device</th>
<th>PMTs</th>
<th>LP mirrors</th>
<th>BP filters</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>405-nm/375-nm octagon</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>502</td>
<td>510/50</td>
<td></td>
<td>AmCyan</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BD Horizon™ V500</td>
</tr>
<tr>
<td>B</td>
<td>—</td>
<td>450/40</td>
<td></td>
<td>DAPI</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BD Horizon™ V450</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Pacific Blue™</td>
</tr>
<tr>
<td>C, D, E, F, G, H - Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>375-nm octagon² (Optional)</td>
<td>610</td>
<td>670</td>
<td></td>
<td>Hoechst Red</td>
</tr>
<tr>
<td>B</td>
<td>—</td>
<td>450/20</td>
<td></td>
<td>Hoechst Blue</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DAPI</td>
</tr>
<tr>
<td>C - Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

a. Use these settings for the 375-nm laser for side population studies.

488(445)/561/633/405(375) Six-Laser System

This six-laser system supports the simultaneous use of four lasers, with the option to switch from the 488-nm laser to the 445-nm laser as well as from the 405-nm laser to the 375-nm laser. Switching lasers affects the supported combination of mirrors, filters, and dyes.

With this configuration, the 405-nm and 375-nm optics are interchangeable unless you are doing side population studies, in which case you’ll use the optics specified for only the 375-nm laser.
Table B-8  488(445)/561/633/405(375) configuration

<table>
<thead>
<tr>
<th>Laser and optics device</th>
<th>PMTs</th>
<th>LP mirrors</th>
<th>BP filters</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>488-nm trigon</td>
<td>A</td>
<td>655</td>
<td>695/40</td>
<td>• PerCP-Cy5.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>675/20</td>
<td>• PerCP</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>502</td>
<td>530/30</td>
<td>FITC</td>
</tr>
<tr>
<td></td>
<td>C</td>
<td>—</td>
<td>488/10</td>
<td>SSC</td>
</tr>
</tbody>
</table>

Appendix B: Laser Options  297
<table>
<thead>
<tr>
<th>Laser and optics device</th>
<th>PMTs</th>
<th>LP mirrors</th>
<th>BP filters</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>445-nm trigon (Optional)</td>
<td>A</td>
<td>470</td>
<td>510/80</td>
<td>CFP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>—</td>
<td>445/15</td>
<td>SSC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>C, D, E, F, G, H - Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>561-nm octagon</td>
<td>A</td>
<td>735</td>
<td>780/60</td>
<td>PE-Cy7</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>630</td>
<td>670/14</td>
<td>PE-Cy5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>710/50</td>
<td>PE-Cy5.5</td>
</tr>
<tr>
<td></td>
<td>C</td>
<td>600</td>
<td>610/20</td>
<td>PE-Texas Red</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Living Colors® mCherry</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>PI</td>
</tr>
<tr>
<td></td>
<td>D</td>
<td>—</td>
<td>582/15</td>
<td>PE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E, F - Optional</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>G, H - Unavailable</td>
</tr>
<tr>
<td>633 nm trigon</td>
<td>A</td>
<td>735</td>
<td>780/60</td>
<td>APC-Cy7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>APC-H7</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>—</td>
<td>660/20</td>
<td>APC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>C - Optional</td>
</tr>
<tr>
<td>405-nm/375- nm octagon</td>
<td>A</td>
<td>502</td>
<td>510/50</td>
<td>AmCyan</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BD Horizon V500</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>—</td>
<td>450/40</td>
<td>DAPI</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>BD Horizon V450</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Pacific Blue™</td>
</tr>
<tr>
<td></td>
<td>C, D, E, F, G, H - Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Special Cases

There are special cases you may use that require special consideration.

Third PMT in the 633 Trigon

If you upgrade with an additional PMT in the 633 trigon, the upgrade kit comes with an Alexa Fluor® 700 filter set, which contains a 755 LP (which replaces the 735 LP) and 730/45 BP filters. This enables the simultaneous use of APC, Alexa Fluor® 700, and APC-H7 (Cy7).

<table>
<thead>
<tr>
<th>Laser and optics device</th>
<th>PMTs</th>
<th>LP mirrors</th>
<th>BP filters</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>375-nm octagon(^a)</td>
<td>A</td>
<td>610</td>
<td>670</td>
<td>• Hoechst Red</td>
</tr>
<tr>
<td>(Optional)</td>
<td>B</td>
<td>—</td>
<td>450/20</td>
<td>• Hoechst Blue</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• DAPI</td>
</tr>
<tr>
<td>C, D, E, F, G, H - Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

\(^a\) Use these settings for the 375-nm laser for side population studies.
Fifth PMT in the 561-nm Octagon

A system with a 561-nm laser and an optional fifth PMT includes a 685 LP mirror that can be used with the supplied 710/50 BP filter to run PE-Cy5.5. The optics in the PMTs need to be shifted to use this setup. The following drawing shows the optics configuration for this case.
Appendix C

BD Aerosol Management Option

The BD aerosol management option (AMO) is a device that uses an attached vacuum source to rapidly evacuate aerosolized particles through an ultra-low penetrating air filter during routine sorting or analysis.

The following topics are described in this chapter:

- Option Components on page 302
- Operating the BD Aerosol Management Option on page 304
- Maintenance on page 310
- Troubleshooting on page 317
- Specifications on page 320
Option Components

The BD Aerosol Management Option (AMO) includes the following:

- An evacuator to generate negative pressure
- An ultra-low penetrating air (ULPA) filter to trap particles, with attached tubing that connects the evacuator to the instrument
- An air filter for the sort collection chamber door
- A hydrophobic filter on the sort block door
- A hinged cover on the sample injection chamber

⚠️ The BD Aerosol Management Option does not eliminate the health risks of working with biohazardous material and must be used in conjunction with good laboratory practice.

The BD Aerosol Management Option is For Research Use Only. It is not for use in diagnostic or therapeutic procedures.

Evacuator

The evacuator holds the ULPA filter and attached tubing. Air flow is controlled using pushbuttons within a membrane panel on the front of the unit. The evacuator sits on castor wheels for easy maneuverability. It can be moved using the handle attached to the unit. See Figure C-1 on page 303.
ULPA Filter

The ULPA filter used in the BD AMO captures and retains 99.9995% of all particles down to and including particles 0.12 microns in size, according to the manufacturer’s specifications.
Operating the BD Aerosol Management Option

Starting Up the Evacuator

Before starting up the evacuator, make sure that the ULPA filter is completely seated against the bottom of the evacuator filter well, and that the tubing is securely attached to the filter and instrument manifold.

⚠️ Any instrument surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling instrument hardware. Wear suitable protective clothing and gloves.

To start up the evacuator:

1. Install the splash shield or the tube holder below the aspirator drawer (Figure C-3 on page 305).

   The splash shield is required for sorting into a multiwell plate or onto a slide.

   To install the splash shield:

   a. Close the sort block door and open the sort collection chamber door, if needed.

      The sort block door must be closed to open the collection chamber door.

   b. Remove the tube holder, if one is installed.

   c. Insert the splash shield into the slotted fittings below the sort aspirator drawer. (See Figure C-3 on page 305.) Push the splash shield all the way in.
2 Ensure that an air filter is installed in the sort collection chamber door. The filter traps airborne dust that could clog the ULPA filter. Note that the filter should be changed on a monthly basis. See Replacing the Air Filter on page 315.

3 Close the sort collection chamber door.

**NOTE** The sort collection chamber door must be closed for the evacuator to generate negative pressure in the chamber.

4 Switch on the main power on the back of the evacuator.
5 Press the power button on the membrane panel of the evacuator.

6 Press the up or down arrow button to set the suction control rate to 20%.

Each time either arrow button is pressed, the suction will increase or decrease by 10%. When two lights are lit on the suction control indicator, the actual air flow is the value between the two illuminated percentages.

⚠️ Do not set the suction control rate above 20%. Higher rates could affect the stability of the side streams.

7 Verify that the filter flow gauge reads less than 2.4 inches of H₂O (Figure C-5 on page 307).

For a new filter, the gauge should read 1.1–1.4 inches of H₂O. As the filter is used, the reading will increase. If the gauge reads 2.4 inches of H₂O or greater, replace the filter. See Replacing the ULPA Filter on page 311.
Figure C-5  Reading the filter flow gauge

Setting Up for Sorting

To set up for sorting:

1  Start up the flow cytometer system. See Cytometer Startup on page 118.

2  Start up the evacuator as described in Starting Up the Evacuator on page 304.

3  Follow the standard sort setup procedure. See Setting Up for Sorting on page 168.

**NOTE**  Always start up the evacuator before setting up for sorting. If you start up the evacuator after sort setup is complete, you will need to repeat the setup procedure.
Responding to a Nozzle Clog During a Sort with the AMO

If the stream is disturbed during the sort (due in part to a clogged nozzle), the sort is designed to stop automatically and block the sort tubes (if Sweet Spot is on). The sort will not restart until the operator has cleared the clog. In the event of a nozzle clog, do not open sort collection chamber door or access the sort tubes before following this procedure.

⚠️⚠️ Cell sorters that use droplet generation methods, such as the BD FACSAria III, can produce aerosols around the sample stream. When acquiring biohazardous samples, follow universal precautions at all times. Keep the sort block door and the sort collection chamber door closed during sorting. Follow these steps to stop sample flow and evacuate potential aerosols before opening the sort collection chamber door.

To clear a clogged nozzle on a system with the AMO:

1. If the stream has not already shut down automatically, turn off the stream by clicking the Stream button (with a checkmark) at the top of the Breakoff window.
   
   This will shut off the stream, unload the sample, and close the aspirator drawer.

2. Increase the air evacuation rate on the AMO unit to 100%.

3. Open the aspirator drawer using software controls (see Figure 1-12 on page 32).

4. Wait at least 60 seconds.
   
   This procedure will clear aerosols from the sort chamber.

5. Close the aspirator drawer.

6. Turn on the stream and view the breakoff.
If the clog is removed, the breakoff will be similar to the breakoff before the clog.

7 If the clog is not cleared, turn the stream on and off several times to see if the clog will clear itself.

8 If the clog is not removed, turn the stream off and perform the Clean Flow Cell procedure with DI water (see Cleaning the Flow Cell on page 202), followed by turning the stream on to see if the clog will clear itself.

9 Open the aspirator drawer and evacuate for at least 60 seconds before closing the aspirator drawer again.

10 You can now open the sort collection chamber and remove the sort collection device.

11 If it is necessary to change nozzles or remove a clog from a nozzle, see Cleaning the Integrated Nozzle on page 229.

12 With stream turned off, open the sort block door and dry the plates and surfaces as needed.

13 When removing collection tubes, be aware that the outside of the tube is potentially contaminated. Use alcohol swabs or bleach to wipe the outsides of tubes.

14 Set the AMO unit back to 20% vacuum.

15 Make sure that all chamber doors are closed and restart the stream.

16 Perform these tasks if needed:
   - Turn on the Sweet Spot
   - Check drop delay
   - Check side stream deflection
**Turning Off the Evacuator**

Turn off the evacuator after you have finished running biohazardous samples.

1. Place the system in standby by pressing the power button on the membrane panel of the evacuator.

2. Switch off the main power on the back of the evacuator (Figure C-4 on page 306).

**Maintenance**

Use the following guidelines to ensure optimal performance of the BD Aerosol Management Option.

- Change the ULPA filter and attached tubing when the flow gauge indicator is >2.4 at a 20% flow setting or when the red filter-life indicator LED is blinking. See Replacing the ULPA Filter on page 311.

  Two spare filters and replacement tubing are included with the AMO. To order additional replacement kits, contact your local BD Biosciences representative.

- All biological specimens and materials coming into contact with them can transmit potentially fatal disease. Handle the ULPA filter and attached tubing as if capable of transmitting infection. Dispose of waste using proper precautions and in accordance with local regulations. Wear suitable protective clothing, eyewear, and gloves.

- Change the air filter in the sort collection chamber door on a monthly basis. The filter traps airborne dust that could clog the ULPA filter. Regular replacement of the air filter will extend the life of your ULPA filter. See Replacing the Air Filter on page 315.

- Do not touch the Filter Life Reset button during normal operation. Doing so could shut down the evacuator and prevent the collection of aerosols.
• Do not disconnect the tubing from the instrument manifold outlet or the ULPA filter unless you are changing the filter. Repeated removal and reattachment of the tubing could loosen the connection and disrupt airflow.

• To ensure optimal airflow, keep the tubing free of kinks and away from sharp or heavy objects. Do not crush or puncture the tubing. Ensure that the tubing is securely attached at both ends before turning on the evacuator power.

• Keep the sort collection chamber free of potentially obstructive debris, such as Kimwipes® or disposable pipettes.

• Replace the hydrophobic filter on the sort block door every six months. See Figure 1-13 on page 33 for the location of the filter.

### Replacing the ULPA Filter

Replace the filter when either of the following conditions occur:

• The filter-flow gauge reads 2.4 inches of H₂O or greater at 20% suction.

• The red filter-life indicator LED is blinking.

**NOTE** When the red light turns on and is not blinking, you have approximately 1 hour of filter life remaining. If the red light comes on during sorting, the filter will not stop working. Replace the filter as soon as possible when the red light starts blinking.

To replace the ULPA filter:

1. Turn off the evacuator main power and disconnect the electrical plug.

   To prevent potential shock, always turn off the evacuator main power and disconnect the electrical plug from the power source before installing or removing any filter.

2. Disconnect the tubing from the manifold (Figure C-6 on page 312).
The manifold is located in the connection panel on the left side of the instrument.

**Figure C-6** Disconnecting tubing (side of instrument)

3 Remove the spring-loaded filter hold-down.

While pushing down on the filter, pull up on the spring-loaded handle (Figure C-7A), and guide the handle over the top of the filter and behind the metal plate in the back of the evacuator (Figure C-7B).

**Figure C-7** Removing the filter hold-down
4 Lift off the ULPA filter and attached tubing from the evacuator and dispose of both the filter and the tubing.

⚠️ All biological specimens and materials coming into contact with them can transmit potentially fatal disease. Handle the ULPA filter, attached tubing, and all instrument hardware as if capable of transmitting infection. Dispose of waste using proper precautions and in accordance with local regulations. Wear suitable protective clothing, eyewear, and gloves.

5 Insert the new ULPA filter into the evacuator filter well (Figure C-8).

Figure C-8 Inserting the new filter

6 Push down on the filter to ensure that it is seated against the bottom of the filter chamber (Figure C-9 on page 314).
NOTE For optimal evacuation of aerosols, the filter must be completely seated in the evacuator filter well.

7 Lift the spring-loaded filter hold-down and place it on top of the filter.

8 Press and hold the Filter Life Reset button on the membrane panel for 5–10 seconds.

![Reset button]

The green and amber LED lights will turn off, and then on. Hold down the button until the 100% indicator light is lit. This resets the 180-hour filter-life clock.

9 Connect one end of the replacement tubing to the ULPA filter, and the other end to the tubing manifold (Figure C-10 on page 315).
Figure C-10 Connecting new tubing

NOTE For optimal evacuation of aerosols, ensure that the tubing is securely connected at both ends.

10 Connect the evacuator power plug to the power source.

Replacing the Air Filter

To extend the life of your ULPA filter, we recommend that you replace the air filter on a monthly basis. The filter traps airborne dust that could clog the ULPA filter. Regular replacement of the air filter will extend the life of your ULPA filter.

1 Open the sort collection chamber door and remove the air filter.

Push the filter toward the left side of the door until you can grasp it, and then slide the filter out of the door.
2 Install a new air filter in the door.

Slide the new filter in from the left.

**NOTE** Make sure to install the filter with the grid side facing up when the door is open.

![Grid side (faces up when door open)](image)
![Non-grid side (faces out when door closed)](image)
Troubleshooting

The tips in this section are provided to help you troubleshoot issues that arise when using the BD Aerosol Management Option. For cytometer-specific troubleshooting, see Troubleshooting on page 249.

If additional assistance is required, contact your local BD Biosciences technical support representative or supplier.

⚠️ If any of the following are observed, assume that the AMO is not evacuating properly, and do not open the doors to the sort chamber.

## Control Panel Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evacuator indicator lights off</td>
<td>Evacuator power cord unplugged</td>
<td>Connect the evacuator power cord to the power source.</td>
</tr>
<tr>
<td>Evacuator power switched off</td>
<td>Switch on the evacuator main power. See Figure C-4 on page 306.</td>
<td></td>
</tr>
<tr>
<td>Evacuator motor failure</td>
<td>Contact your local BD technical support representative.</td>
<td></td>
</tr>
<tr>
<td>Circuit breaker tripped</td>
<td>Depress the circuit breaker on the rear of the evacuator into its original position.</td>
<td></td>
</tr>
<tr>
<td>Site power failure</td>
<td>Turn off the evacuator power switch and wait for site power to be restored.</td>
<td></td>
</tr>
<tr>
<td>Evacuator indicator lights pulsing</td>
<td>Erratic power source</td>
<td>Plug the power cord into a different outlet.</td>
</tr>
</tbody>
</table>
## Control Panel Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys not responding</td>
<td>Improper operation</td>
<td>Push each button firmly before removing your finger from the control.</td>
</tr>
<tr>
<td></td>
<td>Defective membrane panel</td>
<td>Contact your local BD technical support representative.</td>
</tr>
<tr>
<td>Red filter-life indicator light on</td>
<td>Approaching 180 hours of filter use</td>
<td>Monitor the light. When it blinks, change the filter.</td>
</tr>
<tr>
<td></td>
<td>Filter life not reset after filter change</td>
<td>After changing the filter, press and hold the Filter Life Reset button until the 100% indicator light is lit.</td>
</tr>
<tr>
<td>Red filter-life indicator blinking</td>
<td>Filter used over 180 hours</td>
<td>Replace the filter.</td>
</tr>
</tbody>
</table>
## Filter Flow Gauge Troubleshooting

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Cause</th>
<th>Recommended Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero reading on filter flow gauge</td>
<td>Power off</td>
<td>Press the power button on the membrane panel of the evacuator.</td>
</tr>
<tr>
<td></td>
<td>Filter defective</td>
<td>Replace the filter.</td>
</tr>
<tr>
<td></td>
<td>Filter improperly seated in evacuator</td>
<td>Re-seat the filter with the evacuator power off.</td>
</tr>
<tr>
<td></td>
<td>Tubing loose or not connected</td>
<td>Ensure that the tubing is securely connected below the sort chamber and to the filter module.</td>
</tr>
<tr>
<td></td>
<td>Tubing kinked or damaged</td>
<td>Inspect the tubing for kinks or punctures. Replace the tubing, if needed.</td>
</tr>
<tr>
<td></td>
<td>Wrong tubing type or part</td>
<td>Ensure that the correct type of tubing is in use.</td>
</tr>
<tr>
<td>Erratic reading on filter flow gauge</td>
<td>Defective filter</td>
<td>Replace the filter.</td>
</tr>
<tr>
<td></td>
<td>Filter improperly seated in evacuator</td>
<td>Re-seat the filter with the evacuator power off.</td>
</tr>
<tr>
<td>Off-scale reading on filter flow gauge</td>
<td>Tubing or sort collection chamber obstructed</td>
<td>• Inspect the tubing for kinks or punctures. Replace the tubing, if needed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check for obstructions in the sort collection chamber. Remove any obstruction.</td>
</tr>
<tr>
<td></td>
<td>Filter clogged or saturated</td>
<td>Replace the filter as described in Replacing the ULPA Filter on page 311.</td>
</tr>
</tbody>
</table>
Specifications

Specifications for the BD Aerosol Management Option are as follows.

Evacuator

- Greater than or equal to 7 CFM (ft³/min) normal operation rate (20% suction control)
- Greater than or equal to 30 CFM boost evacuation (100% suction control)
- <35 lb unpacked weight

ULPA Filter Module

- VLSI grade
- Traps particles greater than or equal to 0.12 µm
- Three-stage filtration (pre-filter, ULPA, post-filter)
- Particulate removal efficiency >99.9995%

Air Filter

- Filter medium is an open-cell polyurethane foam
- Medium specially coated for improved fire retardation and fungi resistance
- High dust-trapping capacity, low air resistance
- Can be used in a wide variety of climatic conditions
- Rated UL 94 HF-1
Appendix D

Temperature Control Option

The BD™ temperature control option can be used to control the temperature of sorted samples in the BD FACSaria III flow cytometer.

The following topics are described:

- Option Components on page 322
- Using the BD Temperature Control Option on page 323
- Maintenance on page 330
- Specifications on page 331
Option Components

The BD temperature control option includes the following:

- A recirculating water bath

- Specially designed collection tube holders with ports for recirculating water

Tube holders are available in these styles: two-way 15-mL, four-way 12 x 75-mm, and four-way 1.5 mL Eppendorf tubes. See Figure D-1.

Figure D-1 Temperature control option components
When acquiring biohazardous samples, follow universal precautions at all times. Keep the sort block door and the sort collection chamber door closed during sorting. We recommend that you use the BD Aerosol Management Option when sorting biohazardous samples into the temperature control tube holders. If the nozzle develops a clog, see Responding to a Nozzle Clog During a Sort with the AMO on page 308.

The BD temperature control option is For Research Use Only. It is not for use in diagnostic or therapeutic procedures.

**Using the BD Temperature Control Option**

Note that before you start the recirculating water bath, you must attach the tubing to the appropriate collection device.

**Setting Up the Water Bath**

1. Remove the threaded plug from the output port on the water bath.

2. Ensure that the drain cock on the back of the water bath is closed by turning it fully clockwise.

3. Set the pump outflow to maximum by turning the knob fully counterclockwise.

   Remove the top cover to access the knob, which is located inside the water bath towards the back. See the operating instructions supplied with water bath for additional details on this process. This is referred to as position 1.

4. Connect the clear tubing end of the insulated hoses to the input and output ports on the water bath. (See Figure D-2 on page 324.)

   Slide the tubing over the hose barbs and twist gently while installing to get the tubing completely over the barbs.
5 Connect the insulated hoses from the recirculating water bath to the cytometer control panel.

**NOTE** Make sure you match the flow direction from the water bath port to the flow direction on the instrument manifold. The instrument ports are labeled *cooling in* and *cooling out*.

**Figure D-3** Connections for temperature control option

6 Fill the water bath with distilled water containing 0.1 g/L of sodium carbonate.

Sodium carbonate helps reduce corrosion. See the water bath manufacturer’s documentation for fill levels and other setup information.

**NOTE** We do not recommend using ethylene glycol (antifreeze) in the water bath.
Appendix D: Temperature Control Option

7 Plug in the water bath power cord.

**NOTE** Do not start up the water bath until after you have connected the recirculating water tubing, as described in the following sections.

### Setting Up the Tube Holder

This section describes how to install the temperature control tube holder on the instrument and how to attach the recirculating water tubing to the tube holder.

⚠️⚠️ Any instrument surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing and gloves.

1 Place collection tubes in the temperature control tube holder.

   Tube holders are available for 15-mL two-way sorting, 12 x 75-mm four-way sorting, and 1.5-mL Eppendorf tube four-way sorting. For compatible tubes, see Supplies and Consumables on page 277.

2 Attach the recirculating water tubing to the tube holder.

   a Close the sort block door and open the sort collection chamber door, if needed. (The sort block door must be closed to open the collection chamber door.)

   Note that the tubing ports are labeled *In* and *Out*. Attach the input tubing to the port on the left side of the collection tube holder, and the output tubing to the port on the right side, as shown in Figure D-4 on page 326.

   b To attach the tubing, push it into the port until the tubing snaps into place.
3 Figure D-4 Setting up the temperature control tube holder

If you need to remove the tubing, push in the orange collar as you pull the tubing out of the port.

3 Install the tube holder on the instrument.

Remove the current tube holder (if one is installed), and slide the temperature control tube holder into the slotted fittings below the sort aspirator drawer. Push the tube holder all the way in.

4 Close the sort collection chamber door and start up the water bath.
Setting Up the ACDU Stage

This section describes how to attach the recirculating water tubing to the stage used with the automated cell deposition unit (ACDU).

⚠️⚠️ Any instrument surface that comes in contact with biological specimens can transmit potentially fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing and gloves.

1 Install the splash shield below the aspirator drawer.
   a Close the sort block door and open the sort collection chamber door, if needed. (The sort block door must be closed to open the collection chamber door.)
   b Remove the tube holder, if one is installed.
   c Insert the splash shield into the slotted fittings below the sort aspirator drawer. Push the splash shield all the way in.

2 Click the Access Stage button to bring the ACDU stage to the front.
   a Open an experiment, if one is not already open, and create a sort layout for any of the tubes.
   b In the Sort Layout view, click the Access Stage button to move the stage to the front of the sort collection chamber.

3 Attach the recirculating water tubing to the ACDU stage.

Note that the tubing ports are labeled In and Out. Attach the input tubing to the port on the left side of the stage, and the output tubing to the port on the right side, as shown in Figure D-5 on page 328.

To attach the tubing, push it into the port until the tubing snaps into place.
If you need to remove the tubing, push in the orange collar as you pull the tubing out of the port.

4 Install the required collection device on the stage.

5 Close the sort collection chamber door and start up the water bath.
Starting Up the Water Bath

**NOTE** To ensure that the sample collection device is at the correct temperature, start up the water bath at least 30 minutes (115-V model) or 60 minutes (110-V model) before you start sorting.

1. Switch on the main power on the water bath control panel.

2. Use the up or down arrow keys to set the required temperature.

**NOTE** To achieve the required sample temperature, you will need to set the water bath temperature slightly higher or lower (see Table D-1). These settings might need adjustment depending on the ambient temperature in your laboratory. We recommend that you calibrate the water bath for your operating environment.

<table>
<thead>
<tr>
<th>Required Sample Temp (°C)</th>
<th>Water Bath Setting (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>37</td>
<td>37.5</td>
</tr>
<tr>
<td>42</td>
<td>43.2</td>
</tr>
</tbody>
</table>
Wait at least 30 minutes (115-V model) or 60 minutes (110-V model) to allow the recirculating water reach the required temperature.

**Maintenance**

To maintain the recirculating water bath, see the documentation provided by the manufacturer.

**Tube Holders**

Remove the tube holders when you are finished using them, and clean them periodically before storage.

⚠️ When you detach the recirculating water tubing from the tube holder, any fluid remaining in the tubing can leak into the sort collection chamber. To ensure that fluid is aspirated from the sort collection chamber, make sure that the sort chamber aspirator pump is on (do not turn off the instrument main power) before you detach the tubing. Use caution when handling tubing containing hot water.

To detach the recirculating water tubing, push in the orange collar as you pull the tubing out of the port.

Clean the temperature control tube holders by wiping them down with an appropriate cleaning fluid (for example, 70% ethanol, 5% bleach, or deionized water). Dry them with a lint-free cloth before storage.

**Recirculating Water Tubing**

Inspect the tubing periodically for leaks, plugs, or contaminants. If needed, remove the tubing and clean it with an appropriate cleaning solution, or replace the tubing. Contact your BD Biosciences service representative for replacement tubing.
Specifications

Specifications for the recirculating water bath are as follows.

**NOTE** The following specifications are for the US version only.

The temperature control option includes the Lauda® Ecoline cooling/heating bath, model RE 106.

- Operating temperature range: –20 to 120°C
- Ambient temperature range: 5 to 40°C
- Heater power for 115 V/60 Hz: 1.3 kW
- Maximum flow rate at pump output of 5: 17 L/min
- Maximum bath volume: 4–6 L
- Power consumption for 115 V/60 Hz: 1.4 kW

For more information, see the manufacturer’s documentation.
Numerics

4-Way Purity mode 77

A

aborts
See also conflicts, sort.
electronic 266
Access Stage button 111
accessory kit, contents 280
Accudrop
about 71
beads, sorting in Initial mode 175
experiment 115, 172
optimizing drop delay 174
ACDU See automated cell deposition unit
acquisition
controls 101
events to record 155
troubleshooting 261
Acquisition Dashboard 101
adding
cytometer configurations 93
folders 149
sort layouts 108, 180
sort populations 108, 180
adjusting
amplitude 68, 124
area scaling 142, 144, 145
Drop 1 68, 126
drop delay 174
flow rate 50, 101
Home location 190
laser delay 164
micrometer dial 175, 178
PMT voltages 62
side streams 190
sort block angle 31, 229
Window Extension 165
aerosol management option (AMO)
about 33
changing filters 225
components 302
connecting 21
evacuator components 303
maintenance 310
specifications 320
starting up the evacuator 304
troubleshooting 317
ULPA filter 303
using 301–320
agitating samples 85
air
external 22
filters, changing 225
line 120, 205
pressure 23
supply, external 22
AMO See aerosol management option amplitude
about 66
adjusting 68, 124
analysis
batch 161
data 155
printing 160
sorting 159, 169, 179
application settings
about 141
adjusting area scaling 142
creating 142
optimizing PMT voltages 146
saving 148
window 150
applications
custom 93
recommended flow rates 51
recommended sort setup 104
area parameters 61
arrays, detector 40, 54
aseptic sorting 211
aspirator drawer
about 32
opening 70, 111, 181
assistance, technical xv
attenuation control 70
auto drop delay
about 72
graph 178
overview 177
using 177
autoclaving sheath tank 211
automated cell deposition unit (ACDU)
about 34
accessing stage 111
chamber 34
collection devices 191
custom devices 192
installing splash shield 188
sorting 188
troubleshooting 257
B
backflush, sample line 208
bandpass filters 57
base configurations 95
batch analysis, performing 161
BD FACSARia III
about 17
cytometer 24
fluidics cart
workstation 46
BD FACSDiva software See software beads
Accudrop 174
calibration 284
CS&T research 138
setup 136
beam splitters 56
biexponential
display 157
sort gates 179
bleach fluid line 212
bleeding filters 214
breaker, circuit 43
breakoff
drop 65
setting up 124–126
troubleshooting 124, 255
window 66, 103
bulk sorting 169
buttons
See also controls
Access Stage 111
chamber light 27
emergency stop 44
Load 101
power 43
Sort 110
Unload 101
waste drawer 70

C

calculating compensation 152
cameras
   about 42, 71
   cleaning windows 239
cap, waste 134
cart, fluidics See fluidics cart
chambers
   ACDU 34
   sample injection 27
   sort block 30
   sort collection 34
changing
   air filters 225
   ethanol shutdown filter 217
   fluid filters 215
   nozzles 228
   optical filters 244
   pinch valve tubing 237
   sample lines 218
   sheath filters 216
   waste cap 134
charging drops 72
circuit breaker 43

cleaning
   camera windows 239
   cytometer 206, 208
   flow cell 202
   fluidics 211
   mode failure 268
   modes 208
   nozzles 229
   optical filters 245
   strobe lens 241
clogged nozzle
   cleaning 229
   responding to during a sort 186
   responding to during a sort with
      AMO 308
closed-loop nozzle
   cleaning 233
   for shutdown 202
   installing 204
   maintenance 232
   replacing tubing 234
coefficient of variation (CV), high 265
collection
   devices 34, 106
   optics 39
   tubes, replacing 184
collet fitting 221
compensation
   calculating 152
   controls, creating 151
   gating data 154
   setup 154
components
   BD FACSDiva workspace 82, 102
cytometer 24
electronics 43
fluidics 25
optics 35
workstation 46
computer
   about 46
   shutting down 203, 206
configuration, cytometer
   about 59, 87, 88
   adding 93
   and sort setup 99
   copying 95
   custom 93
Cytometer Setup and Tracking (CS&T)
- menu selections 87
- overview 135
- research beads 138
- window 136

D
- daily shutdown procedure 202
- Dashboard, Acquisition 101
- data
  - analyzing 155, 159
  - gating 154, 159
  - recording 155, 158
- data collection, overview 148
- deflection
  - drop 73
  - plates 32, 170
  - removing 242
  - troubleshooting 258
- deflection plate removal tool 242
- delay
  - drop 70, 71, 172
  - See also Accudrop
- laser 63, 164
- deleting
  - custom devices 194
  - sort populations 110
  - sort precision modes 79
- detectors 40, 54, 59
  - detector configurations 290
  - detector locations 289
- devices, sorting 106, 192, 194
- diode laser 42, 71
- discriminating filters 57
- doors, sort collection chamber 35
- doublets
  - discrimination experiment 115
  - discrimination gating 150
  - eliminating 158
- drain plug 134
- drawer See aspirator drawer
- drip tray 226
- drop
  - auto delay 177
  - breakoff 65
  - charging 72
  - conflicts 73
  - correction factors 71, 171
  - deflection 73
  - delay 70, 71, 172, 174
  - See also Accudrop
  - drive frequency 66
  - formation 65
  - satellites 125
- Drop 1
  - about 66, 67
  - adjusting 68, 126

E
- editing
  - cytometer configurations 97
  - sort layouts 110
  - statistics view 160
- electronics
  - aborts 266
  - about 43
  - signal processing 60
  - troubleshooting 270
- emergency stop button 44
- emission
  - optics 276
  - spectra 53
- emptying waste 133
- error messages
  - cleaning mode failure 268
  - cytometer disconnected 270
  - cytometer not responding 270
- Master DAQ overflow 270
ethanol shutdown
  filter, changing 217
tank
  capacity 127
  refilling 130
events
  not showing in plots 261, 263
  rate, troubleshooting 264, 265
target 108, 180
  troubleshooting 266
excitation optics 36
Experiment Layout 155
experiments
  Accudrop 115, 172
cytometer QC 115
doublet discrimination 115
setting up 155
  sorting 180
  templates 115
exporting sort reports 114, 183

**F**

FACSAria III *See* BD FACSAria III
FACSDiva software *See* software
Ferrules, removing 221, 223
Fiber optics 37
Filling containers 131
Filters
  about 55
  air, changing 225
  bandpass 57
  changing 215, 244
discrimination 57
fluid, changing 215
holders 280
  longpass 56
neutral density (ND) 58, 246, 279
optical 55, 245
  purging 214
  removing 215, 246
sample line 235, 236
sheath 216
Fine Tune mode 78
flow cell
  about 29
  access door 24, 25
  cleaning 202
flow rate
  about 51
  adjusting 50, 101
  recommendations 51
 Fluid
  bleach line 212
  containers 21
  filters 215
  level indicators 86
  line 120, 205
  movement 48
  out port 213
  priming 132, 209
  refilling 131
fluidics
  about 48
  cleaning 211
  components 25
  connections 21
  containers 21
  controls 83
daily shutdown 202
daily level indicators 86
daily power 23
  shutdown 84, 203
startup 49, 83, 120
system 48
troubleshooting 268
fluidics cart
  about
  cord 22, 23
dimensions 276
drip tray 226
power 21, 23
specifications 276
fluorescence
about 53
emission spectra 53
signal, troubleshooting 262
folders, adding 149
forward scatter (FSC)
about 52
detector 59
ND filter 246, 279
removing 246
frequency, drop drive 66
FSC See forward scatter

G
Gap 66, 67
gating
compensation controls 154
data 159
during sorting 179
global worksheets
adding sort layouts 108, 180
previewing data 155
setting up 156

H
hardware, ACDU 188
hazard symbols xiv
hazards, mechanical 44
heating samples 85, 118
height parameters 61
holders
collection tube 34, 169, 326
optical filter 280
sample tube 28
Home Device 104, 190, 191
hydrodynamic focusing 51

I
index sorting
description 195
setting up for 195
Initial mode 78
installing
collection tube holders 169, 326
nozzle 228
plates 189, 328
sample line filter 235
sample tubes 28
slides 189, 328
splash shield 188
instrument See cytometer
integrated nozzle
about 30
changing 228
cleaning 229
replacing seal 232
interrogation point 29

L
labels, parameter 155
label-specific tubes 151
labware, parts list 286
lasers
about 36
configurations 36
delay 63, 164
diode 42, 71
laser options 287
power 43
shutting down 203, 206
specifications 275
starting 118
warmup time 118
layout See sort layouts
leaks, troubleshooting 269
lens, strobe 241
levels
  fluid  86
  sample  27
lever, nozzle  121, 228
light
  detection  54
  injection chamber  27
  scatter signals  52
  voltage warning  32
limitations  xvi
Link & Save  154
Load button  101
loader, plate  35
loading tubes  28, 50
long clean  268
longpass filters  56

M
maintenance
  AMO  310
  scheduled  207
  temperature control option  330
  unscheduled  227
managing aerosols  33
Masks
  about  73
  default precision modes  77
  Phase  76
  Purity  75
  Yield  74
Master DAQ overflow error  270
micrometer dial  42, 175, 178
mirrors, dichroic  56
mismatch dialog
  configuration  100
cytometer settings  151
modes
  defining  79
deleting  79
  sort precision  73, 77
monitoring sorts  112, 182

N
ND filters  58, 246, 279
neutral density filters  58, 246, 279
nozzles
  See also closed-loop nozzle
  about  30
  breakoff patterns  126
  changing  228
  cleaning  229
  integrated  30
  lever  121, 228
  O-ring  281
  responding to clogs  186
  responding to clogs with AMO  308
  sizes  104, 228
  spare  281

O
octagon
  about  39, 40, 54
opening
  aspirator drawer  70, 111, 181
  sample injection chamber  28
Optical Filter control  70, 71
optical filters
  about  55
  changing  244
  cleaning  245
custom  244
Index

 optics
  about 35
  collection 39
  emission 276
  excitation 36
  fiber 37
  filter holders 280
  reordering 278
  stream-viewing 42

 optimizing
  cytometer settings 148
  drop delay 174
  PMT voltages 146
  streams 190

 ordering supplies 277

 O-ring
  nozzle 281
  sample injection chamber 243

 P

 parameters
  about 61
  adding 59, 88, 93
  labels 155
  measuring 62
  scatter, distorted 265

 parts, replacement 282

 pausing sorting 68, 111, 185

 performance
  check, running 139
  tracking 88

 phase
  field 71
  masks 74, 76

 photodiodes 59

 photomultiplier tubes (PMTs)
  about 40, 59
  applying voltages 62
  assigning 59, 88, 93

 optimizing for application
  settings 146

 pinch valve
  changing tubing 237
  collet fitting 239

 plate loader 35

 plate voltage 71

 plates
  deflection 32, 170
  removing 242
  installing 189, 328
  sorting into 188

 plots
  excessive debris 266
  no events in 261
  unexpected events in 263

 PMTs See photomultiplier tubes

 populations
  sorting 72, 108, 179, 180
  troubleshooting 259, 266

 power
  buttons 43
  cytometer 43, 118
  fluidics cart 21, 23
  laser 43

 precision modes 73, 77
  See also sort precision modes

 preferences, user 159

 pressure
  air 23
  sample 50
  sheath 49, 84
  sort, default values 104
  troubleshooting 268

 priming fluids 132, 209

 printing
  sort reports 114, 183
  worksheets 160

 pulse, electronic 60

 purging filters 214
Purity
  Masks  75
  mode  77, 180

Q
quality control (QC)
  experiment  115
  particles  284

R
reagents, parts list  285
recording
  data  155, 158
  during sorting  182
refilling
  ethanol shutdown
    tank  130
  plastic containers  131
  sheath tank  128
removal tool, deflection plate  242
removing
  deflection plates  242
  ferrules  221, 223
  filters  215, 244, 246
  sample line filter  235
replacement parts  282
replacing
  closed-loop nozzle tubing  234
  tubes  183
reports
  cytometer status  90
  printing  114, 183
  sort  113, 114
results, troubleshooting  260
rotating sort block  31, 229
running performance check  139

S
safety, general  44
sample
  agitation  85
  core diameter  51
  flow  48, 50
  injection chamber
    about  27
    lubricating O-ring  243
    sample line  236
interrogation  29
line
  backflush  208
  changing  218
  filter  235, 236
  pressure  50
  temperature  85, 118
tubes, replacing  183
samples
  heating  85, 118
  running  158
satellites, drop  125
Save Conflicts  109, 180
saving
  application settings  148
  sort conflicts  109, 180
scatter
  light  52
  parameters, distorted  265
second laser
  adjusting delay  164
  sensitivity, cytometer performance  273
settings
  See also application settings
  optimizing  148
setup
  beads  136
  compensation  154
  values, sort  104, 105
sheath
  flow 49
  line 213
  pressure 49, 84
  reservoir, autoclaving 211
sheath filter
  changing 216
  purging 214
sheath probe
  containment device 210
  removing 209
sheath tank
  capacity 127
  changing air filter 225
  changing filter 216
  connectors 128
  refilling 128
  required location 130
shutdown tank, ethanol
  capacity 127
  refilling 130
shutting down
  computer 203, 206
  daily procedure 202
  fluidics 84, 202, 203
  lasers 203, 206
side scatter (SSC) 52
side streams
  optimizing 190
  window 69, 103
signals
  about 52
  detection 54
  fluorescent 53
  generating 60
  low Area 263
  no fluorescent 262
  scattered light 52
  troubleshooting 267
Single Cell mode 78
slides
  installing 189, 328
  sorting into 188
software
  about 46
  cleaning modes 208
  components 82, 102
  cytometer controls 83
  templates 115
sort
  block 30, 33
  collection
    chamber 34
    devices 34
Sort button 110
sort layouts
  about 72
  creating 108, 180
  custom 104, 192
  editing 110
  entering populations 108, 180
sort menu 103
sort precision modes
  4-Way Purity 77, 180
  about 73
  creating 79, 103
  defaults 77
  deleting 79
  Fine Tune 78
  Initial 78
  Purity 77
  Single Cell 78
  Yield 78
sort reports
  about 113
  exporting 114, 183
  printing 114, 183
sort setup values 104, 105
sort, test 70, 171
sorting
about 64, 167
Accudrop beads 175
analysis 159, 169, 179
aseptic 211
aspirator drawer control 70, 111
bulk 169
collection devices 106
conflicts 73, 109, 111, 180, 259
controls 102, 110
counters 111
experiment 180
gates 179
index 195
into plates 188
into slides 188
into tubes 169
monitoring 112, 182
pausing 68, 111, 185
populations 72, 108, 179, 180
recording data 182
resuming 183, 185
setup 168
starting 110, 181
stopping 110
troubleshooting 256
specifications
  cytometer 272
  fluidics cart 276
  laser 275
  temperature control option 331
splash shield, installing 188
stage, accessing 111
starting
cytometer 118
fluidics 49, 83, 120
lasers 118
stream 122
status, cytometer report 90
Stokes shift 53
stop button 44
stopping sorting 110
stream
centering 70, 171
deflecting 71
flow rate 49
setting up 190
starting 122
troubleshooting 122, 250
viewing 42
stream-charging wire 73
strobe lens, cleaning 241
supplies, cytometer 278
Sweet Spot
  about 65, 68
  control 66
symbols, hazard xiv
T
tanks See containers
target events 108, 180
technical assistance xv
temperature control option
  about 34
  maintenance 330
  setting up ACDU 327
  specifications 331
  using 322–331
  water bath 323
temperature, sample 85
templates, experiment 115
Terasaki plate adapter 199
test sort 70, 171, 191
threshold, troubleshooting 267
trap, waste 134
trigons
   about  39, 40, 54
troubleshooting
   ACDU  257
   acquisition  261
   AMO  317
   breakoff  124, 255
   CVs  265
   deflection  258
   electronic aborts  266
   electronics  270
   event rate  264, 265
   fluidics cart  268
   leaks  269
   low Area signal  263
   populations  259, 266
   pressure  268
   scatter parameters  265
   signals  262, 267
   sorting  256, 259, 260
   stream  122, 250
   threshold  267
tubes
   adding sort layouts  108, 180
   agitating  85
   compensation  151
   heating/cooling  85, 118
   holders  28, 34
   label-specific  151
   loading  28, 50
   replacing  183
   sorting into  34, 169
   unloading  28, 50
typographical conventions  xiv

U
   ULPA filter on AMO  303
   Unload button  101
   unloading tubes  28, 50

user preferences  159

V
   View Configurations selection  88
   viewing global worksheets  156
views
   statistics  160
   violet laser
      configuration  37
      detector  54, 279
      laser delay  63
   voltage
      adjusting PMT  62
      controls  70
      optimizing PMT  146
      warning light  32

W
   waste
      aspirator  32
      cap, changing  134
      container parts  133
      emptying  133
      water bath  323, 329
   width parameters  61
   Window Extension
      adjusting  165
   windows
      See also views
      about  82, 102
      Acquisition Dashboard  101
      Breakoff  66
      camera, cleaning  239
      CS&T  136
      cytometer configuration  88
      device setup  191
      Side Stream  69
      strobe lens  241
worksheets
   See also global worksheets
   printing  160
   viewing  156
workspace
   components  82, 102
   setting up  149
   setting up CS&T  136
workstation
   about  46
   shutting down  203, 206

X

X-mount optical plate  37

Y

Yield
   mask  74, 76
   mode  78